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1. INTRODUCTION 

 

 

 

Laser measurement system HPI-3D is a two frequency 

laser interferometer intended to be used mainly in machine 

geometry measurements. Its small size and low weight 

simplify transportation and make the instrument especially 

useful for service applications. Software version for 

Windows XP/Vista/7/8 and automation of many 

measurement processes make the interferometer easy to use. 

Software, compliant with ISO 230-2 and similar norms, 

enable making rapports and diagrams. It is possible to 

choose statistical results processing according to norms: ISO 

230-2 (European), VDI/DGQ 3441 (German), NMTBA (USA), 

BSI BS 4656 Part 16 (British) and PN-93 M55580 (Polish). 

 

Laser Measurement System HPI-3D is highly 

configurable device although already in its basic 

configuration it allows performing the complicated 

measurements at highest possible precision. Available 

options will be described below in this user manual. 

Very good technical parameters of the interferometer 

allow using it in scientific laboratories, for precision 
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positioning, for scaling optical and magnetic measurement 

systems, etc. 

 

 

 

 

a. Safety considerations 

 

The Laser Interferometer HPI-3D is a Safety Class I 

product designed and tested in accordance with 

international safety standards. It is also a Class II Laser 

product conforming to international laser safety regulations. 

The instrument and the manual should be inspected and 

reviewed for safety markings and instructions before 

operation. 

 

 

b. Warnings 

 

Although the laser measurement system HPI-3D is 

design to be used in harsh environment, the following 

conditions must be met: 

The Laser Head must not be put near strong magnetic 

fields. 

The head should not be unscrewed from its base and if it 

is, it may not be put on a heat sink (e.g. thick metal plate). 
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The head must not be thrown or dropped. 

Keep the optical components clean and avoid scratching 

them. 

When the optics is dusted, clean it with pure alcohol. 

Do not use the system beyond its work conditions. 

 

 

c. Compliance Information 



INTRODUCTION 

1-4  www.lasertex.eu     

1  
 

 

EC-DECLARATION OF CONFORMITY 2012 

 

Wroclaw, 2012-04-20 

Manufacturer  

LASERTEX Co LTD. 

Radzionkowska 17 

51-506 Wrocław 

Poland 

 

Hereby certifies on its sole responsibility that the following product: 

 

Laser Measurement System HPI-3D 

 

which is explicitly referred to by this Declaration meet the following directives and standard(s): 

 

Directive 2006/95/EC 

Electrical Apparatus 

Low Voltage Directive 

- EN 61010-1:2011 

 

Directive 2006/42/EU 

Machinery Directive 

- EN 60825-1:2007 

 

Directive 2004/108/EU 

Electromagnetic Comatibility: 

- EN 61326-1:2006 

- EN 61000-4-2:2011 

- EN 61000-4-6:2007 

- EN 61000-4-8:2010 

- EN 61000-4-11:2007 

- EN 55011:2007 

- EN 55022:2011 

 

 

Documentation evidencing conformity with the requirements of the Directives is kept available for 

inspection at the above Manufacture. 

 

President, Janusz Rzepka PhD 
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2. QUICK START 

 

 

 

 

The information presented in this chapter is only for 

quick start. More detailed information can be found in the 

following chapters. 

 

a. Main features 

 

The HPI-3D is a device for contact measurement of the 

velocity of the moving object.  

 

The device operates according to the laser 

interferometer principle (see Principles of Operation chapter). 

The Doppler shift phenomenon is used.  

 

The basic measurement unit is the wavelength of the 

laser, i.e. 632nm.  

 

The functionality of the instrument depends on the type 

of used optical components. 
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The HPI-3D is can be used either as a stand alone device 

or with a PC computer and the dedicated HPI Software. 

 

b. How it works 

The HPI-3D measures shift of the moving element in 

relevance to the reference element as shown in the figure 2.1. 

It is important to notice, that the relative movement and not 

the absolute position of any of the elements is detected! 

 

LASER  HEAD

Horizontal & Vertical polarization

Horizontal polarization

Vertical polarization

Reference element

Moving element

 FIG. 2.1.  ILLUSTRATION OF THE PRINCIPLE OF OPERATION - LINEAR 

OPTICS 

 

i. Linear optics 

 

i. To the linear optics belong Linear Interferometer IL1 

and Linear Retroreflector RL1. 

The operation of the HPI-3D with the linear optics used 

is shown in the figure 2.1. The laser outputs the laser beam 
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consisting of two polarizations: Horizontal (H) and Vertical 

(V). The Reference element (IL1) splits the beam into two 

parts. The H polarized beam is reflected back to laser and the 

V polarized beam is directed into the measurement path. The 

frequency of the V beam is changed according to the Doppler 

Effect when the moving element is in motion. 

The linear optics is mainly used for measurement of: 

 Shift 

 Velocity 

 Acceleration 

 Vibrations 

 Straightness with 3D method 

 Squareness with 3D method (RE3D element 

required) 

 Parallelism with 3D method (RE3D element 

required) 

 

ii. Angular optics 

 

To the angular optics belong Angular Interferometer IK1 

and Angular Retroreflector RK1. 

The operation of the HPI-3D with the angular optics 

used is shown in the figure 2.2. The laser outputs the laser 

beam consisting of two polarizations: Horizontal (H) and 

Vertical (V). The IK1 splits the beam into two parts. Both 

beams are directed into the measurement path but are 
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parallel shifted by 50.8 mm. The frequency of both beams is 

changed according to the Doppler Effect when the RK1 

element is in motion.  

The frequency change of both beams is the same when 

RK1 and IK1 are shifted linearly. In this case no measured 

signal is detected by the laser head.  

 

 

The laser detects movement only when the IK1 and RK1 

are rotated against each other. In this case the frequency 

change of the H beam is different from the frequency change 

of the V beam. 

 

RK1IK1

LASER  HEAD

Horizontal & Vertical polarization

Horizontal polarization

Vertical polarization

Beam Path 1

Beam Path 2

 

FIG.2.2.  ILLUSTRATION OF THE PRINCIPLE OF OPERATION - ANGULAR 

OPTICS 

 

 

The laser head with angular optics is insensitive to linear 

movements. 



QUICK START 

2-5  www.lasertex.eu     

2  

The angular optics is mainly used for measurement of: 

 Small angles 

 Straightness with Angular method 

 Flatness 

 Pitch 

 Yaw 

 

iii. Wollaston  optics 

 

To the angular optics belong Wollaston Prism WP2 and 

Wollaston Retroreflector WRP2. 

The operation of the HPI-3D with the Wollaston optics 

used is shown in the figure 2.3. The laser outputs the laser 

beam consisting of two polarizations: Horizontal (H) and 

Vertical (V). The WP2 splits the beam into two parts. Both 

beams are directed into the measurement path. There is a 

certain angle between the beams. The frequency of both 

beams is changed according to the Doppler Effect when the 

WP2 element is in motion.  

The frequency change of both beams is the same when  

WP2 and WP2 are shifted linearly. In this case no measured 

signal is detected by the laser head.  

 

 

 

 
The laser head with Wollaston optics is insensitive to linear 

movements. 
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The laser detects movement only when the WP2 is 

moved perpendicular to the beam from the laser. In this case 

the frequency change of the H beam is different from the 

frequency change of the V beam, because the lengths of 

beam paths 1 and 2 are different – see figure 2.3 

LASER  HEAD

WP2

WRP2

LASER  HEAD

WP2

WRP2Horizontal & Vertical polarization

Horizontal polarization

Vertical polarization

Beam Path 1

Beam Path 2

A

B

 

 

FIG.2.3.  ILLUSTRATION OF THE PRINCIPLE OF OPERATION - WOLLASTON 

OPTICS. BEAMS RETURING TO THE LASER ARE IN THE PLANE OF THE 

DRAWING. 

 

The Wollaston optics is mainly used for measurement 

of: 

 Straightness with Wollaston method 

 Axes squareness (with REW element) 
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 Axes parallelism (with REW element) 

 

c. How to start 

 

1. Install HPI software from CD or from www.lasertex.eu
 

 

LASER  HEAD

2. Mount Laser Head, and optical elements on the measured 

machine. Connect power supply to the Laser Head.  
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LASER  HEAD

USB

Bluetooth

3. Run HPI Software and connect PC with laser over 

USB or over Bluetooth interface  

 

LASER  HEAD

4. Align optical path

 

5. Start measurements
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3. PREPARATIONS 

 

 

 

 

 

The Laser Interferometer HPI-3D requires an installation 

of software "HPI Software” on a hard disc of a PC computer. 

The hardware requirements are:  

Windows XP/Vista/7/8 system, 

CR-ROM 

Pentium processor, 1 GHz or better 

SVGA graphic card 

USB 2.0 or Bluetooth 2.0 

 

a. Software installation 

 

The software installation package is located on the USB 

memory stick that is included to the measurement system. 

HPI_Software_Install application can be launched from the 

USB memory. The installation process should start 

automatically.  
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FIG. 3.1. ICON OF THE SETUP APPLICATION. 

 

Following components have to be installed for proper 

operation of HPI-3D system: 

  HPI Software application, 

  Directory of the languages Languages, 

  FTDI Driver for USB, 

 documents folder with the manual and other 

documents (depending on a system version), 

  Database BDE (Borland Database Environments) 

 

During the installation process necessary parameters 

have to be set by the user. In the figure 3.2 there is shown a 

first windows that appears during installation. It allows 

choosing the installation language.  

 

 

FIG.3.2. INSTALLATION LANGUAGE SETUP WINDOW. 
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FIG.3.3. WELCOME WINDOW. 

 

FIG.3.4. USER INFORMATION WINDOW. 
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FIG.3.5. PROGRAM DESTINATION FOLDER WINDOW. 

 

 

FIG.3.6. WINDOW APPEARING WHEN THE FOLDER NAME DOES NOT EXISTS IN THE 

CURRENT INSTALLATION PATH. 
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FIG.3.7. MENU START FOLDER SLECTION WINDOW. 

 

FIG.3.8. DESKTOP ICON SETUP WINDOW. 
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FIG.3.9. WINDOW WITH INSTALLATION INFORMATION. 

 

FIG.3.10. INSTALLATION WINDOW DURING DATA COPY OPERATION. 
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FIG.3.11. BDE (BORLAND DATABASE ENVIRONMENT) DESTINATION FOLDER WINDOW. 

 

 

FIG.3.12. FTDI DRIVER INSTALLATION. 
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FIG.3.13. INSTALLATION SUMMARY WINDOW 

 

In most cases, the installation is semi-automatic 

requiring only confirmation by the Enter key. 

 When the software is installed on the computer,  also 

drivers should be installed. To complete this process, the 

system has to be connected by a USB cable to your PC. 

Driver installation is performed automatically by Windows. 

 

 

 

FIG.3.14. MESSAGE APPEARING WHEN THE NEW USB DEVICE IS FOUND. 
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FIG.3.15. MESSAGE APPEARING WHEN THE DRIVER FOR HPI-3D DEVICE IS INSTALLED. 

 

The HPI Software application can be launched from the 

HPI Software folder located in Programs tab in Windows 

Start Menu (assuming that the installation settings are not 

changed). The application can also be launched from the 

desktop, if the shortcut is created during installation. 

 

FIG.3.16. ICON OF HPI SOFTWARE APPLICATION. 

 

In order to uninstall the HPI Software application please 

choose Uninstall HPI Software from Menu Start. 

 

FIG.3.17.  ICON OF HPI SOFTWARE DEINSTALLATION APPLICATION 

 

b. Elements of the Laser System 

 

Number of the system elements is configurable and its 

configuration is related to the required application. 



PREPARATIONS 

 

3-10  www.lasertex.eu     

3  

Following items are included in the standard set (for linear 

measurements): 

 

1. 
1 

pcs 
Laser head 

 

2. 
1 

pcs 
Power Supply 

 

3. 
1 

pcs 

Tripod 

stand 

 

4. 
1 

pcs 

Linear 

retro-reflector 

RL1 

 

5. 
1 

pcs 

Linear 

interferometer 

IL1 
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6. 
3 

pcs 
 

Base 
temperature 

sensor
 

 

7. 
1 

pcs 
 

Air 
temperature

sensor
 

 

8. 
1 

pcs 
Wireless strobe  

 

9. 
2 

pcs 

 Holding 

block HB1  

 

10. 
2 

pcs 

 Stainless 

rod SR1  

 

11. 
2 

pcs  

 Magnetic 

holder UM2  
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12. 
1 

pcs 
USB Type B 

cable  

 

 

In the figure 3.18 there is shown a suitcase for transport 

and storage of the interferometer system. 

 

 

FIG.3.18. THE SUITCASE FOR TRANSPORT AND STORAGE OF THE 

INTERFEROMETER SYSTEM. 

 

Additional elements for angular measurements are: 

1 x Angular Interferometer IK1, 
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1 x Angular Retro-reflector RK1, 

2 x Beam directing mirror ZK1, 

1 x Rotary table RE1. 

Additional elements for straightness measurements are: 

1 x Wollaston Prism WP2, 

1 x Wollaston Retroprism WRP2. 

Additional elements for squareness measurements are: 

1 x Right Angle Etalon for 3D measurements RE3D, 

1 x Right Angle Etalon for Wollaston measurements 

REW. 

 

c. Interferometer setup for measurement 

 

The Laser Interferometer HPI-3D is supplied from 

autonomous 24VDC/5A Power Supply. Communication 

with a PC computer is performed by USB or Bluetooth 

interface. The USB connection is faster thus it gives more 

possibilities in some measurements (i.e. Vibration or 

Dynamic).  

 

Before starting the measurements the Laser Head (1) 

should be placed on the Tripod stand (3) and connected to the 

Power Supply connector on the back of the laser head. The 

Laser Head can be also placed directly on the machine 

because it is equipped with magnetic base. 
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If the USB connection is used then the USB cable (10) 

should be connected to the male socket on the back panel of 

the Laser Head (fig. 3.19). The second end of the cable should 

be plugged into the USB socket of a PC computer. For the 

Bluetooth connection only power connection is necessary. 

 

 

 

FIG.3.19. CONNECTIONS OF THE HPI-3D.  

 

Through the Extension Connector it is possible to drive 

many peripherals directly from the laser head. This give 

huge possibilities of customization of the usage of the laser 

interferometer – e.g. in emulation of glass scales, driving 

Power Button 

Power Connector 

Extension Connector 

USB Connector 
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stepping motors, dynamic measurements, etc. Standard 

connector pinout is described in Technical Data at the end of 

this manual. 

Environmental (6) and base temperature (7)  sensors are 

connected to the Laser Head wirelessly. The sensors are 

maintenance free – they do require neither switching on/off 

nor charging. When the Laser Head is not powered they 

remain in power down mode. Sensors can only “wake up” 

and start to measure when the Laser Head is powered by the 

Power Supply unit. 

Sensors are powered from 1/2AA 3.6V lithium battery 

(number 14250). It can be replaced, when the battery strength 

monitor on Display screen (see below in this Chapter) shows 

that it is depleted, after removing the cap of the sensor. The 

battery life time in the power down mode only is more than 

30000 hours. The combined life time of the battery for the 

sensor is 10000 hours. 

Wireless Strobe is used to manually capture points 

during measurements (see appropriate chapter). 

The Power Button is used for switching the laser on or 

off and for signalization of the internal state of the laser. The 

meaning of the signaling of the Power Button is described in 

the table 3.1. 
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Power Button state State description 

Red  Laser head powered on properly. Laser not 

working 

Red – blinking fast  Laser head powered on properly but main 

CPU firmware is corrupted. Firmware 

programming necessary. 

Orange / Green  

blinking slow 

 Laser switched on; Stabilization phase 1 

Orange / Green  

blinking fast 

 Laser switched on; Stabilization phase 2 

Green -  

blinking 

 Laser switched on; Stabilization phase 3 

Orange 

 

 Laser stabilizes. Beam path unaligned. 

Green   Laser stabilizes. Beam path aligned. System 

ready for measurements! 

TAB.3.1.  POWER BUTTON LED STATES 
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d. Powering the system on

i. Starting hardware

  The  HPI-3D  has  only  one  soft-switch  on  the  top  of  the 

laser head. Starting the laser is possible by holding the Power 

Button for  3  seconds  (see  figure  3.19)  or  from  the  HPI

software  by  clicking  on the  bottom  bar  of  the  screen  in

“Laser” text (see fig. 3.20). 

 

 

FIG.3.20.  POWER SWITCH OF THE HPI-3D 

 

ii. Starting software 

 

When the software starts a splash screen appears (figure 

3.21). Pressing F5 on the PC keyboard or the button marked 
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Simulator causes the software to switch into simulation mode 

– connection to a HPI-3D device is emulated even if there is a 

real device connected to the computer! 

In the bottom part of the splash screen there are shown 

all HPI-3D devices currently connected to the PC either by 

Bluetooth  or USB interface. The devices paired up with the 

PC over Bluetooth are visible in blue. Devices connected over 

USB are shown in red.  

 

 

FIG.3.21.  SPLASH SCREEN 

 

After the splash screen a connection screen appears 

(figure 3.22) where the connection trials are shown. In the 

right bottom part there is shown the interface over which the 

software is actually trying to obtain a connection (see a red 

circle in the figure 3.22). After software installation, by 

default, the first trials are made over USB interface. When 
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there is a successful connection made over other interfaces 

then the “successful” interface is taken as a first choice in 

next runs. 

 

 

FIG.3.22.  CONNECTION SCREEN 
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FIG.3.23. MAIN MENU 

 

After the connection screen there the Main Menu 

appears as shown in the figure 3.23. There are two rows of 

buttons. Button Display opens the window with basic 

control of the laser operation. It is described in details later in 

this Chapter. Button Configuration opens configuration 

window. Pressing Exit button closes the application. 

Other buttons open measurement screens. All options 

are described in details in following Chapters. Because of 

abundance of measurement types offered by the HPI-3D, 

some of the options are not visible and can be reached by 

using the buttons with arrows in the second row.   

 

Connection problems troubleshooting is described in the 

Troubleshooting chapter. 
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e. Getting basic information from the system. 

 

When the software is launched and the system is 

connected the option Display in the Main Menu should be 

chosen. The window shown in the figure 3.24 appears. If the 

output beam of the laser is properly redirected to the Laser 

Head (e.g. with the use of the retroreflector RL1) and laser 

maintain the stabilization (Laser status bar is green), the 

Beam Strength (a green indicator on the screen) shows 100% 

of the signal level. If the laser heats up to maintain the 

stabilization the Beam Strength appears and disappears. The 

speed of changes is related to the temperature of the laser. 

During the heating up the system is ready for the alignment 

of the optical path (see chapter 4). 

 

FIG.3.24. DISPLAY WINDOW 
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On the Display screen there are a status bar 

and four panels:  

- Panel (figure 3.25) where are presented a digital 

result of the measurement and the signal level. There are also 

located buttons for changing the Units and a number of 

displayed Digits in the result. 

 

 

FIG.3.25. PANEL WITH MAIN DISPLAY 

 

- Panel Environment (figure 3.26) where data 

obtained from the Environmental Compensation Unit (ECU) 

is shown. On the screen there are presented: temperature, 

pressure and humidity of the atmosphere (Pressure, 

Humidity, and Air Temp.) and temperature of the base which 

is measured by three base temperature sensors and averaged 

(Average temp., T1, T2 and T3). For each sensor the battery 

voltage and signal strength are presented. Data from 

Environmental Compensation Unit can be also controlled by 

the user. It is possible switch off the data coming from ECU  

and insert parameters of the atmosphere manually. In the 

lower left corner there are icons setting up a link to Microsoft 
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Excel or OpenOffice Calc (if installed). This link allows 

registering measurement in Excel or Calc by each STROBE 

button press. 

 

                

FIG.3.26. ENVIRONEMNTAL PANEL  

 

- Measurement Panel (figure 3.27) contains basic 

information about current measurement. With the left drop-

down list the type of the measurement is changed. Right 

drop-down list is used for an axis selection. If Adjustment or 

Laser head checkbox is not ticked, the pictorial view of 

optical configuration is presented. It reflects measurement 

type (i.e. distance, speed, angle, straightness) and axis (i.e. X, 

Y, Z). Adjustment and Laser head options are selected by 

the checkboxes located on the panel. However only one of 

them can be active, because they are mutually exclusive. 

Both options are very helpful in optical path alignment 

process (see chapter 4). 



PREPARATIONS 

 

3-24  www.lasertex.eu     

3   

FIG.3.27. MEASUREMENT PANEL 

 

- Panel Parameters (figure 3.28) is used for 

configuration of the measurement system. Change sign 

option selects whether enlarging distances between the retro-

reflector and the interferometer gives positive (default “+”) 

or negative result on the display. Thermal expansion of 

feedback system option is used to select the material from 

which a feedback measurement system of the measured 

machine is made of. Setting the proper value of the 

expansion coefficient is very important to obtain the highest 

accuracy of the system. Option User makes it possible to 

enter any value of the thermal expandability coefficient. 

Resolution enables to change between High (0.1 nm) and 

Normal (1 nm) system resolution.  
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FIG.3.28. PARAMETERS PANEL 

 

Status Bar (figure 3.24) presents state of the Laser Head 

and state of the measurements. There are four fields: 

Connection, Laser, Signal and Velocity. In proper operation 

they should all be green. In table 3.2 there are shown the 

possible states of the fields. 

 

Field State description Required action 

 No connection to the 

Laser Head 

Click on the field to open 

Configuration window. Restart 

the connection 

 Laser Head is 

connected to the 

computer properly 

No action necessary 

 Laser Head off Click on the field to switch the 

laser on 

 Laser Head on but not 

ready 

Wait for the laser to become 

ready 

 Laser Head near 

unstable region.  

Finish performed measurements 

and click on the field to allow 

the head to find new stable point 

Connection 

Connection 

Laser 

Laser 

Laser 
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 Laser Head works well 

 

No action necessary 

 Beam strength too 

week. 

Using beam indicator adjust 

optical components to obtain 

satisfactorily beam strength, 

then click on the field to reset 

the error  

 

 

Beam strength fine 

but not calibrated 

Beam path between IL1 and 

RL1 optical components should 

be obstructed for a while so the 

laser can calibrate beam 

parameters 

 

 

Beam strength fine No action necessary 

 Velocity of the 

registered movement 

too high 

Click on the field to reset the 

error 

 

 

Velocity of the 

registered movement 

in range 

No action necessary 

 No measuring sensors 

detected 

At least 3 minutes after 

powering up the laser head:  

- Check if sensors are close 

enough to the laser head;  

- Check/replace sensors 

batteries; 

 At least one sensor is 

working 

No action necessary 

 Rotary encoder not 

detected 

Check if rotary encoder is 

switched on 

Laser 

Signal 

Signal 

Laser 

Velocity 

Velocity 

Sensors 

Sensors 

Rotary 
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 Rotary encoder 

present. No link to 

rotary set.  

Double click on the field for the 

laser to set the link to rotary 

 

 

Rotary link set No action necessary 

TAB.3.2. STATUS BAR STATES 

 

If measurements are performed with automatic 

compensation of the atmosphere parameters and the 

compensation of the base temperatures, one should: 

 Place the air temperature and humidity sensors 

THS on the machine in the vicinity of the laser 

beam. 

 place the sensors of the base temperature along the 

measured axis on the machine base 

Measurements performed without automatic 

compensation are referred to normal conditions: temperature 

20 °C, pressure 1013.25 hPa, humidity 50 %. 

The measured machine is compensated to the 

temperature set in the Reference temperature edit box, located 

in the Configuration->Meteo panel (see figure 3.29). By 

default the reference temperature is set to 20 degrees C and 

should not be change unless necessary.  

Rotary 

Rotary 
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FIG. 3.29. CONFIGURATION WINDOW – METEO PANEL 
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f. Recording mode 

 

The long term changes of the length of machine axes 

under changes of temperature condition may give the 

information about thermal properties of the machine. This 

kind of measurements called “Recording mode” may be 

chosen by pressing RECORD button on the Display screen. 

This switches the system into the data recorder mode. The 

time interval of the records could be programmed from the 

computer by setting a required value.  

 

 

FIG.3.30. RECORDING DATA MODE WINDOW 
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Pressing “End Recording” finishes the data recording. 

The results can be saved with the choice of “Save to file”. In 

fig. 3.30 the example of Data Record is presented. 

 

g. Flat mirror measurements - option 

 

       The flat mirror measurements option enables to 

measure the displacement, velocity, positioning, and 

vibrations of a flat surface. The surface should have a mirror 

quality (surface flatness λ/8) and the reflection coefficient 

not less than 50%. The aluminum, gold or dielectric mirror 

mounted to the moving part is suggested. There are two 

possible configurations: double pass setup Fig. 3.31 and 

single pass setup 3.32. The resolution of the double pass 

setup is two times bigger than the single pass. The setup 

consists of the laser head, the flat mirror interferometer FMI 

and the flat mirror. In order to obtain correct result of 

measurements with double-pass flat mirror configuration, 

the option double-pass in the Configuration window should be 

chosen (fig. 3.33). 
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l/4

l/4

Flat mirror

LASER  HEAD

 

FIG. 3.31.  DOUBLE PASS FLAT MIRROR INTERFREOMETER 

 

l/4

l/4

Flat mirror

LASER  HEAD
Flat mirror

 

FIG. 3.32.  SINGLE PASS FLAT MIRROR INTERFREOMETER 
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FIG. 3.39.  CONFIGURATION WINDOW – INTERFEROMETER TYPR CHOICE 
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4. BEAM ALIGNMENT 

 

 

 

 

 

 

 

 

 

 

a. Introduction 

 

Beam alignment is a process in which the user, with the 

use of certain mechanical arrangements, makes the direction 

of the laser beam parallel to the direction of the movement in 

a measured axis. If the beam is not correctly aligned an effect 

like the one shown on Fig.4.1 may happen, i.e. the position of 

the beam returning on the detector in the Laser Head from 

the moving retroreflector may vary with the position of the 

retroreflector resulting in a cosine error (see chapter 17)  

and/or misalignment of the optical path (no Beam Strength). 

 

 

The alignment of the optical path difficult and laborious part of 

the whole measurement process. Be very careful reading this 

chapter!  
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LASER  HEAD

 

 FIG.4.1. ILLUSTRATION OF BEAM MISALIGNMENT 

 

The alignment of the optical set up should be conducted 

in the option Display. It can be done during Laser Head 

heating. Final check should be made when the system is 

ready to work. 

 

b. Electronic alignment tools 

 

The beam path alignment process is usually time 

consuming so in order to simplify and speed it up the HPI-

3D provides, together with standard mechanical elements 

like diaphragms, three unique electronic tools. 

The first is a function of electronic position of the laser 

head in space – Display/Laser Head. This option is a useful 

tool for the alignment of laser head position in space.  

Another useful and unique tool supporting alignment is 

the Electronic Beam Alignment switched on in 

Display/Alignment option. With this tool the position of the 

beams returning to the laser can be controlled very 

accurately. 
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The third tool is the Electronic Beam Indicator showing if 

the beam returning to the laser is strong enough to make 

proper measurements. For indicating the beam strength the 

physical Power Button on the laser head is used. When the 

laser is ready for operation then this button stops blinking 

but turns orange or green. The second color means the 

proper value of beam level.  

 

c. Basic rules of beam alignment  

 

With the HPI-3D there are delivered three main types of 

optical components: linear optics, angular optics, Wollaston 

optics. Although the elements seem different the beam path 

alignment is similar for all cases. In the points below the 

process is described in more details with explanation of 

differences for the different types of optics. 

In the Figure 4.2 there is shown a block diagram of the 

basic rules of beam path alignment. All points are covered in 

details in the paragraphs below. 
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Start

Set the laser head firmly on the tripod or on the 

machine bench

Switch the laser on and set the position of the 

laser so the beam is parallel to the measurement 

axis

Set proper optical components along the laser 

beam path.

Move the optical components along the 

measurement axis and regulate the position of 

the laser head so the beam always returns to the 

laser – use diaphragms

Repeat previous point with the use of Electronic 

Beam Alignment tool – (diaphragms in „work” 

position)

Control the strength of the returning beam either 

wirh Electronic Beam Indicator on the laser or 

with software beam indicator on the PC

Correct position of the laser if necessary

Stop

 

FIG.4.2. BASIC BEAM ALIGNMENT RULES 
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d. Preparations 

  

The Laser Head should be firmly attached to the tripod 

or put directly on the machine bench. The tripod should not 

touch the machine as it may cause vibration of the Laser 

Head and the optical path. Special attention should be paid  

not to move the legs of the tripod during the measurements. 

The alignment process would have to be repeated then.  

 

 

FIG. 4.3 ILUSTRATION OF THE FUNCTION LASER HEAD 

 

The mechanical elements of the tripod help in the 

adjustment process. The tripod must be leveled, and after 

that with the function Laser Head the position of Laser Head 

must be set according  to the angle of the measurement path.  
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i. Diaphragm 

 

The diaphragm of the laser beam on the front panel of 

the Laser Head (figure 4.4) helps in the process of alignment. 

The diaphragm can be placed in two positions:  

" Alignment" – the laser beam goes out through opening 

in the diaphragm about 2 mm diameter,  

" Measurement" from the Laser Head goes out beam 

about 8 mm diameter, 

 

 

FIG.4.4. DIAPHRAGM POSITIONS. A) MEASUREMENT, B) ALIGNMENT 

 

During transportation or when system is not used, 

correct position of diaphragm is alignment position. In this 

position optics is safe from getting dirty, covering with dust 

and accidental damage during transportation.  

 

The Diaphragms are also used on most available optical 

components – see figure 4.5 – with the exception of 

Wollaston optics. 
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FIG.4.5. DAPHRAGMS: ALIGNMENT POSITION (A) AND WORK POSITION 

(B) 

 

If it is required then the diaphragms can be taken off 

and put back later on. 

 

A 

 

B 
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ii. Laser head alignment elements 

  

FIG.4.5.  THE LASER HEAD ALIGNMENT ELEMENTS 

 

In order to set the position of the beam in space properly 

the laser head has a few regulation elements as shown in the 

figure 4.5. The elements are placed on the swivel head of the 

tripod (figure 4.5a and 4.5b) and on the base of the laser head 

(figure 4.5c).  

Z Aligment 
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Elements placed on the tripod are in general used for 

linear vertical and horizontal movement of the beam 

position, while the elements available on the laser head base 

are for angular vertical and horizontal movement of the 

beam. 

 

iii. Electronic Beam Alignment tool 

 

One of the unique features of the HPI-3D laser is the 

Electronic Beam Alignment tool. This is a software tool 

displaying the position of the beams returning to the laser. 

The tool can be activated in the Display option by checking 

Adjustment check box in the Measurement panel – see figure 

4.6. 

 

  

FIG.4.6.  ELECTRONIC BEAM ALIGNMENT TOOL 



BEAM ALIGNMENT 

 

4-10  www.lasertex.eu     

4  

The tool shows two crosses: green and blue. The green 

cross shows the position of the reference beam, while the 

blue one the position of the measurement beam.  

The exact meaning of the crosses depends on the type of 

used optical components. The terms “reference beam” and 

“measurement beam” have sense only for linear optics. In 

this case the “reference beam” means the beam “from” IL1 

element while “measurement beam” is the beam reflected 

back by RL1.  

 

 

 

 

 

 

Each time the optical configuration of linear optics is 

changed it is required to stop the beam between IL1 and RL1 for 

2-3 seconds. Laser needs this operation to conduct calibration 

procedures.   

Attention! It is inadmissible to place one of optical 

elements (i.e. RL1 or IL1) outside the machine on an additional 

stand – the system measures then also displacements of the 

machine in relation to the stand!).  



BEAM ALIGNMENT 

 

4-11  www.lasertex.eu     

4  

e. Beam alignment process for linear optics 

 

LASER  HEAD

1. Mount Laser Head, IL1 and RL1 on the measured machine
 

LASER  HEAD

2. Turn on the laser and align all elements along the measurement 

axis  

LASER  HEAD

3. Move the RL1 very close to IL1 (they can touch each other). Set 

their initial position so the beam returns back to the laser.  

LASER  HEAD

4. Move the RL1 from the IL1
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LASER  HEAD

5. By regulation of the laser head position align the beam path so that 

both beam overlap on the input of the laser. 

REMARK 1: With angular regulation the position of the beam from RL1 

should be regulated. Position of the beam returning from IL1 should be 

regulated with mechanical components on the tripod.

REMARK 2: If the laser head is mounted directly on the machine then 

the position of the beam returning from IL1 should regulated by direct 

movement of the IL1 component.    

LASER  HEAD

6. Move the RL1 back to IL1 (the components must not touch!) and 

check the quality of the beam path alignment. Use availble electronic 

tools – Beam Level Indicator and Electronic Beam Alignment Tool.  

 

 

 

 

 

Attention! The position when the interferometer touches the 

retro-reflector can serve only to adjust. Be sure that during 

measurements in extreme nearest measuring position the retro-

reflector does not touch the interferometer, because it can be a 

source of measuring errors.  
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f. Beam alignment process for angular optics 

 

LASER  HEAD

1. Mount Laser Head, IK1 and RK1 on the measured machine

IK1 RK1

 

RK1IK1

LASER  HEAD

2. Turn on the laser and align all elements along the measurement 

axis  

RK1IK1

LASER  HEAD

3. Move the RK1 very close to IK1 (they can touch each other). Set 

their initial position so the beam returns back to the laser. 

RK1

 

RK1IK1

LASER  HEAD

4. Move the RK1 from IK1. 

RK1
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RK1IK1

LASER  HEAD

5. By regulation of the laser head position align the beam path so that 

both beam overlap on the input of the laser. 

REMARK: If the beams do not overlap then it means that the IK1 is 

rotated against RK1. Check the roll of laser head against IK1 and RK1 

– it should be zero!    

 

RK1IK1

LASER  HEAD

6. Move the RK1 back to IK1  (the components must not touch!)  and 

check the quality of the beam path alignment. Use available electronic 

tools – Beam Level Indicator and Electronic Beam Alignment Tool.  
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g. Beam alignment process for Wollaston optics 

LASER  HEAD

1. Mount Laser Head and WP2 on the measured machine

WP2

 

LASER  HEAD

WP2

2. Turn on the laser. Switch diaphragms both on the WP2 and the 

laser head to the alignment position. Insert the WP2 in the laser beam 

path so that the beam passes through the middle of both diaphragms 

of the WP2

LASER  HEAD

WP2

3. Move the WP2 along the measurement axis. Aling the laser position 

so that the beam passes always through the middle of the WP2 

diaphragms.

WP2
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LASER  HEAD

WP2

WRP2

4. Insert WRP2 at the end of the measurement path.  
 

LASER  HEAD

WP2

WRP2

5. Regulate the angle of the WRP2 (with the large knob on the top) so 

that the reflected beam returns to the laser head

 

LASER  HEAD

WP2

WRP2

6. Move the WRP2 back to WP2 (not closer than 30 cm) and check the quality of 

the beam path alignment. Use available electronic tools – Beam Level Indicator 

and Electronic Beam Alignment Tool – the beams on the Alignment Tool have to 

overlap!. If they not over lap then rotate the WP2 so they are onto each other.  
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h. Beam alignment of linear optics with angle 

etalon 

 

L
A

S
E

R
  
H

E
A

D

1. Mount Laser Head, IL1, RL1 and RE3D on the measured machine

R
E

3
D
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L
A

S
E

R
  
H

E
A

D

R
E

3
D

2. Turn on the laser and align all elements along the measurement axis
 

 

L
A

S
E

R
  
H

E
A

D

R
E

3
D

3. Move the RL1 very close to IL1 (they can touch each other). Set 

their initial position so the beam returns back to the laser.  
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L
A

S
E

R
  
H

E
A

D

R
E

3
D

4. Move RL1 from IL1
 

 

L
A

S
E

R
  
H

E
A

D

R
E

3
D

5. By regulation of the laser head position align the beam path so that both 

beams overlap on the input of the laser. 

REMARK 1: With angular regulation the position of the beam from RL1 

should be regulated. Position of the beam returning from IL1 should be 

regulated with mechanical components on the tripod.

REMARK 2: If the laser head is mounted directly on the machine then the 

position of the beam returning from IL1 should be regulated by direct 

movement of the IL1 component.    
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L
A

S
E

R
  
H

E
A

D

R
E

3
D

6. Move the RK1 back to IK1 (the components must not touch!) and 

check the quality of the beam path alignment. Use available electronic 

tools – Beam Level Indicator and Electronic Beam Alignment Tool.  
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i. Beam alignment of angular optics with beam 

bender 

i. Laser Head initially not aligned 

L
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R
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D
IK1 RK1

ZK1

1. Mount Laser Head, IK1, RK1 and ZK1 on the measured machine
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2. Turn on the laser and align all elements along the measurement axis
 

ZK1
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RK1IK1 RK1

3. Move the RK1 very close to IK1 (they can touch each other). Set their 

initial position and the position of ZK1 so the beam returns back to the laser.  
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4. Move the RK1 from IK1. 
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5. By regulation of the laser head position align the beam path so that both beams 

overlap on the input of the laser. Instead of regulating the position of the laser head 

it is possible to regulate the ZK1 – in many situations it would be faster!

REMARK: If the beams do not overlap then it means that the IK1 is rotated against 

RK1. Check the roll of laser head against IK1 and RK1 – it should be zero!    

RK1

ZK1
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RK1IK1

6. Move the RK1 back to IK1 (the components must not touch!) and 

check the quality of the beam path alignment. Use available electronic 

tools – Beam Level Indicator and Electronic Beam Alignment Tool.  
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ii. Laser Head initially aligned 

ZK1

RK1IK1
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1. Align all elements (ZK1, IK1, RK1) along the new measurement axis. 

DO NOT TOUCH the laser head  

 

ZK1
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RK1IK1 RK1

2. Move the RK1 very close to IK1 (they can touch each other). Set their 

initial position and the position of ZK1 so the beam returns back to the laser.  
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3. Move the RK1 from IK1. 
 

ZK1
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RK1IK1

4. By regulation of the ZK1 position align the beam path so that both beam overlap 

on the input of the laser. DO NOT TOUCH the laser head.

REMARK: If the beams do not overlap then it means that the IK1 is rotated against 

RK1. Check the roll of laser head against IK1 and RK1 – it should be zero!    

 

 



BEAM ALIGNMENT 

 

4-27  www.lasertex.eu     

4  

RK1

ZK1

L
A

S
E

R
  
H

E
A

D

RK1IK1

5. Move the RK1 back to IK1 (the components must not touch!) and 

check the quality of the beam path alignment. Use available electronic 

tools – Beam Level Indicator and Electronic Beam Alignment Tool.  
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5. MEASUREMENTS - POSITIONING 

 

 

 

 

 

a. General Description 

 

The linear positioning measurement is the most 

advanced option of linear measurements. It is also the most 

common form of laser interferometer measurements 

performed on machines. The laser system measures linear 

positioning accuracy, repeatability and backlash by 

comparing the position to which the machine moves (i.e. the 

position displayed on the machine’s readout) with the true 

position measured by the interferometer. 

The HPI-3D device offers a unique feature of 

simultaneous measurement of positioning and estimation of 

straightness in horizontal and vertical planes. This 3D 

feature simplifies and significantly speeds up the process of 

machine geometry testing and improves measurement 

accuracy thanks to elimination of the cosine error. 
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i. Positioning in brief  

 

In the Figure 5.1 there is shown the block diagram of the 

linear positioning error correction algorithm. Following the 

presented algorithm it is easy to correct any numerically 

controlled machine. 

 

In the first step there can be chosen some measurements 

options. In most cases this step can be omitted. Next in the 

software there should be generated the program for machine 

movement (G Codes). The generated program drives the 

machine in compliance with the ISO230-2 standard.  

After starting the uploaded program on the tested 

machine the measurements can also be started in the HPI 

Software. No user attendance is necessary during 

measurement process. 

After the measurement finishes there can be generated a 

special file for compensation of the machine control. After 

uploading the file, the machine positioning should be 

measured again to obtain the end results. The end results can 

be stored or printed.  

All measurement steps are described in much greater 

detail inside the Chapter. 
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Performing linear positioning 

measurement by starting machine 

and pressing START in HPI 

Software (no user attendance 

during measurements necessary!)

Printing error report according to 

a chosen standard 

(NMTBA, ISO, VDI/DGQ, BSI, PN, JIS)

Error compensation table generation 

in a format best suited the corrected 

machine

(linear, incremental, Siemes, HP, Fanuc)

Loading G-Code program into 

machine

Downloading corrections into 

machine (if necessary)

Positioning method choice:

- linear

- pendulum

- pilgrim standard

- pilgrim effective

G-Codes program generation for CMM

or CNC machines in LSP30-3D software

Error report generation according to a 

chosen standard 

(NMTBA, ISO, VDI/DGQ, BSI, PN, JIS)

 

FIG.5.1 LINEAR POSITION ERROR CORRECTION PROCEDURE 
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b. Measurement Setup 

i. Principles  

 

The Positioning measurement is the very basic 

measurement performed with the linear optical components: 

linear retroreflector RL1 and the linear interferometer IL1. 

Any change in the distance between IL1 and RL1 is detected 

by the laser head and shown in the HPI Software.  

As it is illustrated in the Figure 5.2 both elements are 

normally aligned along the laser beam. Although IL1 is 

usually treated as a reference element with the movement of 

the RL1 measured but the configuration can also be reverse, 

i.e. RL1 can be stationary with IL1 being translated.  

 

 

LASER  HEAD

IL1 RL1

 FIG.5.2 OPTICAL PATH  SET UP FOR POSITIONING MEASUREMENTS- 

SCHEMATIC 

 

The distance L measured in the linear configuration 

depends significantly on the actual wavelength lair of the 

laser beam with the formula 
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),,(
**

HPTn
NNL vac

air

l
l   (5.1) 

,where N denotes the number of interference fringes, lvac 

is the laser wavelength measured in vacuum and n(T,P,H) is 

the refraction coefficient of the air.   

 The wavelength changes with the fluctuations of the 

parameters of the air: humidity, pressure and humidity. 

From the experimental formulas (see Chapter 17) it may be 

obtained the refraction coefficient dependences on T, P and 

H in usual conditions (T=293K, P=1000hPa, H=50%): 
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n 1
10*93,0 6  
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The changes of the wavelength are compensated 

automatically by the HPI-3D laser head only if the TH sensor 

is used properly, i.e. placed near the laser beam path. The air 

pressure is measured inside the laser head.  

 

 

ii. Principles – base temperature compensation 

 

One of the important factors limiting the precision of 

every machine is the temperature. In the Figure {2} there is 

schematically shown a milling machine. On the machine 
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there is  a work table with a workpiece. There is also 

schematically shown the measurement subsystem of the 

machine, i.e. the Scale. The position encoder (marked as 

Scale) is the part that is connected to the CNC control. It can 

be of different construction – magnetic, glass, laser, etc. Its 

expansion is corrected with positive sign in order to force the 

CNC control to leave the table in the same position despite 

the thermal expansion of the scale.  

 

Scale

0

Scale deadpath

workpiece
Workpie. 

offset

Table

Workpiece

 

FIG.5.3 BASE EXPANDABILITY COMPENSATION - NOTATION 
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The important parameters in the Scale length 

compensation are: 

- scale thermal expandability factor in [ppm] or 

[m/(m*K)] units; for glass scales it can have very low value 

- scale deadpath – the length of the non-used scale 

part or the distance between the beginning of the scale and 

the Zero mark. 

 The HPI-3D is capable of automatic compensation of 

the thermal expandability of the Scale. The user has only to 

properly use Base Temperature sensors (i.e. place them as 

close to the machine measurement system as possible) and to 

set the thermal expandability value of the Scale.  

 

 

iii. Measurement Setup Preparations 

 

For positioning measurements linear optics should be 

used. Necessary components are (see also figures 5.2 to 5.5): 

 Laser Head  

 Power Supply  

 Linear interferometer IL1 

 Linear retro-reflector RL1 

 Air temperature sensor TH (Important!!!) 

 At least one Base temperature sensor  (T1, T2 or 

T3) (Important!!!) 
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Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 

Positioning measurements require optical elements IL1 

and RL1 to be aligned along laser beam as shown in the 

figure 5.2. Each of the elements can be moved.  

During positioning measurements the Abbe, Dead Path 

and Cosine errors (for details – see the Chapter 17) have to be 

taken into consideration. The usage of the air temperature 

sensor and at least one base temperature sensor (T1 or T2 or 

T3) is absolutely necessary! More than one base temperature 

sensor should be used on long measurement axes, especially 

where a temperature gradient is possible.  
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FIG.5.3 OPTICAL PATH  SET UP FOR POSITIONING MEASUREMENTS IN X 

AXIS 

 

If only one base temperature sensor is used then all 

unused sensors should be switched off in the HPI Software. 

Otherwise the base temperature value would be false and the 

measurement would yield improper results. Switch singular 

sensors can be performed in the Display menu by clicking 

the value fields of the T1, T2 or T3 sensors in the WiMeteo 

panel. 

 

Positioning measurements can be performed not only 

along the laser beam (as shown in figures 5.2 and 5.3) but 

also in directions perpendicular to the laser beam. These 

configurations are shown in figures 5.4 and 5.5. In those two 
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configurations the laser beam has to enter the IL1 from the 

bottom of the element. Only the retro-reflector RL1 can be 

moved. 

 

 

FIG.5.4. OPTICAL PATH SET UP FOR POSITIONING MEASUREMENTS IN Y 

AXIS 
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FIG.5.5. OPTICAL PATH SET UP FOR POSITIONING MEASUREMENTS IN Z 

AXIS 

 

 

c. Software description 

 

i. Introduction 

 

In order to start Positioning measurements in the Main 

Menu the Positioning button should be pressed (Figure 5.6). 

On the screen there should appear a Linear positioning 

window as shown in the Fig. 5.7. The window consists of a 

pull-down menu and four panels:  
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 1) Display panel – presents information about 

current distance, target distance and measurement 

signal level; 

 2) Positioning plot panel; 

 3) Positioning results panel 

 4) Panel with control buttons and status 

information. 

 

 

FIG.5.6 MAIN MENU 

 

ii. Display Panel 

 

The top part of the Display Panel (block 1 of figure 5.7) 

is used for basic control of the laser operation. Through this 

panel it is possible to monitor the quality of the input signal, 
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i.e. the beam strength and the current value measured by the 

laser. Number of displayed digits can also be modified.   

 

 

 

FIG.5.7 LINEAR POSITIONING WINDOW 

 

In the top left corner of the Panel there are two fields 

named 1st measurement point and 2nd measurement point 

allowing tying the coordinate system of the laser with the 

coordinate system of the measured machine. This option is 

described in more details below in the Chapter. Also later in 

the chapter there is described an option for switching 

between 1D and 3D positioning. 

1 

2 

3 

4 
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iii. Positioning Plot Panel 

 

On the chart drawn in the Positioning Plot Panel there 

are shown information about the measured deviation 

between the real and the desired translation of the machine. 

On the plot the points are placed in two colors: the 

deviations measured during forward movement of the 

machine is shown with blue circles while the deviations 

measured during reverse movement are shown with red 

triangles. The points for the current measurement series are 

connected with the solid line (see Figure 5.8). 

 

 

FIG.5.8. PLOT WITH POSITIONING MEASUREMENT RESULTS  

 

Although the scale of the Y axis is set automatically by 

default but it is possible to set the display limits manually by 

choosing an Axis Y option from the pull-down menu (see 

Figure 5.8). Values in the axis X can be displayed either in the 

distance units or as numbers of measurement points.  
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iv. Positioning Measurement Values Panel 

 

In the Values Panel there are displayed numerical 

values of the positioning measurements (Figure 5.11). These 

are the values from the current measurement series and 

these are shown on the Positioning Plot as points connected 

with the solid line. 

The unit of the distance can be changed, independently 

on the unit of the chart, by clicking with the left mouse 

button on the distance (i.e. Ref.) column of the chart. There 

are two possibilities: true value of the distance or point 

number. 

 

 

v. Positioning Control Panel 

 

Positioning Control Panel is comprised of three main 

parts (Figure 5.11):  

 Line with control buttons 

 Line with measurement status information 

 Line with laser status information. 

 

The functionality of the line with the buttons changes 

with the current measurement state. In the Figure 5.9 there 

are shown various appearances of the control part of the 

Control Panel. 
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FIG.5.9 CONTROL PANEL – DIFFERENT MODES. CLARIFICATIONS IN TEXT 

 

Case A appears when there is no measurement in 

progress and no data were read from a file. In this mode it is 

possible either to start the measurement (“Start”), to reset the 

main counter (“Reset position”) or to return to the main 

menu of the program (“Menu”).  

Case B appears during measurements. The 

measurement can be stopped directly (“Stop”) or indirectly 

(“Menu”). After pressing the “Menu” button the software 

always asks if the measurement is to be stopped first. 

Case C is visible during analyses of the obtained results. 

If there are measured fewer series than the desired limit than 

the button “Next” becomes active. Pressing this button starts 

the measurement. The results obtained during the 

measurement will be added to the thus far registered results. 

Pressing “Repeat” button also starts new measurement but 

the results would supersede the results of the last 

measurement series. By pressing “New” button all registered 

results are cleared and a new measurement is started. 

 

A 

B 

C 
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 FIG.5.10. DATA BROWSING WINDOW 

 

Button “Browse” opens the results browse window 

(Figure 5.10). The functionality of this window is show in 

more details later in the Chapter.  Pressing “Report” opens 

Linear Positioning Report Window as shown in the Figure 

5.34. 

 

 

 

FIG.5.11. STATUS BARS IN POSITIONING WINDOW  

 

In the bottom part of the Positioning Control Panel there 

can be found two status lines. The upper one is presenting a 

configuration of the positioning measurements, the lower the 

state of the laser system 



MEASUREMENTS - POSITIONING 

 

5-18  www.lasertex.eu     

5  

In the first field of the upper line there is an information 

about the points capture method (manual or automatic). The 

next field informs about number of cycles in series (number 

of cycles executed one after one, if not active is the option 

Stop After Cycle). In the third field there is shown the 

information about measurement method selected in the 

Configuration. 

The bottom line shows information common to all 

options of the HPI Software, i.e. the state of Connection, 

Laser, Signal, Sensors and Rotary encoder. The functionality 

of the line is described in another Chapter. 

 

 

vi. Pull down menu - File 

 

The menu bar consists of following options: File, Edit, 

Measurement, View, Help. In the File menu (figure 5.12) can 

be found commands for reading measured data from a file, 

saving the data to a file, printing measurements results or 

exporting them to a file. 
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FIG.5.12. POSITIONING PULL-DOWN MENU FILE  

 

Other important commands available in the File menu 

are options for generating CNC path and preparing 

compensation table. 

 

vii. CNC path generation 

 

CNC path generation options allows automatic 

preparation, by the  HPI-3D software, the G-code program 

compatible with most CNC control systems. The options of 

the path generation are set in the separate window as shown 

in the figure 5.13.  

In the upper part of the window the machine movement 

parameters are set. In the lower part the generated program 
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can be viewed end edited. The results can be saved to a text 

file or previewed and printed. 

 

    

FIG.5.13. CNC PATH GENERATION WINDOW  

 

Following parameters in Software parameters panel 

should be configured in order to generate the proper code: 

 Measurement method - should be set accordingly 

with the chosen measurement method (see below). 

Choice must be made between linear, pendulum, 

pilgrim effective and pilgrim standard; 
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 Axis – the measured machine movement axis 

should be chosen (X, Y, Z, U, V, W, A, B, C). 

 Feed Rate – the maximum machine feed rate in 

the chosen axis during measurements can be 

modified. The chosen value cannot be greater than 

machine limitations (see manual of the tested 

machine) and laser limitation (7 m/s = 420000 

mm/min).  

 Stop Time – the time the machine stops at every 

measurement point. This time is necessary for the 

HPI Software to capture measurement point. The 

proper value of this parameter depends on the 

tested machine and on Point Capture parameters of 

the laser (described later in this chapter).  

  Step – the distance between measurement points.  

 Clearance – additional machine movement used 

to compensate backlash. The chosen value should 

be large enough for the proper backlash 

compensation of the machine. 

 Cycles number – sets the number of generated 

movement cycles. For proper calculation of 

statistical parameters in Report the number of 

measurement cycles should be not lower than 

three. The more measurement cycles is chosen the 

better characterization of the machine is done but 
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the longer the measurement process lasts. The 

number of cycles should be the same with the 

value in Configuration->Positioning->Cycles in series. 

 Points number – sets the number of measurement 

points. 

 Base point – the initial position of the machine in 

its own coordinate system. 

 Coordinate system – if used, the proper 

coordinate system should be chosen. 

 3D Measurement – if checked then the Stop Time 

value is automatically increased to make the 

simultaneous 3D measurements possible (3D 

module requires additional 2 seconds stop time 

during each point capture).  

 Unidirectional movement – if checked then the g-

code program is generated only for machine 

movement in one direction. This option is useful 

for rapid estimation of machine geometry and for 

very long machines. Should not be used for 

normal measurements. 

 g code/Heidenhain – it is possible either to 

generate the standard G-code program or a 

version compatible with Heidenhain machine 

controls.  
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viii. Compensation table preparation 

 

 

FIG.5.14. COMPENSATION TABLE PREPARATION WINDOW  

 

Compensation table preparation (figure 5.14) is an 

option used when measurement is finished (before 

measurement start it is not enabled). The measurement 

results are used by the software to calculate errors and 

generate the compensation values for the machine control 

system. Suitable format of the compensation table for 

machine control system has to be selected from Data format 

drop-down list. Together with the data format additional 

parameters are configured. 
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The option is described in more detail in the end of the 

chapter. 

 

ix. Pull down menu - Edit 

 

In the pull-down menu option Edit (fig. 5.15) there are 

options for setting measured machine data (Fig 5.16), 

defining machine error limits  (fig. 5.17), previewing 

obtained positioning results, editing positioning points 

(when option Target Points from List from menu 

Measurement is active) and changing overall positioning 

configuration.  

 

FIG.5.15. POSITIONING PULL-DOWN MENU EDIT  
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FIG.5.16 MACHINE DATAWINDOW 

 

 

x. Machine error limits 

 

In the Edit option the user can setup allowable error 

limits of the machine for different norms (option Machine 

error limits - Fig. 5.17). The results of the whole linear 

positioning measurements are compared with these limits 

(see Fig. 5.18). This option is especially useful when there are 

checked many machines of the same type and the same 

requirements on their accuracy are expected. 
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FIG.5.17. MACHINE ERROR LIMITS WINDOW 

 

 

FIG.5.18. MACHINE ERROR LIMITS COMPARATION PANEL 
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xi. Positioning points generation 

 

 

FIG.5.19. POSITIONING POINTS GENERATION WINDOW 

 

If option Target Points from List from menu 

Measurement is active, then the program expects the 

measured machine to stop in points defined in the 

Positioning points window as shown in the figure 5.19. 

Points can be entered manually or can be generated from the 

input parameters: start position (can be negative), distance 

(must be positive) and interval (must be positive) or number 



MEASUREMENTS - POSITIONING 

 

5-28  www.lasertex.eu     

5  

of points. The points are calculated when Calculate button is 

pressed. Obtained points can be saved to a file. 

xii. Configuration of Positioning measurement  

 

 

FIG.5.20 LINEAR POSITIONING COFIG WINDOW 

 

In the Positioning tab in the Configuration window the 

important options of the linear positioning measurements 

(Fig. 5.20) can be set.  

In the Measurement tab the user can choose the main 

parameters of the positioning measurement. The parameters 



MEASUREMENTS - POSITIONING 

 

5-29  www.lasertex.eu     

5  

grouped in the Point detection tab change the behavior of 

the software during point capture process. 

There are four available methods for checking machine’s 

positioning: Linear, Pendulum, Pilgrim Standard and 

Pilgrim Effective (buttons in Measurement method panel). The 

directions of the expected movement of the machine are 

shown in the pictograms and in figures 5.21, 5.22, 5.23 and 

5.24. Usually the Linear method is used.  

In the Cycles in series field the number of complete 

measurements cycles is set. The greater number of cycles is 

used the better result is achieved. At least three cycles are 

recommended for proper calculation of statistics. 

 

FIG.5.21. MACHINE MOVEMENT IN THE LINEAR MODE (S – STARTING 

POINT) 
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FIG.5.22. MACHINE MOVEMENT IN THE PENDULUM MODE (S – STARTING 

POINT) 

 

 

FIG.5.23. MACHINE MOVEMENT IN THE PILGRIM STANDARD MODE (S – 

STARTING POINT) 
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FIG.5.24. MACHINE MOVEMENT IN THE PILGRIM EFFECTIVE MODE (S – 

STARTING POINT) 

 

Measurement points can be either captured manually 

(with keyboard space or Strobe button) or captured 

automatically by the software. For automatic capture 

parameters set in the Point detection tab are used.  

 

 

 

 

 

Measurement points can be automatically detected by 

the software during measurement process or can be edited 

manually. The manual point list edition is described later in 

this chapter.  

 

For numerically controlled machines the Automatic point 

capture and Automatic point generation should be chosen. 
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Set of checkboxes allow further modification of the 

positioning process 

 Skip backlash compensation – if checked then the 

software does not expect the machine to make the 

backlash compensation movement (from point S to 

point 1 in the figures 5.21 – 5.24). When manual 

point capture option is chosen then there is no 

backlash compensation at the first measurement 

point! 

 Correct target value – if checked then the software 

confirms laser measured distance value of each 

captured point. Option usable for non-numeric 

machines. 

 Stop after each cycle – if checked then the 

measurements is stopped automatically after full 

measurement cycle (i.e. when machine returns 

back to position 0). The option is useful when 

intermediate results are to be viewed and 

analyzed. 

 Simultaneous 3D measurement – if checked then, 

during positioning measurements also a 3D 

straightness measurements are performed. Longer 

machine stop time in measurement points is 

required. 
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 Unidirectional measurements – if checked then 

the measurement is finished when machine return 

movement is detected and not when the machine 

returns back to zero. 

 

 

FIG.5.25. LINEAR POSITIONING COFIG WINDOW – POINT DETECTION 

 

The options available in the Point detection tab are 

usable only when Automatic Point Capture option is chosen. 

They define the conditions under which the software 

captures the measurement points.  
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A point is captured when the measured distance 

vibrations are lower than Vibration less than value after time 

defined in Point capture after. The measurement point value is 

rounded with tolerance set in Point tolerance.  

For example if the Point tolerance is set to 1.0 mm and 

laser measures 50.11mm, then a desired measurement point 

of 50.00 mm is taken with machine error of 0.11 mm. In the 

case when laser measures 60.61 mm the measurement point 

of 61.00 mm is taken with machine error of -0.39 mm. 

  In the case when the Point tolerance is set to 0.2 mm and 

laser measures 50.11mm, then a desired measurement point 

of 50.20 mm is taken with machine error of -0.09 mm. In the 

case when laser measures 60.61mm the measurement point 

of 60.60 mm is taken with machine error of 0.01 mm. 

 

xiii. Pull down menu – Measurement 

 

 

FIG.5.26. POSITIONING PULL-DOWN MENU MEASUREMENT  
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Measurement menu includes the options related to the 

measurement process:  

Stop after each cycle – if this option is active program 

breaks the measurement when a measuring cycle is 

completed; if it is not active the configured number of cycles 

is executed.  

Correct target value – setting this option enables to 

change an earlier defined distance value of a measuring 

point during the measurement process. Before the point is 

captured, appears a window in which a new distance value 

can be written. In the edit field there are only marked places 

after comma what causes that it is not necessary to write the 

whole distance. 

Skip backlash compensation – if checked then the 

software does not expect the machine to make the backlash 

compensation movement (from point S to point 1 in the 

figures 5.21 – 5.24). 

Automatic point capture – program captures 

measurement points automatically using settings from 

Configuration. In this mode the system itself recognizes the 

moment of stop, the value of target point, the direction of 

movement and the series number. Option exclusive with 

“Manual point capture”. 

Manual point capture – measured points are captured 

by the program when a Manual Capture button, Space key or 
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a remote Strobe button is pressed. Option exclusive with 

“Automatic point capture”.  

Automatic points generate – positioning points are 

calculated automatically by the program. Points calculation 

is performed in first measuring cycle. Option exclusive with 

“Points from list”. 

Points from list – when this option is selected on the 

screen appears a window for positioning points edition. This 

window enables to write or calculate distance values for 

positioning points which are compared to measured points 

during positioning measurement. Option exclusive with 

“Automatic points generate”. 

 

 

FIG.5.27. POSITIONING PULL-DOWN MENU VIEW  

 

View menu is used to switch on or off a Deviation table 

and to switch on drawing on the graph points from All 

cycles (active cycle is drawn using solid line but remaining 

cycles are illustrated using only points). Show pictogram 

command is used to present a schematic diagram of selected 

measurement method. 
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d. Preparations for measurement  

 

i. Measurement window 

 

 

FIG.5.28 CHOICE BETWEEN 1D AND 3D POSITIONING 

 

If the system is ready to work, then two digital displays 

and the gauge of measuring signal level appear on the 

screen. On the upper display the measured value is shown. 

On the bottom display the value of the target position (read 

from data points table or appointed automatically) is shown.  

Under the displays on the left side there is shown a graph on 

which the results of measurements are shown. On the right 

side an Error Table can be found. Under the graph three 

buttons can be found:  
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 Start - beginning of the measurement,  

 Reset Position – resetting the measured value and 

the button  

 Menu - allowing returning to the Main menu. 

 

ii. 1D and 3D measurements 

 

In the right upper corner of the main positioning 

window (see figure 5.28) there is placed the button for 

choosing if the laser measures only the positioning (“1D”) or 

if the 3D axes straightness is measured simultaneously 

(“3D”). If the “3D” option is chosen, together with the 

positioning data, the straightness data in horizontal and 

vertical planes are gathered.  

 

 

FIG.5.29. 3D DATA BROWSING  

 

All measured data can be browsed during 

measurements by changing data panels (figure 5.29). The 

data from actual measurement series are shown in the table 

and on the chart connected with lines. Points from previous 
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obtained series are visible on the chart as blue circles or red 

triangles. 

 

 

iii. Measurements in machine coordinate system 

 

It is possible to obtain positioning measurements 

directly in the machine coordinate system. To do this the 1st 

machine point and 2nd machine point fields have to be filled (see 

figure 5.31). In these fields the position of first two 

measurement points in the machine coordinate system has to 

be entered. After modification of these fields the 

measurement results is shown in the machine coordinate 

system. Also the error compensation files are changed 

appropriately.  

 

 

FIG.5.31. CONNECTING COORDINATE SYSTEMS OF LASER AND MACHINE  
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iv. Setting measurement points 

 

The linear positioning measurement requires target 

positions which define the points where positioning errors 

are calculated. The target points can be automatically 

defined during the first cycle in the measurement, or 

manually written to the list or calculated (Target Points 

From List). Points are detected with 1.0 mm tolerance in 

automatic mode (if other point tolerance value is required, 

then Configuration->Positioning->Point detection->Point 

tolerance value should be changed). The positioning points 

can be also written or calculated after marking an option 

Target Points From List (see figure 5.19). After activating 

this option the positioning points can be defined with any 

accuracy.  

Measurement can be performed in an Automatic option 

or in a Manual Capture option as described earlier in this 

chapter. In the automatic mode the system itself recognizes 

the moment of stop, the value of target point, the direction of 

movement and the series number.  

 

e. Rules of automatic positioning measurement  

 

For correct operation of the automatic positioning 

measurement option below rules should be followed:  
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1) The time of machine stand still duration in the 

positioning point  must be no less than 1 second – default 

value (this can be changed in the Configuration->Positioning-

>Point detection->Point capture after),  

2) Vibrations of the target  should be less than 10 m - 

default  value (this can be changed in the  Configuration-

>Positioning->Point detection->Vibrations less than),   

3) Backlash compensation move of the machine should 

exceed 1.0 mm.           

If vibrations are too large and system does not capture 

points – then the option Manual Capture should be switched 

on in the Measurement menu. 

 

 

 

f. Remarks on measurements and on data 

analysis 

 

Examination of linear positioning of machine consists of 

at least 2 measuring cycles.  

In every cycle the measured the machine moves the 

retro-reflector for programmed distance forward and back. 

 After each shift the machine should stop for a time of at 

least one second.  

From practical point of view, because of machine 

vibration, the stop time should exceed 3 seconds.  
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The measured distance by the laser system is saved in 

the table of results.  

After one cycle, if Stop after each cycle is set or after the 

whole measurement process the window with results 

appears (figure 5.32). 

 

 

FIG.5.32. POSITIONING WINDOW AFTER FINISHING A FULL 

MEASUREMENT CYCLE  

 

Buttons Remove and Add can be used to remove or add 

the measurement cycle. It is possible to change the 

measuring cycle in which accidental error is suspected. 

Button Browse opens data browsing window (figure 5.33) 

where each data cycle can be viewed and analyzed.  
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FIG.5.33. DATA BROWSING WINDOW  

 

Both from main positioning window and from data 

browsing window the measurement report can be generated. 

If at least two series of measuring cycles are completed, 

statistical calculations can be performed and the report can 

be generated. In order to get the final report the Report 

button has to be pressed. The screen of the computer after 

pressing the button Report is presented on fig. 5.34. 
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FIG.5.34. LINEAR POSITIONING REPORT WINDOW 

 

The positioning results are presented on the graph and 

in the Results panel. This panel is also used to set 

measurement data processing parameters. The norm defines 

a statistical method used in calculations and can be chosen 

from a pull-down list. Norm selection causes recalculation of 

the results. Limit values for measured machine parameters 

are presented in this panel. They are assigned to the machine 

that is chosen from Machine pull-down list. If the error 

value exceeds limits for the machine, this error is displayed 

in red. 

Under the graph there are: buttons used for report 

Preview, Print the report, change of the graph Parameters, 

and return to the previous window. 



MEASUREMENTS - POSITIONING 

 

5-45  www.lasertex.eu     

5  

The axis scale can be changed using Axis Scale 

(automatic scaling or assignment, minimum and maximum 

values) option available by right mouse click on the graph. 

             

 

FIG.5.35. LINEAR POSITIONING REPORT EXAMPLE 
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The generated report can be simplified or extended. The 

selection window is shown each time the Preview or Print 

buttons are pressed. The simplified version consists of three 

pages: the title page, the results page and the chart page – see 

also figure 5.35. The logo on the title page can be changed in 

the Configuration->Parameters. In the Extended Report 

additional pages with measurement results are added. The 

number of additional pages depends on the number of 

gathered measurement points. 

 

g. Machine error compensation 

 

When the measurement is finished the data can be saved 

to a file or exported as a text file (pull down menu File-

>Export). Text file export gives possibility of further analysis 

of obtained data in mathematical tools like Matlab, 

Mathematica or Excel. 

The HPI Software from the positioning results generates 

also the text compensation file for the machine control 

(figure 5.35). At this moment there are available eight 

different formats of the output files. Format should be 

selected according to the type of the control of the machine. 

Depending on the chosen output data format different 

set of parameters appears in the Error Compensation 
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window (figures 5.37-5.39). Below there are described most 

commonly used data formats. 

 

 

FIG.5.36. MACHINE ERROR COMPENSATION 

 

i. Absolute and Incremental data formats 

 

The basic and most universal error correction file 

formats are Absolute and Incremental. In this case the data are 

formatted as a simple table with five columns (figure 5.37):  

 number of positioning point 

 distance value in the positioning point 

 error in forward direction 
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 error in reverse direction 

 mean error 

In the case of the absolute format the values of errors are 

absolute, non-relative. In the case of the incremental format 

the errors in the certain point are calculated relative to the 

errors in the previous point, taking error in the first 

measurement point as zero.  

 

 

FIG.5.37. MACHINE ERROR COMPENSATION – LINEAR AND 

INCREMENTAL DATA FORMAT 

 

The compensation window for those formats is shown 

in the figure 5.37. The user can change the Error unit between 
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m and mm and the Base point. The base point value is 

added to all position values in the second column. 

 

ii. Siemens data format 

 

The Siemens data format file is usable in most 

commonly used machine control units produced by Siemens. 

The choice is between types 828 and 840. For older control 

units the incremental data format should be used.  

 

 

FIG.5.38. MACHINE ERROR COMPENSATION – SIEMENS DATA FORMAT 

 

As shown in the figure 5.38 the format of the Siemens 

file differs greatly from the absolute/incremental format. 
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The Siemens type file can be stored to a file and uploaded 

directly to the corrected machine (with 828 or 840 drives).  

It is possible to set proper Measurement system, change 

the machine Base point (not necessary when the machine 

coordinate system is used) and change the compensated Axis 

name.  

 

iii. Fanuc data format 

 

 

FIG.5.39. MACHINE ERROR COMPENSATION – FANUC DATA FORMAT 

 

The Fanuc data format file is usable in most commonly 

used machine control units produced by Fanuc. The choice is 

between different types of Fanuc control units.  
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As shown in the figure 5.39 the format of the Fanuc file 

differs greatly from the absolute/incremental format. The 

Fanuc type file can be stored to a file and uploaded directly 

to the corrected machine.  

It is possible to set proper Data offset (should be in 0-1023 

range), change the machine Base point (not necessary when 

the machine coordinate system is used) and change the 

compensated Axis name.  
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6. MEASUREMENTS - VELOCITY 

 

 

 

 

 

 

a. General Description 

 

Velocity measurements are performed with the use of 

linear optics. This measurement can be used, for example, for 

characterization of motor movement.  The System enables to 

measure velocity in different units. It can be configured in 

Configuration->Velocity option. The value of velocity is 

sampled every 40ms. 

 

 

b. Measurement Setup 

 

For velocity measurements linear optics should be used. 

Necessary components are (see also figures 6.1 to 6.4): 

 Laser Head  

 Power Supply  

 Linear interferometer IL1 



MEASUREMENTS - VELOCITY 

6-2  www.lasertex.eu     

6  

 Linear retro-reflector RL1 

 

Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Base temperature sensor  

 Air temperature sensor 

 

Velocity measurements require optical elements IL1 and 

RL1 to be aligned along laser beam as shown in the figure 

6.1. Each of the elements can be moved.  

During velocity measurements the usage of the air 

temperature sensor is recommended. Base temperature 

sensors do not have to be used. 

 

LASER  HEAD

IL1 RL1

 FIG.6.1 OPTICAL PATH SET UP FOR VELOCITY MEASUREMENTS- 

SCHEMATIC. 

 

Velocity measurements can be performed not only along 

the laser beam (as shown in the figures 6.1 and 6.2) but also 
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in directions perpendicular to the laser beam. These 

configurations are shown in the figures 6.3 and 6.4. In those 

two configurations only the retro-reflector RL1 can be 

moved. 

 

 

FIG.6.2 OPTICAL PATH  SET UP FOR VELOCITY MEASUREMENTS IN X AXIS. 
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FIG.6.3. OPTICAL PATH  SET UP FOR VELOCITY MEASUREMENTS IN 

Y AXIS. 

 

FIG.6.4. OPTICAL PATH  SET UP FOR VELOCITY MEASUREMENTS IN 

Z AXIS. 
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c. Software description 

 

Velocity is measured in the Velocity option, chosen 

from the Main Menu. In the Fig. 6.5. there is presented a 

main window of the Velocity option in the HPI Software. The 

window consists of four main parts:  

 Display – presents a current velocity and 

measurement signal level; 

 Velocity plot – blue line is a plot of the measured 

velocity, red line is a plot of the averaged velocity; 

 Velocity value table – a table containing 

consecutively numbered samples, time elapsed 

from start, and current velocity value; 

 Panel with buttons 
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FIG.6.5. VELOCITY MEASUREMENT WINDOW. 

 

Velocity measurement is launched by the Start button 

and software performs a continuous velocity data acquisition 

of the measured object. The measurement is finished by the 

Stop button. During measurements the velocity graph will 

be constantly updated on the screen. By clicking on a part of 

the graph and moving the mouse rightwards the graph can 

be zoomed. By clicking on a part of the graph and moving 

mouse leftwards the zoom is cancelled. The graph can be 

printed or saved to a file. Those commands are available 

from the File menu (i.e. Save, Save as, Print – see figure 6.6).  
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FIG.6.6. VELOCITY  PULL-DOWN MENU FILE.  

 

Before saving the file the program asks about machine 

data (option available from pull-down menu Edit->Machine 

data), like machine type, machine serial number, measured 

axis or machine operator (see figure 6.7). Those values allow 

describing performed measurement for later analysis and 

they are also present on the printed report. 
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FIG.6.7. MACHINE DATA WINDOW.  

 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview in the 

measurement analysis window (fig. 6.8). The report can be 

generated in the basic form where only the plot of the 

measured values is shown (fig. 6.9) or in the extended 

version, which contains tables with measured data. 
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FIG.6.8. VELOCITY MEASURED DATA ANALYSIS WINDOW.  

 

 

FIG.6.9. VELOCITY REPORT PREVIEW WINDOW. 

 

It is also possible to copy the velocity graph to the 

clipboard and then paste it for example to a Word editor 
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document. Copy to clipboard command is available from 

popup menu that appears after right-click on the area of the 

graph.  

The velocity unit can be set in the Configuration, 

Velocity tab (see figure 6.10). Configuration is available 

from Edit menu. 

 

 

FIG.6.10. VELOCITY CONFIGURATION OPTIONS. 
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d. Measurement procedure 

 

1. Set up the laser on the measured machine and 

align optical path. 

2. Start the HPI-3D software and select Velocity 

option. 

3. Choose desired Velocity unit in the Configuration 

window (optional). 

4. Press Start button and run the machine. 

5. When the machine stops, press Stop button, save 

the results and/or print the measurement report. 
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7. MEASUREMENTS - STRAIGHTNESS 

 

 

 

 

a. General Description 

 

Straightness measurements is a measurement usually 

used to gain basic information about the machine axis 

geometry. With this option the user can measure machine 

base straightness on all important surfaces of the base or 

check the movement of e.g. the measured machine’s element 

in space. 

In the HPI-3D device the straightness measurements can 

be performed with three different methods: Angular, 

Wollaston and 3D. Angular method is designed to be used in 

base straightness measurements (like optical autocollimator); 

Wollaston method is designed for “movement in space” 

measurements – e.g. the movement of a machine table or 

working tool can be characterized; 3D method is used for 

rapid estimation of “movement in space” – like Wollaston 

method but the measurement is performed in the three axes 

at once. The main parameters of those methods are described 

in the Technical Data chapter. 
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b. Measurement Setup – Angular optics 

 

i. Principles  

 

The operation of the HPI-3D with the angular optics 

used is shown in the Figure 7.1. The laser outputs the laser 

beam consisting of two polarizations: Horizontal (H) and 

Vertical (V). The IK1 splits the beam into two parts. Both 

beams are directed into the measurement path but are 

parallel shifted by 1’’ or 2’’ distance (depending on the 

version).  

 

RK1IK1

LASER  HEAD

Horizontal & Vertical polarization

Horizontal polarization

Vertical polarization

Beam Path 1

Beam Path 2

 

FIG.7.1.  ILLUSTRATION OF THE PRINCIPLE OF OPERATION - ANGULAR 

OPTICS 

 

When the distance between optical elements altered 

then the frequency of both beams is changed according to the 

Doppler Effect. The laser head does notice a movement only 
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if there is a rotation of IK1 versus RK1, i.e. when there is 

difference in lengths of beam paths. The measured distance 

can then be used to obtain either the rotation angle (pitch or 

yaw of the machine) or the vertical movement of the optical 

component (IK1 or RK1). 

 

 

 

L

h

x

α 

S

 

FIG.7.2.  CALCULATION OF STRAIGHTNESS DURING ANGULAR 

MEASUREMENTS - NOTATION 

 

The laser head with angular optics is insensitive to linear 

movements. 
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In the Figure 7.2 there is shown schematically an RK1 on 

a carriage with all parameters important for calculation. For 

the clarity the position of IK1 is treated as a reference. The 

meaning of the parameters is:  

L – base length; 

 s – distance between beams on IK1 and RK1 

elements; 

 x – distance measured by the Laser Head 

 - angular rotation of RK1 element 

 h – difference in height between two measurement 

points 

 

The Laser Head measures the parameter x while the 

distance between beams s and the base length L must be set 

in the parameters of the HPI Software. Then the rotation 

angle  and the movement in the vertical direction h can be 

calculated from: 

 

s

L
xh

s

x

*

arctan





 (7.1) 

 

ii. Application Notes 
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LASER  HEAD

IK1

α0

Measured guide rail

RK1

α1

α2

 

FIG.7.3.  MEASUREMENT OF STRAIGHTNESS - PRINCIPLES  

 

 

The angular optics can be used for: 

 Measurement of pitch or yaw of a machine 

 Measurement of straightness of a machine bed 

 Measurement of small angles 

 

The explanation of the first two applications is shown in 

the Figure 7.3. The RK1 mounted on a carriage is translated 

over the measured guide rail. Every length of the carriage 

(usually 100mm) a measurement is performed. Formulas 7.1 

are then used for calculation of the angles (for pitch/yaw 

measurements) or the vertical translations (for straightness 

measurements).   

It is worth to notice that such straightness measurement 

method requires proper choice of measurement points. 

Choosing points denser than the carriage size results in 

excessive values of the straightness errors (the shape of the 

error is proper).  

 



MEASUREMENTS – STRAIGHTNESS 

7-6  www.lasertex.eu     

7  

LASER  HEAD

IK1

α0 α0

Measured guide rail

RK1

 

FIG.7.5.  MEASUREMENT OF STRAIGHTNESS WITH TOO SPARSE MEASUREMENT 

POINTS  

 

Choosing points too sparse may effect both the shape 

and the value of the error as shown in the Figure 7.5. In this 

special case because of too sparse measurement points the 

laser will not notice the change in the shape of the guide rail 

– the measured distance between beams will not change! 

 

The measurement of small angles allows very accurate 

measurements of small rotations if two conditions are met: 

1. measured angle is within ±5 degrees 

2. distance between RK1 and the laser head does not 

change more than a few centimeters.  

The second limitation comes from the heterodyne effect 

present in the HPI-3D laser. This effect influences the angle 

according to (l is the change of distance between the laser 

and RK1 during measurements) : 

s

mlx 


260.2*
arctan


  (7.2) 
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The above effect is present also in the normal 

straightness measurements but it is taken care by the HPI 

Software.  

 

 

iii. Measurement Setup Preparations 

 

For Angular straightness measurements the angular 

optics should be used. Necessary components are: 

 Laser Head  

 Power Supply  

 Angular Interferometer IK1 

 Angular Retro-reflector RK1 

 

Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Air temperature sensor  

 Base temperature sensor  

 

Angular straightness measurements require optical 

elements IK1 and RK1 to be aligned along laser beam as 

shown in the figure 7.6. Each of the elements can be moved.  
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During Angular straightness measurements the usage of 

the air temperature sensor is recommended. Base 

temperature sensors do not have to be used. 

LASER  HEAD

IK1 RK1

 FIG.7.6 OPTICAL PATH  SET UP FOR ANGULAR STRAIGHTNESS 

MEASUREMENTS- SCHEMATIC. 

 

 

FIG.7.7 OPTICAL PATH  SET UP FOR ANGULAR STRAIGHTNESS 

MEASUREMENTS IN X AXIS. 

 

Angular straightness measurements can be performed 

not only along the laser beam (as shown in figures 7.7 and 
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7.8) but also in directions perpendicular to the laser beam. 

Such configuration is shown in figure 7.9. In this 

configuration only the retro-reflector RK1 can be moved. 

 

 

 

FIG.7.8 OPTICAL PATH  SET UP FOR ANGULAR STRAIGHTNESS 

MEASUREMENTS IN Y AXIS. 
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FIG.7.9 OPTICAL PATH  SET UP FOR ANGULAR STRAIGHTNESS 

MEASUREMENTS IN Z AXIS. 

 

During beam alignment it is important first to set up the 

position of IK1 aligned with the position of the laser head. 

Then the diaphragms on both optical components should be 

switched into the alignment position. The IK1 and RK1 

should be set in such a way that the beam passes the centers 

of diaphragms.  

After successful setup the diaphragms are to be set into 

work position and final alignment should be done with the 

use of electronic beam alignment tool. In order to keep the 

highest precision of the measurement the position of both 

beams on the alignment tools should stay within 200m 

window for the whole linear movement range. 
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c. Measurement Setup – Wollaston optics 

 

i. Principles 

 

LASER  HEAD

WP2

WRP2

Beam Path 1

Beam Path 2

 

FIG.7.10 WOLLASTON PRISM OPTICS - PRINCIPLES 

 

 

Another way of measuring straightness, parallelism and 

squareness with the laser interferometer requires the use of 

Wollaston type optics.  The optics consist of two elements: 

Wollaston polarizing prism WP2 and a paired reflector 

WRP2 – see Figure 7.10. The laser beam, consisting of two 

perpendicular polarizations, is split by the WP2 element into 

two beams. The beams are leaving the WP2 at a certain angle 

and then, after being reflected back by the reflector WRP2 are 

returning to the laser head. The laser measures the difference 

between beams’ paths lengths. 
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θ

α 

 

FIG.7.11 WOLLASTON PRISM POLARIZER WP2 

 

In the Figure 7.11 there is shown the explanation of the 

operation of the WP2 element. This prism is constructed of 

two birefringent triangle prisms cemented together. Both 

prisms are built from the same material but their ordinary 

and extraordinary axes are perpendicular to each other, i.e. 

refraction coefficient of the ordinary axis of the left prism nol 

equals to the coefficient value of the extraordinary axis of the 

right prism ner.  

Because of this the orthogonally polarized laser beams 

entering the Wollaston element are deflected at different 

angles on the middle boundary layer and on the right 

boundary layer. This behavior can be easily proven with the 

use of the Snell’s law. The angle between the exiting beams is 

often denoted as .  
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180 - θ 

Y

X

FIG.7.12A WOLLASTON REFLECTOR WRP2 – FRONT VIEW 

 

180 - θ 

Y

X

 

FIG.7.12B WOLLASTON REFLECTOR WRP2 – TOP VIEW 

 

 

Unlike in the angular optics (see previous part of this 

Chapter) the distance between beams are changing with 

distance, thus making the construction of the reflecting 

element difficult. In the figure {7} there is shown the 

construction of the reflection element for the Wollaston 

optics WRP2. It consists of two special glass prisms glued 

very precisely at 180-angle. The prisms used in the WRP2 

in y axis reflect the beam with ½’’ translation (like the 

retroreflector RL1). In the x axis the beam is reflected with no 

translation (like in a mirror). 
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The use of Wollaston optics makes possible the 

measurement of relative movement of WP2 element in the 

axis perpendicular to the laser beam. As it is shown in the 

Figure 7.13 the measurements are possible ONLY with the 

WP2 movement.  

LASER  HEAD

WP2

WRP2

 FIG.7.13 MEASUREMENTS WITH WOLLASTON OPTICS 

 

Because of the sensitivity of the laser readout on the 

angular movement of the WRP2 it is important that during 

measurements the WRP2 element is neither touched nor 

moved. In more details it is described in the next section.  

 

ii. Application Notes 

 

Although it is possible to measure the straightness either 

with movement of the WP2 or WRP2 element but there are 

certain differences. The WRP2 this element should be 

stationary during measurement (i.e. should not be moved 

along the laser beam). As the WRP2 behaves in one of the 

axis like a mirror thus any angular movement of the WRP2 



MEASUREMENTS – STRAIGHTNESS 

7-15  www.lasertex.eu     

7  

in this axis may result in the laser beam not returning to the 

laser head and will influence significantly the measurement 

results! 

 

 

There are no such problems when the WP2 is moved 

instead. The only disadvantage is the smaller measurement 

range. WP2 can be moved ±2mm while maximal 

measurement range of the WRP2 is ±30mm (but only when 

the distance between WP2and WRP2 is 4.5 m). 

 

 

 

iii. Measurement Setup Preparations 

 

For Wollaston straightness measurements the Wollaston 

optics should be used. Necessary components are: 

 Laser Head  

 Power Supply  

 Wollaston prism WP2 

 Wollaston retro-reflector WRP2 

 

Optional elements are: 

 USB cable 

The laser head with Wollaston optics is sensitive to angular 

movements of the reflector! 
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 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Air temperature sensor  

 Base temperature sensor  

 

Wollaston straightness measurements require optical 

elements WP2 and WRP2 to be aligned along laser beam as 

shown in the figure 7.14. The beam alignment procedure is 

described in the fourth chapter. 

During measurement the WRP2 element should be 

stationery, i.e. its distance from the laser head should not 

change.  

During Wollaston straightness measurements the usage 

of the air temperature sensor is recommended. Base 

temperature sensors do not have to be used. 

LASER  HEAD

WP2

WRP2

 

FIG.7.14 OPTICAL PATH  SET UP FOR WOLLASTON STRAIGHTNESS 

MEASUREMENTS- SCHEMATIC. 
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Wollaston straightness measurements can be performed 

in two configurations – horizontal X (figure 7.15) and vertical 

Z (figure 7.16). In configuration X only the straightness of 

path in X axis is measured. The same situation is with Z 

setup. In both configurations the measurements should be 

performed with the moving of WP2 element. 

 

 

FIG.7.15 OPTICAL PATH  SET UP FOR WOLLASTON STRAIGHTNESS 

MEASUREMENTS IN X AXIS. 
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FIG.7.16 OPTICAL PATH  SET UP FOR WOLLASTON STRAIGHTNESS 

MEASUREMENTS IN Z AXIS. 
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d. Measurement Setup – 3D method 

 

i. Principles 

 

The HPI-3D laser head is capable of detecting the 

position of  the returning beam. The position of the returning 

beam changes with the movement of the retroreflector RL1 

perpendicular to the laser beam axis.  This phenomena for 

one axis is shown in the Figure 7.17. The beam returning 

from the linear interferometer IL1 is treated as a reference 

while the beam reflected by RL1 as measuring beam. The 

laser simultaneously registers information about the changes 

of position of an optical component in both axes 

perpendicular to the laser beam.  

 

LASER  HEAD

 FIG.7.17 STRAIGHTNESS MEASUREMENTS WITH LINEAR OPTICS 

 

The measured position is then used either for precise 

control of the laser beam path alignment or for the 

straightness, squareness or parallelism measurements.  

The 3D measurement returns absolute values of the 

beam position. This is different from the main, 
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interferometric measurement axis where obtained results are 

incremental. 

 

 

ii. Application Notes 

 

The 3D option can be used for rapid estimation of 

straightness simultaneously in two axes but with some 

limitations resulting from physical nature of the 

measurements.  

 

Unlike in all interferometric measurements, the laser 

head takes active part in the measurements, i.e. its position 

and its vibrations influences the measurement results. For 

this reason it is important to avoid using the tripod stand 

and to fix the laser head directly on the measured machine.  

 

The 3D measurement bases on the position of the 

returning beam on the position sensitive device. Thus it is 

important that the beam stays within the measurement 

range of the device, i.e. ±1 mm. Using 3D option outside this 

range would produce unreliable results.   

 

Similarly to all laser based straightness measurements 

the air turbulences have an influence on the results. Small 

wandering of the laser beam can be accommodated by the 
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signal processing circuit inside the laser with the change of 

averaging time (see Software Description for more details). If 

the air movements are too large – i.e. when the beam 

returning to the laser wanders outside ±1 mm window - then 

the results of the 3D measurements may become unusable. In 

such situation either some shielding from the air movement 

or a fan forcing the air movement have to be used. The 

problem with air turbulences is more troublesome for larger 

distances between the laser head and RL1 element. 

 

 

iii. Measurement Setup Preparations 

 

For 3D straightness measurements linear optics should 

be used. Necessary components are (see also figures 7.18  to 

7.21): 

 Laser head – Laser Interferometer  

 Power supply - Laser Interferometer Power Supply 

 Linear interferometer IL1 

 Linear retro-reflector RL1 

 

Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM1 

 Tripod stand (not recommended) 



MEASUREMENTS – STRAIGHTNESS 

7-22  www.lasertex.eu     

7  

 Air temperature sensor  

 Base temperature sensor  

 

3D straightness measurements require optical elements 

IL1 and RL1 to be aligned along laser beam as shown in the 

figure 7.18. Only the retro-reflector RL1 should be moved. 

During 3D straightness measurements the usage of the 

air temperature sensor is recommended. Base temperature 

sensors do not have to be used. 

 

LASER  HEAD

IL1 RL1

 FIG.7.18 OPTICAL PATH SET UP FOR 3D STRAIGHTNESS MEASUREMENTS- 

SCHEMATIC. 

 

3D straightness measurements can be performed not 

only along the laser beam (as shown in figures 7.18 and 7.19) 

but also in directions perpendicular to the laser beam. These 

configurations are shown in figures 7.20 and 7.21. Also in 

those two configurations only the retro-reflector RL1 can be 

moved. 
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FIG.7.19 OPTICAL PATH  SET UP FOR 3D STRAIGHTNESS MEASUREMENTS 

IN X AXIS. 

 

FIG.7.20. OPTICAL PATH  SET UP FOR 3D STRAIGHTNESS MEASUREMENTS 

IN Y AXIS. 



MEASUREMENTS – STRAIGHTNESS 

7-24  www.lasertex.eu     

7  

 

FIG.7.21. OPTICAL PATH  SET UP FOR 3D STRAIGHTNESS MEASUREMENTS 

IN Z AXIS. 

 

 

e. Software description 

 

 

i. Introduction 

 

Straightness measurement are performed in the 

Straightness option, chosen from the Main Menu (fig. 7.22).  
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FIG.7.22 MAIN MENU 

 

The Straightness HPI Software program window is 

shown in the Fig. 7.23. The window consists of a pull-down 

menu and five panels:  

 1) Display – presents current distance and 

measurement signal level; 

 2)  Straightness Plot – in the 3D mode there are 

visible plots for vertical and horizontal axis, in the 

Angular and the Wollaston mode only one plot is 

visible; 

 3)  Panel for changing the operation mode; 

 4) Straightness value table – a table containing 

consecutively numbered samples and measured 

straightness value (or two values in 3D mode); 
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 5)  Panel with control buttons and status 

information. 

 

 

 

FIG.7.23. STRAIGHTNESS MEASUREMENT WINDOW WITH PANELS. 

 

 

 

ii. Display Panel 

 

The Display Panel (figure 7.24) is used for basic control 

of the operation of the interferometric part of the laser. 

Through this panel it is possible to monitor the quality of the 

input signal, i.e. the beam strength and the current value 

measured by the laser. Depending on the chosen 

1 

2 

3 

4 

5 
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measurement type the values are displayed in different units 

(figures 7.24A,B and C): for angular and pitch/yaw 

measurement types it is arcseconds, for Wollaston it is 

micrometers and for 3D it is millimeters. For the 3D option 

the value displayed on the panel is only an auxiliary one – 

the straightness readouts are shown on the Straightness Plot 

panel described below.  

 

 

 

 

FIG.7.24 DISPLAY PANEL DURING (A) ANGULAR, (B) WOLLASTON, (C) 3D 

TYPE MESUREMENTS 

 

Through the buttons available on the Display Panel it is 

possible to change either the sign or the displayed resolution 

of the current measurement result. The setting of the sign 

influences the values registered in Straightness Plot and 

Values Table. Changing number of digits have no influence 

on the measurement.  

 

 

FIG.7.25 DISPLAY PANEL AFTER 3D TYPE MESUREMENTS 

A 

B 

c 
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After the 3D measurements are finished then on the 

Display Panel appears additional button. This is shown in 

the Figure 7.25. Pressing this button makes possible retaking 

any measurement point. The remeasurement procedure is 

described further in the Chapter.  

 

iii. Straightness Plot Panel 

 

 

FIG.7.26 STRAIGHTNESS PLOT PANEL IN THE ANGULAR AND WOLLASTON  

OPTIONS 

 

The Straightness Plot panel is the place where 

measurement results are displayed. The measurement results 

are placed on the plot(s) as soon as they are registered by the 

laser head. There can be one or two plots displayed in 

dependence on the measurement type. For angular and 

Wollaston type measurements there is only one plot (fig. 
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7.26) because with this optics it is possible to measure 

straightness only in one axis at a time. 

 

 

FIG.7.27 STRAIGHTNESS PLOT PANEL IN THE 3D OPTION 

 

The Straightness Plot during the 3D measurement looks 

differently (fig 7.27) because simultaneously there are 

measured: the distance between RL1 and IL1 (shown in the 

Display Panel) and the position of the RK1 in the axes 

perpendicular to the laser beam (denoted as horizontal axis 

and vertical axis).  

Both straightness values can be resetted by pressing 0 

button on the small displays. It has to be remembered that 

this resetting is valid only for the current measurement – 3D 

straightness values are absolute and not incremental like in 

the interferometric channel. 

In the bottom right corner of the panel there are 

displayed the edge values of the straightness, i.e minimal 
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value Min, maximal value Max, amplitude of the straightness 

Ds=Max-Min. In the case of 3D measurements those values 

are shown for each axis. 

 

 

FIG.7.28 POP UP MENU ON THE STRAIGHTNESS PLOT PANEL 

 

The units on the vertical axis of the straightness plot 

depend on the actual configuration set in the Configuration-

>General option. For straightness measurements these are 

usually micrometers while for  pitch/yaw measurements 

arcseconds. The displayed range is set automatically but it 

can be set also manually. On the horizontal axis there can be 

displayed either the distance or measurement points 

numbers. 

After the right mouse button click on the chart axis the 

pop-up menu as shown in the Figure 7.28 will appear. The 
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options in this menu are used for modification of displaying 

of horizontal and vertical axes of the chart. The chart can also 

be copied to clipboard (“Copy to clipboard” option) for 

further pasting into a document editing software (like 

Microsoft Word or OpenOffice Write). 

 

 

 

FIG.7.29 CHART ZOOMING 

 

The displayed chart can be zoomed in and out with the 

use of the mouse. Zooming in requires marking the top left 

corner of the desired area by pressing the left mouse button. 

The button has to be held and the mouse pointer should be 

moved to the bottom right corner of the desired are. The 

auxiliary red dashed lines as shown in the Figure 7.29 should 

appear. Zooming out is done by moving the pressed left 
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mouse button from the bottom right corner to the top left 

corner.  

Zoomed chart view can be shifted by pressing the right 

mouse button on the chart (and not on the axes as the pop-

up menu would appear!) and moving the mouse pointer in 

the desired direction.  

 

iv. Operation Mode Panel 

   

 

FIG.7.30 OPERATION MODE PANEL 

 

In the upper right corner a button for changing 

measurement mode is placed (Fig. 7.30). There are four 

options available: Angular, Wollaston, 3D and Pitch/Yaw. 
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The last mode is described in another Chapter of this 

document. 

 

v. Straightness Measurement Values Panel 

 

In the Values Panel there are displayed numerical 

values of the straightness measurements (Figure 7.31). These 

are the same values that are shown on the chart(s). 

 

 

FIG.7.31 VALUES PANEL 

 

The unit of the distance D can be changed, 

independently on the unit of the chart, by clicking with the 

left mouse button on the distance column of the chart. There 
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are three possibilities (see Figure 7.32): rounded values of the 

distance (A), true value of the distance (B) and number of 

points (C). 

 

   

FIG.7.32 VALUES PANEL – DIFFERENT MODES. CLARIFICATIONS IN TEXT 

 

vi. Straightness Control Panel 

 

Straightness Control Panel is comprised of three main 

parts (Figure 7.23):  

 Line with control buttons 

 Line with measurement status information 

 Line with laser status information. 

The last line shows information common to all options 

of the HPI Software, i.e. the state of Connection, Laser, 

Signal, Sensors and Rotary encoder.  

The measurement status line shows the information of 

the current measurement like the number of the registered 

A B C 
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measurement points, the measurement type and the 

statistical method used for data fitting.  

The functionality of the line with the buttons changes 

with the current measurement state. In the Figure 7.33 there 

are shown various appearances of the control part of the 

Control Panel.  

Case A appears when there is no measurement in 

progress and no data were read from a file. In this mode it is 

possible either to start the measurement (“Start”), to reset the 

main counter (“Reset position”) or to return to the main 

menu of the program (“Menu”). It is possible also to set a 

time between automatically captured measurements 

(“Time”). 

 

 

 

 

 

 

FIG.7.33 CONTROL PANEL – DIFFERENT MODES. CLARIFICATIONS IN TEXT 

 

Cases B and C appear during measurements. The former 

is during the Automatic Point Capture mode, while the latter 

during the Manual Point Capture mode. The measurement 

can be stopped directly (“Stop”) or indirectly (“Menu”). 

A 

B 

C 

D 

E 
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After pressing the “Menu” button the software always asks if 

the measurement is to be stopped first. 

Cases D and E are visible during analyses of the 

obtained results. If there is only one measurement series 

performed than the panel D appears, otherwise pane E. From 

those panels it is possible either to view measurement report 

(“Preview” or “Print”) or to redo the measurements 

(“Repeat” or “New”). In case D (single series) the 

functionality of “Repeat” and “New” is the same. When 

there are more than one series measured then it is possible to 

repeat only one series (“Repeat”) or to start completely new 

measurements (“New”).  

 

vii. Straightness  pull-down menus  

 

Viewed graph can be printed or saved to a file. Those 

commands are available from the File menu (i.e. Save, Save 

as, Print – see figure 7.34). 
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FIG.7.34. STRAIGHTNESS  PULL-DOWN MENU FILE. 

 

Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit-

>Machine data), like machine type, machine serial number, 

measured axis or machine operator. Those values allow 

describing performed measurement for later analysis and 

they are also present on the printed report. 

 

 

FIG.7.35. STRAIGHTNESS  PULL-DOWN MENU EDIT. 

 

Other options available in Edit menu are: 

- Measurement table – raw data are shown for 

analysis, export and print; 
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- Base length – angular retro-reflector RK1 base length 

can be set (default is 100mm); the option available also in 

Configuration->Parameters; 

- Configuration – opens Configuration window as 

shown in the figure 7.36. 

 

FIG. 7.36. STREIGHTNESS CONFIGURATION OPTIONS. 

 

 

In the Configuration it is possible to set: 

1. Straightness data file folder – place where the 

operating system will point to during the 

measurement data save; 
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2. Measurement method – the same functionality 

with the operational mode panel; 

3. Statistic calculation method – measured data can 

be viewed either as a raw or line fitted data. For 

the raw data None option should be chosen. Line 

fitting can be done according either to the End 

point fit or Least squareness fit  method. Which 

method is used depends on personal preferences.  

4. Cycles in series – defines how many measurement 

series are to be expected by the software. It is 

possible to perform fewer cycles then set in this 

parameter; 

5. 3D averaging time – as the 3D straightness 

measurement is an amplitude type measurement 

thus, depending on the measurement condition, 

the device requires certain time for averaging the 

results. The longer is the distance between the 

laser head and the reflecting element RL1 and the 

larger airflow is tangible the larger value of the 

Averaging time should be set; 

6. Point detection parameters – parameters not used 

in the current version of the software. Applicable 

only in customized version of the HPI Software.  
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FIG.7.37. STRAIGHTNESS  PULL-DOWN MENU MEASUREMENT. 

 

In the Measurement pull-down menu it is possible to 

change the method of capturing measurement points. Either 

a manual method (PC keyboard or the manual Strobe can be 

used) or a semi-automatic (time) one can be used.  

 

FIG.7.38. STRAIGHTNESS  PULL-DOWN MENU VIEW. 

 

The options in the View pull-down menu can be used for 

switching on or off the view of the deviation (error) table and 

for switching on or off the cursor position field on the 

straightness charts. 

 

 

viii. Reports 

 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window (fig. 7.39). The report can be 

generated in the basic form where only the plot of the 
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measured values is shown (fig. 7.40) or in the extended 

version, which contains tables with measured data. 

 

FIG.7.39. STREIGHTNESS MEASURED DATA ANALYSIS WINDOW. 
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FIG.7.40. STREIGHTNESS REPORT PREVIEW WINDOW. 

 

It is possible to copy the straightness graph to the 

clipboard and then paste it for example to a Word editor 

document. Copy to clipboard command is available from 

popup menu that appears after right-click on the area of the 

graph.  

 

 

f. Straightness measurements procedure 

 

Straightness measurements are started by pressing the 

Start button.  During the measurement points are collected 

by the software and the straightness graph is constantly 

updated. The measurement is finished by pressing the Stop 

button.  

 

The straightness measurements are driven along a 

straight line pointed by the laser light. The actual 

measurement procedure depends slightly on the 

measurement mode: angular, Wollaston or 3D. 

 

i. Measurement procedure – Angular optics - 

preparations 
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The Straightness measurement in Angular mode is 

based on moving angular Retro-reflector RK1 by an interval 

set in the Base Length parameter (usually 100 mm) and 

measuring the angular deviation of the RK1.  

It is very important to set before the measurements with 

the angular optics the distance between measurement points 

and the actual optical configurations, i.e. whether RK1 or IK1 

is moved and in which direction. This can be done in the 

special pop-up window (Figure 7.41). This window appears 

always after pressing the Start button. 

 

 

FIG.7.41. SELECTION OF CONFIGURATION OF THE ANGULAR OPTICS 

 

If the RK1 is moved manually then the distance between 

points should be marked on the leading ruler or on the 

examined surface before the measurement begins. It is 

recommended to use the ruler with  the scale – see Figure 

7.42.  

During the measurement points can be captured either 

manually by the user or automatically by the software in the 
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constant time intervals. The time period between points 

captures is used to move the retro-reflector about a distance 

of 100 mm (RK1 base length). The time interval should be 

tailored to the experience of the user. It is suggested to set 

the time to 10 s and to decrease it if needed. The time interval 

is increased and decreased by pressing ,   keys on the 

computer screen. 

 

      

FIG.7.42. AN EXAMPLE OF OPTICAL COMPONENTS SETUP IN ANGULAR 

STRAIGHTNESS MEASUREMENT. 

 

 

ii. Measurement procedure – Angular optics 

 

1. Set up the laser on the measured machine and 

align the optical path. 
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2. Start the HPI Software and select Straightness 

option. 

3. Choose the measurement method: Angular. 

4. Choose whether the points are to be captured 

manually or automatically 

5. Press Start button 

6. Choose the right optical configuration  

7. Wait for the program to capture the first point (in 

time capture mode) or capture the point manually. 

8. Move the IK1 or the RK1 by the distance set in the 

Edit->Base length option (default 100mm) and wait 

on the next point capture. 

9. Continue the measurement until the last point is 

reached. 

10. Stop the measurement. 

 

iii. Measurement procedure – Wollaston optics – 

preparations 

 

 

The Straightness measurement in the Wollaston mode is 

based on moving Wollaston prism WP2 by an interval set in 

the Base Length parameter (usually 100 mm) and measuring 

the movement of the WP2 in the direction perpendicular to 

the laser beam.  
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iv. Measurement procedure – Wollaston optics 

 

1. Set up the laser on the measured machine and 

align the optical path. 

2. Start the HPI Software and select Straightness 

option. 

3. Choose the measurement method: Wollaston. 

4. Choose whether the points are to be captured 

manually or automatically 

5. Press Start button 

6. Wait for the program to capture the first point (in 

time capture mode) or capture the point manually. 

7. Move the WP2 by the distance set in the Edit->Base 

length option (default 100mm) and wait on the 

next point capture. 

8. Continue the measurement until the last point is 

reached. 

9. Stop the measurement. 

 

v. Measurement procedure – 3D method - preparations 

 

The Straightness measurement in the 3D mode is based 

on moving linear optics elements (IL1 or RL1) by any 

distance and measuring the relative movement of the IL1 

and RL1 in both directions perpendicular to the laser beam.  
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vi. Measurement procedure – 3D method 

 

1. Set up the laser on the measured machine and 

align the optical path. 

2. Start the HPI Software and select Straightness 

option. 

3. Choose the measurement method: 3D. 

4. Choose whether the points are to be captured 

manually or automatically 

5. Press Start button 

6. Wait for the program to capture the first point (in 

time capture mode) or capture the point manually. 

7. Move the IL1 or the RL1 by the distance set in the 

Edit->Base length option (default 100mm) and wait 

on the next point capture. 

8. Continue the measurement until the last point is 

reached. 

9. Stop the measurement. 

 

 

 

. 
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8. MEASUREMENTS - FLATNESS 

 

 

 

 

 

a. General Description 

 

The flatness measurement is performed using the 

angular straightness measurement principal. In order to 

obtain a surface flatness the measurement of angular 

straightness in eight axes is necessary. From obtained axes 

straightness data a flatness map is calculated and drawn 

(fig.8.1.). 

 

b. Measurement Setup 

 

For flatness measurements the angular optics plus 

additional mirrors should be used. Necessary components 

are: 

 Laser Head  

 Power Supply  

 Angular Interferometer IK1 
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 Angular Retro-reflector RK1 

 Two Beam Benders ZK1 (see figure 8.2) 
Flatness Plot
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FIG.8.1. FLATNESS MAP OF AN EXEMPLE SURFACE. 

 

Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Air temperature sensor  

 Base temperature sensor  
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FIG.8.2. THE ELEMENT SET FOR THE FLATNESS MEASUREMENTS (IK1, RK1 

AND ZK1). 

 

Flatness measurements require that optical elements IK1 

and RK1 are aligned along laser beam as shown in the figure 

8.3 for the first axis. Element IK1 is stationary and element 

RK1 is moved. 

Other axes can be measured with the use of one or two 

beam benders with constant position of the laser head, or by 

moving the position of the laser head. In both cases  

realignment of the IK1 and RK1 components is required. It is 

recommended to use the option with constant position of the 

laser head because it simplifies the realignment process.  
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LASER  HEAD

IK1 RK1

 FIG.8.3 OPTICAL PATH  SET UP FOR FLATNESS MEASUREMENTS – 

SCHEMATIC. 

 

During flatness measurements the usage of the air 

temperature sensor is recommended. Base temperature 

sensors do not have to be used. 

 

FIG.8.4. OPTICAL PATH  SET UP FOR FLATNESS MEASUREMENTS IN ONE 

OF AXES. 
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c. Software description 

 

Flatness is measured in the Flatness option, chosen from 

the Main Menu. The HPI Software program window looks 

like it is shown in the Fig. 8.5. The Flatness Measurement 

Summary window consists of three main parts:  

 Display – presents flatness of the surface 

calculated according to straightness measurements 

for axes;  

 Schematic chart – allows to select axis; 

 Panel with buttons. 

        

 

FIG.8.5. FLATNESS MEASUREMENT SUMMARY WINDOW. 

 



MEASUREMENTS - FLATNESS 

8-6  www.lasertex.eu     

8  

Measurements of the axes are performed in the Flatness 

Measurement window that is launched by the Measurement 

button from Flatness Summary window. The window as 

shown in the figure 8.6 appears. In this window it is also 

possible to change the measured axis and analyze the 

straightness results of each individual axis. The axis can be 

selected by clicking the proper axis on the axes chart or by 

choosing it from the No. axis pull down list. 

 

 

FIG.8.6. FLATNESS MEASUREMENT WINDOW. 

 

The options available in the flatness measurement 

window allow also for repeating the single straightness 

measurement (Repeat button) or printing the results (of a 

single measurement) in the form of the Report (Preview or 

Print button). 
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The graph can be printed or saved to a file. It can be  

chosen from the File menu (i.e. Save, Save as, Print – see 

figure 8.7).  

 

FIG.8.7. FLATNESS  PULL-DOWN MENU FILE. 

 

Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit-

>Machine data), like machine type, machine serial number, 

measured axis or machine operator (see figure 8.8). Those 

values allow describing performed measurement for later 

analysis and they are also present on the printed report. 
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FIG.8.8. MACHINE DATA WINDOW. 

 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window. The report can be generated 

in the basic form where only the plot of the measured values 

is shown or in the extended version, which contains tables 

with measured data. 

It is also possible to copy the straightness graph to the 

clipboard and then paste it for example to a Word editor 

document. Copy to clipboard command is available from 
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popup menu that appears after right-click on the area of the 

graph. 

The flatness option can be configured in the Flatness tab 

(Fig. 8.9.) located in the Configuration window accessible 

from the Main Menu or from pull down menu Edit-

>Configuration.  

 

 

FIG.8.9. FLATNESS CONFIGURATION OPTIONS. 

 

In the Flatness Configuration Tab it is possible to change 

the destination data folder or to choose the measurement 

method. The standard one is the Envelope that uses Moody 
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method for flatness calculation. For Grid method the number 

of vertical and horizontal axes can be set from 3 to 8. 

 

d. Alignment of optics for the flatness 

measurements 

 

The flatness measurement consists of the straightness 

measurements performed along 8 axes. The axis can be 

selected by clicking the proper axis on the axes chart or by 

choosing it from the list (Fig. 8.10.). There are also shown: 

directions of measurements in the axes and margins that 

must be kept during measurements. 

 

 

FIG.8.10. AXES CHOICE CHART. 

 

Straightness measurements are made with angular 

optics as it is described in the Chapter Measurements - 
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Straightness. Depending on the measurement axis, a different 

set of optical components is used and the alignment of the 

optical path is done in slightly different way. As mentioned 

earlier the measurements can be made either with or without 

changing the position of the laser head. In both cases the 

measurements have to be performed in accord with the 

directions pointed by arrows on the schematic graph on the 

main screen of flatness measurement (Fig. 8.10).  

Below there is described the procedure of flatness 

measurements in the constant laser head position 

configuration. 

 

i. Optical path alignment of the axis “1”. 

 

The straightness measurement of the axis “1” is 

performed in the same way as described in Chapter 7, 

Straightness measurements. 

 

ii. Optical path alignment of the axes: “3”, “6”, “8”. 

 

During flatness measurements of the axes “3”, “6” and 

“8” an additional beam directing mirror ZK1 is used. The 

way of using it is shown in the Figure 8.11. The alignment 

procedure is the same as described in Chapter 4 for angular 

optics with an additional beam directing element (ZK1) in 

the path. 
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FIG.8.11. THE SET OF THE OPTICAL COMPONENTS USED IN 

STRAIGHTNESS MEASUREMENTS IN THE AXES: “3”, “6:” AND “8”. 

 

iii. Optical path alignment of the axes: “5” and “7” 

 

During flatness measurements of the axes “5” and “7” 

two beam directing mirrors ZK1 are used. The way of using 

them is shown on Figure 8.12. The alignment procedure is 

the same as described in Chapter 4 for angular optics with an 

additional beam directing element (ZK1) in the path. 
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FIG.8.12. THE SET OF THE OPTICAL COMPONENTS USED IN 

STRAIGHTNESS MEASUREMENTS IN THE AXES: “5” AND “7”. 

 

iv. Optical path alignment of the axes: “2” and “4” 

 

Similarly to previously described axes “5” and “7”, 

during flatness measurements of the axis “4” two beam 

directing mirrors ZK1 are used. The difference is that the 

angle of the second mirror usually differs from 45. The 

alignment of the axis “4” is shown in the Figure 8.13. In case 

of  the axis “2” only one beam directing mirror ZK1 is used, 

but alignment procedure is quite similar to the axis “4”. The 

alignment procedure is the same as described in Chapter 4 
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for angular optics with an additional beam directing element 

(ZK1) in the path. 

 

FIG.8.13. THE SET OF THE OPTICAL COMPONENTS USED IN 

STRAIGHTNESS MEASUREMENTS IN THE AXES: “2” AND “4”. 

 

e. Measurement procedure 

 

1. Set up the laser on the measured machine and 

align first optical path. 

2. Start the HPI Software and select Flatness option. 

3. Press Measurement button on the Flatness 

summary screen 
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4. Choose the proper axis on the axis choice chart 

and press Start, New or Repeat button. 

5. Move the RK1 by the distance set in the Edit->Base 

length option (default 100mm) and wait on the 

next point capture (or capture it manually). 

6. Continue measurements until all points on the 

path are measured. 

7. Stop the measurement. 

8. If not all axes are measured then repeat points 4-7. 

9. When straightness measurements of all axes are 

completed then the Back button should be pressed. 

The software returns to the Flatness Summary 

screen – see figure 8.14 

 

 

FIG.8.14. A RESULT OF FLATNESS MEASUREMENT. 
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In order to perform the measurement in the manual 

capture mode, the Measurement->Manual point capture should 

be selected. The measurement begins by pressing 

Start/New/Repeat. The point can be captured by pressing 

Space key, clicking the Point capture button, or pressing the 

remote Strobe button.  When the last point is captured the 

Stop button should be pressed. 

 Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window. The report can be generated 

in the basic form where only the plot of the measured values 

is shown or in the extended version, which contains tables 

with measured data. 
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9.   MEASUREMENTS – PITCH/YAW 

 

 

 

 

 

a. General Description 

 

Pitch/Yaw measurement enables to better characterize 

the measured machine axis geometry. With this option the 

machine base straightness on all important base surfaces can 

be measured or the quality of movement of the measured 

element can be checked. The measured errors are known in 

the literature as pitch and yaw errors. Pitch/Yaw option is 

very similar to the Angular Straightness option which is 

described in another Chapter of this document. The only 

difference is a method used for measurement result 

calculation. 

 

 

 

  

b. Measurement Setup 
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For Pitch/Yaw measurements the angular optics should 

be used. Necessary components are: 

 Laser Head  

 Power Supply 

 Angular Interferometer IK1 

 Angular Retro-reflector RK1 

 

Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Air temperature sensor  

 Base temperature sensor  

 

Pitch/Yaw measurements require optical elements IK1 

and RK1 to be aligned along laser beam as shown in the 

figure 9.1. Each of the elements can be moved.  

During Pitch/Yaw measurements the usage of the air 

temperature sensor is recommended. Base temperature 

sensors do not have to be used. 
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LASER  HEAD

IK1 RK1

 FIG.9.1 OPTICAL PATH  SET UP FOR PITCH/YAW MEASUREMENTS- 

SCHEMATIC. 

 

 

FIG.9.2 OPTICAL PATH  SET UP FOR PITCH/YAW MEASUREMENTS IN 

X AXIS. 

 

Pitch/Yaw measurements can be performed not only 

along the laser beam (as shown in figures 9.1 and 9.2) but 

also in directions perpendicular to the laser beam. These 

configurations are shown in figures 9.3 and 9.4. In those two 

configurations only the retro-reflector RK1 can be moved. 
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FIG.9.3 OPTICAL PATH  SET UP FOR PITCH/YAW MEASUREMENTS IN 

Y AXIS. 

 

 

FIG.9.4 OPTICAL PATH  SET UP FOR PITCH/YAW MEASUREMENTS IN 

Z AXIS. 
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c. Software description 

 

Pitch and Yaw errors can be measured in the Pitch/Yaw 

option, chosen from the Main Menu. The HPI-3D program 

window looks like it is shown in the Fig. 9.5. The window 

consists of four main parts:  

 Display – presents recent measured angle and 

measurement signal level; 

 Obtained results plotted on a graph; 

 Obtained results displayed in the measurement 

table; 

 Panel with buttons. 

        

 

FIG.9.5. PITCH/YAW MEASUREMENT WINDOW. 
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Before the measurement is started the right point 

capture method from the Measurement menu should be 

chosen (see figure 9.6). There are two methods available: 

Time period point capture – points are captured 

automatically by the software in constant time intervals. 

Time interval is configured on the panel with  and  

buttons. 

Manual point capture – points are captured when the 

Point capture button on the panel, Space key on the keyboard 

or Manual Strobe button is pressed. 

 

 

FIG.9.6. PITCH/YAW PULL-DOWN MENU MEASUREMENT. 

 

Measurement is started by the Start button. Depending 

on the chosen point capture method the points are captured 

automatically or have to be captured by the user. During  the 

measurement the graph on the screen is constantly updated. 

The measurement is finished by the Stop button. 
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FIG.9.7. PITCH/YAW PULL-DOWN MENU FILE.  

 

Obtained results can be saved, printed or exported 

(menu File). Before saving the file the program asks about 

changing machine data (option available from pull-down 

menu Edit->Machine data), like machine type, machine serial 

number, measured axis or machine operator (see figure 9.8). 

Those values allow describing performed measurement for 

later analysis and they are also present on the printed report. 
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FIG.9.8. MACHINE DATA WINDOW.  

 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window (fig. 9.9). The report can be 

generated in the basic form where only the plot of the 

measured values is shown or in the extended version, which 

contains tables with measured data. 
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FIG.9.9. PITCH/YAW MEASURED DATA ANALYSIS WINDOW.  

 

It is also possible to copy the straightness graph to the 

clipboard and then paste it for example to a Word editor 

document. Copy to clipboard command is available from 

popup menu that appears after right-click on the area of the 

graph. 

Configuration of Pitch/Yaw measurement option is 

available in the Configuration->Straightness window. There is 

performed a configuration of statistic calculation method 

(fig. 9.10) which is used for measurement data processing. 

End point fit or Least squareness fit can be chosen to use 

statistical methods. The None option enables to perform an 

analysis of raw results. 
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FIG. 9.10. PITCH/YAW CONFIGURATION OPTIONS.  

 

d. Measurement procedure 

 

1. Set up the laser on the measured machine and 

align optical path. 

2. Start the HPI-3D software and select Pitch/Yaw 

option. 

3. Choose the desired point capture method. 

4. Press Start button and run the machine. 

5. In the manual mode capture points using the most 

appropriate method; in the automatic mode points 
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are captured by the software in constant time 

intervals. 

6. Stop the measurement. 

7. Save the results and/or print the measurement 

report. 
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10. MEASUREMENTS - SQUARENESS 

 

 

 

 

 

 

a. General Description 

 

The squareness measurement is used to characterize the 

measured machine geometry, i.e. the squareness of axes. The 

measurement is performed using either 3D or Wollaston 

straightness measurement technique. In order to obtain the 

proper results, two measurements with the use of a right 

angle etalon are necessary. From obtained axes straightness 

data the squareness is calculated and drawn (fig.10.1.). 

 

b. Measurement Setup 

 

The choice of optical elements necessary for squareness 

measurements depends on the selected measurement 

method: i.e. 3D or Wollaston. If 3D method is used then the 

linear optics plus right angle etalon should be used. In this 

case the necessary components are: 
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 Power Supply  

 Linear Interferometer IL1 

 Linear Retro-reflector RL1 

 Right angle etalon RE3D or REW 

 

 

FIG.10.1. AN EXEMPLARY SQUARENESS RESULTS 

 

In the case of the Wollaston type measurement the 

necessary components are: 

 Laser Head  

 Power Supply  

 Wollaston prism WP2 

 Wollaston retro-reflector WRP2 

 Right angle etalon REW 
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 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Air temperature sensor  

 Base temperature sensor  

 

Squareness measurements based on the 3D method 

require optical elements IL1 and RL1 to be first aligned along 

the laser beam as shown in the figure 10.2A. The element 

RL1 should be moved. Obtained results of the axis 

straightness should be saved for further processing. 

 

LASER  HEAD

IL1 RL1

 FIG.10.2A. OPTICAL PATH SET UP FOR 3D SQUARENESS MEASUREMENTS- 

FIRST AXIS 

 

In the next phase of the measurements the beam should 

be directed to the perpendicular axis with the use of right 

angle etalon RE3D or REW. Be careful not change the 

position of the laser head during alignment of the laser path 

– the beam path has to be aligned only with the rotation of 
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configuration is shown in the Figure 10.2B. The 

measurement of the axis straightness should be performed 

with the movement of the RL1 element. 

RE3D

LASER  HEAD

 

FIG.10.2B. OPTICAL PATH SET UP FOR 3D SQUARENESS MEASUREMENTS- SECOND 

AXIS 

 

Wollaston squareness measurements require optical 

elements WP2 and WRP2 to be aligned along laser beam as 

shown in the figures 10.3A and 10.3B. The beam should be 

directed to the perpendicular axis with the use of right angle 

etalon REW.   

The measurements consist of two parts. In the first part 

the WP2 is moved between the laser head and the REW 

prism (Fig. 10.3A). During the second part the WP2 should 

be placed between REW and WRP2 (Fig. 10.3B). 
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FIG.10.3A. OPTICAL PATH SET UP FOR WOLLASTONE SQUARENESS 

MEASUREMENTS - SCHEMATIC FOR FIRST AXIS. RETURN BEAMS NOT 

DRAWN FOR FIGURE CLARITY 
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FIG.10.3B. OPTICAL PATH SET UP FOR WOLLASTONE SQUARENESS 

MEASUREMENTS - SCHEMATIC FOR SECOND AXIS. RETURN BEAMS NOT 

DRAWN FOR FIGURE CLARITY 

 

The element WRP2 MUST NOT be moved during 

measurements. The laser head and the REW should also be 

not touched during both parts of the measurement. 

During squareness measurements the usage of the air 

temperature sensor is recommended. Base temperature 

sensors do not have to be used. 
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c. Software description 

 

Squareness is measured in the Squareness option, 

chosen from the Main Menu. The HPI Software program 

window looks like it is shown in the Fig. 10.4. The 

Squareness Measurement Summary window consists of 

three main parts:  

 Display – presents measured straightness of axes 

and calculated squareness;  

 Schematic chart – allows changing the currently 

edited axis; 

 Panel with buttons 

        

 

FIG.10.4. SQUARENESS MEASUREMENT SUMMARY WINDOW 
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window shown in the figure 10.5 appears. In this window it 

is possible to change the measured axis and analyze the 

straightness results of each individual axis. The axis can be 

changed by clicking the proper axis on the axes chart or by 

choosing it from the No. axis pull down list. 

 

 

FIG.10.5. SQUARENESS MEASUREMENT WINDOW 

 

The options available in the squareness measurement 

window also enable to repeat the single straightness 

measurement (Repeat button) or print the results (of a single 

measurement) in the form of the Report (Preview or Print 

button). 
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commands can be found in File menu (i.e. Save, Save as, 

Print – see figure 10.6).  

 

FIG.10.6. SQUARENESS  PULL-DOWN MENU FILE  

 

Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit-

>Machine data), like machine type, machine serial number, 

measured axis or machine operator (see figure 10.7). Those 

values allow describing performed measurement for later 

analysis and they are also present on the printed report. 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window. The report can be generated 

in the basic form where only the plot of the measured values 

is shown or in the extended version, which contains tables 

with measured data. 

It is also possible to copy the straightness graph to the 

clipboard and then paste it for example to a Word editor 

document. Copy to clipboard command is available from 
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graph. 

 

 

FIG.10.7. MACHINE DATA WINDOW  

 

The squareness option can be configured in the 

Configuration window accessible both from the Main Menu 

or from pull down menu Edit->Configuration in the 

Straightness tab (figure 10.8).  

 



MEASUREMENTS – SQUARENESS 

10-11  www.lasertex.eu     

10  

 

FIG.10.8. STRAIGHTNESS CONFIGURATION OPTIONS  

 

The Straightness Configuration Tab allows 

configuration which is described in the Measurement-

>Straightness chapter with the difference that the 

Measurement methods used for squareness measurements 

are Wollaston or 3D. 

 

d. Alignment of optics for the squareness 

measurements 
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straightness measurements for two axes. The measurement 

axis is selected on the measured surface as shown in the 

figure 10.9. In this figure there are also shown: directions of 

measurements and margins that have to be kept during 

measurements. 

 

 

FIG.10.9. AXES CHOICE CHART 

 

The measurements of deviations from straightness are 

performed with linear or Wollaston optics as described in the 

Chapter Measurements - Straightness. Depending on the 

measurement axis, a different set of optical components is 

used and the alignment of the optical path is performed in a 

slightly different way. 

 The measurements have to be performed without 

changing the position of the laser head.  
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the directions pointed by arrows on the schematic graph on 

the main screen of squareness measurement (fig. 10.9).  

 

FIG.10.10 OPTICAL PATH  SET UP FOR 3D STRAIGHTNESS MEASUREMENTS 

IN X AXIS 
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MEASUREMENTS IN X AXIS 

 

Configuration of optical components for 3D and 

Wollaston methods are shown in the figures 10.10 and 10.11. 

In the figures there is omitted an REW element (see figures 

10.3A and 10.3B). 

 

When the machine data is properly configured (Edit-> 

Machine Data), the Measurement button should be pressed. 

Next step is a measurement axis selection (fig. 10.9) and the 

optical path should be adjusted (see figures 10.10.and 10.11). 

If the straightness of the first axis is measured the optical 

path should be realigned and the next axis should be selected 

in the software. If both axes are measured, Back button 

should be pressed. Obtained squareness measurements 

summary (fig. 10.1) can be saved, printed or exported to a 

text file (File->Save, File->Print or File->Export). 

 

e. Measurement procedure 

 

1. Set up the laser on the measured machine and 

align the first optical path. 

2. Start the HPI Software and select Squareness 

option. 
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summary screen. 

4. Choose the proper axis on the axis choice chart 

and press Start, New or Repeat button. 

5. Move the RL1 or WP2 to the next measurement 

point. 

6. Continue measurements until all points on the 

path are measured. 

7. Stop the measurement. 

8. Realign the optical path to the perpendicular axis 

and repeat steps 4-7 

9. When straightness data of all axes are measured 

then the Back button should be pressed. The 

software returns to the Squareness Summary 

screen – see figure 10.1 

10.  For 3D measurement type the correct axes 

(Vertical or Horizontal) should be chosen for 

comparison. 

 

In order to make the measurement in the manual 

capture mode, the Measurement->Manual point capture should 

be selected. The measurement begins by pressing 

Start/New/Repeat. Measurement points can be captured  by 

the Space key from the computer keyboard, Point capture 

button on the panel, or by the remote Strobe button. If the 

last point is captured, the Stop button should be pressed. 
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obtained data, either by pressing Print or Preview on the 

measurement analysis window. The report can be generated 

in the basic form where only the plot of the measured values 

is shown or in the extended version, which contains tables 

with measured data. 
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11. MEASUREMENTS - PARALLELISM 

 

 

 

 

 

 

a. General Description 

 

The parallelism measurement is used to characterize the 

measured machine geometry, i.e. the parallelism of axes. The 

measurement is performed using 3D or Wollaston 

straightness technique. In order to obtain the proper results, 

two measurements with the use of a right angle etalon are 

necessary. From obtained axes straightness data the 

parallelism is calculated and drawn (fig.11.1.). 

 

b. Measurement Setup 

 

The choice of optical elements necessary for parallelism 

measurements depends on the selected measurement 

method: i.e. 3D or Wollaston. If 3D method is used then the 

linear optics plus right angle etalon should be used. In this 

case the necessary components are: 

 Laser Head  
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 Power Supply  

 Linear Interferometer IL1 

 Linear Retro-reflector RL1 

 Right angle etalon RE3D 

 

 

FIG.11.1. AN EXEMPLARY PARALLELISM RESULTS 

 

In the case of the Wollaston type measurement the 

necessary components are: 

 Laser Head  

 Power Supply  

 Wollaston prism WP2 

 Wollaston retro-reflector WRP2 

 Right angle etalon REW 

 

For both methods the optional elements are similar: 

 USB cable 
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 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Air temperature sensor  

 Base temperature sensor  
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FIG.11.2A. OPTICAL PATH SET UP FOR 3D PARALLELISM MEASUREMENTS- 

SCHEMATIC FOR AXIS 1. 

 

Parallelism measurements based on the 3D method 

require optical elements IL1 and RL1 to be aligned along 

laser beam as shown in the figures 11.2A and 11.2B. The 

element RL1 should be moved. The beam should be directed 

to the perpendicular axis with the use of the right angle 

etalon RE3D. 
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FIG.11.2B. OPTICAL PATH SET UP FOR 3D PARALLELISM MEASUREMENTS- 

SCHEMATIC FOR AXIS 2. 

 

 

Wollaston parallelism measurements require optical 

elements WP2 and WRP2 to be aligned along laser beam as 

shown in the figure 11.3. The element WP2 should be moved 
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first along Axis 1 and then along Axis 2. No right angle 

prism is necessary for this measurement. 

 

LASER  HEAD

WP2

WRP2

 

FIG.11.3. OPTICAL PATH SET UP FOR WOLLASTONE PARALLELISM 

MEASUREMENTS - SCHEMATICS 

 

 

During parallelism measurements the usage of the air 

temperature sensor is recommended. Base temperature 

sensors do not have to be used. 

 

c. Software description 

 

Parallelism is measured in the Parallelism option, 

chosen from the Main Menu. The HPI Software program 

window looks like it is shown in the Fig. 11.4. The 

Parallelism Measurement Summary window consists of 

three main parts:  

 Display – presents measured straightness of axes 

and calculated parallelism;  
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 Schematic chart – allows changing the currently 

edited axis; 

 Panel with buttons 

 

FIG.11.4. PARALLELISM MEASUREMENT SUMMARY WINDOW 

 

Measurement is started by the Measurement button and 

window shown in the figure 11.5 appears. In this window it 

is possible to change the measured axis and analyze the 

straightness results of each individual axis. The axis can be 

changed by clicking the proper axis on the axes chart or by 

choosing it from the No. axis pull down list. 
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FIG.11.5. PARALLELISM MEASUREMENT WINDOW 

 

The options available in the parallelism measurement 

window also enable to repeat the single straightness 

measurement (Repeat button) or print the results (of a single 

measurement) in the form of the Report (Preview or Print 

button). 

  

The graph can be printed or saved to a file. Those 

commands can be found in File menu (i.e. Save, Save as, 

Print – see figure 11.6).  
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FIG.11.6. PARALLELISM  PULL-DOWN MENU FILE  

 

Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit-

>Machine data), like machine type, machine serial number, 

measured axis or machine operator (see figure 11.7). Those 

values allow describing performed measurement for later 

analysis and they are also present on the printed report. 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window. The report can be generated 

in the basic form where only the plot of the measured values 

is shown or in the extended version, which contains tables 

with measured data. 

It is also possible to copy the straightness graph to the 

clipboard and then paste it for example to a Word editor 

document. Copy to clipboard command is available from 

popup menu that appears after right-click on the area of the 

graph. 
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FIG.11.7. MACHINE DATA WINDOW  

 

The parallelism option can be configured in the 

Configuration window accessible both from the Main Menu 

or from pull down menu Edit->Configuration in the 

Straightness tab (figure 11.8).  
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FIG.11.8. STRAIGHTNESS CONFIGURATION OPTIONS  

 

The Straightness Configuration Tab allows 

configuration which is described in the Measurement-

>Straightness chapter with the difference that the 

Measurement methods used for parallelism measurements 

are Wollaston or 3D. 

 

d. Alignment of optics for the parallelism 

measurements 
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The parallelism measurement consists of the 

straightness measurements for two axes. The measurement 

axis is selected on the measured surface as shown in the 

figure 10.9. In this figure there are also shown: directions of 

measurements and margins that have to be kept during 

measurements. 

 

FIG.11.9. AXES CHOICE CHART 

 

The measurements of deviations from straightness are 

made with linear or Wollaston optics as described in the 

Chapter Measurements - Straightness. Depending on the 

measurement axis, a different set of optical components is 

used and the alignment of the optical path is done in slightly 

different way. 

 The measurements have to be performed without 

changing the position of the laser head.  

In both cases the measurements have to be performed in 

the directions pointed by arrows on the schematic graph on 

the main screen of parallelism measurement (fig. 11.9).  
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Configuration of optical components for 3D and 

Wollaston methods are shown in the figures 11.10 and 11.11.  

 

FIG.11.10 OPTICAL PATH  SET UP FOR 3D STRAIGHTNESS MEASUREMENTS 

IN X AXIS 

 

When the machine data is properly configured (Edit-> 

Machine Data), the Measurement button should be pressed. 

Next step is a measurement axis selection (fig. 11.9) and the 

optical path should be adjusted (see figures 11.10.and 11.11). 

If the straightness of the first axis is measured the optical 

path should be realigned and the next axis should be selected 

in the software. If both axes are measured, Back button 

should be pressed. Obtained parallelism measurements 

summary (fig. 10.1) can be saved, printed or exported to a 

text file (File->Save, File->Print or File->Export). 
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FIG.11.11 OPTICAL PATH  SET UP FOR WOLLASTON STRAIGHTNESS 

MEASUREMENTS IN X AXIS 

 

 

e. Measurement procedure 

 

1. Set up the laser on the measured machine and 

align the first optical path. 

2. Start the HPI Software and select Parallelism 

option. 

3. Press Measurement button on the Parallelism 

summary screen. 

4. Choose the proper axis on the axis choice chart 

and press Start, New or Repeat button. 

5. Move the RL1 or WRP2 to the next measurement 

point. 
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6. Continue measurements until all points on the 

path are measured 

7. Stop the measurement. 

8. Realign the optical path to the perpendicular axis 

and repeat steps 4-7 

9. When straightness of all axes is measured then the 

Back button should be pressed. The software 

returns to the Parallelism Summary screen – see 

figure 11.1 

10. For 3D measurement type the correct axes 

(Vertical or Horizontal) should be chosen for 

comparison. 

 

In order to make the measurement in the manual 

capture mode, the Measurement->Manual point capture should 

be selected. The measurement begins by pressing 

Start/New/Repeat. Measurement points can be captured  by 

the Space key from the computer keyboard, Point capture 

button on the panel, or by the remote Strobe button. If the 

last point is captured, the Stop button should be pressed. 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window. The report can be generated 

in the basic form where only the plot of the measured values 

is shown or in the extended version, which contains tables 

with measured data. 
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12.  MEASUREMENTS - VIBRATION 

 

 

 

 

 

 

 

a. General Description 

 

Vibration measurements are performed with the use of 

linear optics. This measurement can be used, for example, for 

characterization of motor movement. The laser measurement 

system HPI-3D is capable of detecting machine vibrations in 

the frequency range from 0 to 500 Hz in Bluetooth mode and 

0 to 50 kHz in USB mode. The sensitivity of measurements is 

100pm. 

The System allows measuring vibration in different 

units in single shot and continuous mode. The parameters of 

the measurement can be set in the Configuration->Vibration 

option. 

 



MEASUREMENTS – VIBRATION 

12-2  www.lasertex.eu     

12  

b. Measurement Setup 

 

For velocity measurements linear optics should be used. 

Necessary components are (see also figures 12.1 to 12.4): 

 Laser head 

 Power Supply 

 Linear interferometer IL1 

 Linear retro-reflector RL1 

 

 

Optional elements are: 

 USB cable 

 Magnetic holder UM2 

 Tripod stand 

 Base temperature sensor  

 Air temperature sensor  

 

Vibration measurements require optical elements IL1 

and RL1 to be aligned along laser beam as shown in the 

figure 12.1. The laser measures the difference of vibrations of 

both optical elements (i.e. IL1 and RL1). 

During vibration measurements the usage of the air 

temperature sensor is recommended. Base temperature 

sensors do not have to be used. 
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LASER  HEAD

IL1 RL1

 FIG.12.1 OPTICAL PATH SET UP FOR VIBRATION MEASUREMENTS- 

SCHEMATIC 

 

Vibration measurements can be performed not only 

along the laser beam (as shown in the figures 12.1 and 12.2) 

but also in directions perpendicular to the laser beam. These 

configurations are shown in the figures 12.3 and 12.4. In 

those two configurations only the retro-reflector RL1 can be 

moved. 

 

 

FIG.12.2 OPTICAL PATH  SET UP FOR VIBRATION MEASUREMENTS IN X 

AXIS 
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FIG.12.3. OPTICAL PATH  SET UP FOR VIBRATION MEASUREMENTS IN Y 

AXIS 

 

FIG.12.4. OPTICAL PATH  SET UP FOR VIBRATION MEASUREMENTS IN Z 

AXIS 
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c. Software description 

 

Vibrations are measured in the Vibration option, chosen 

from the Main Menu. The HPI-3D program window looks 

like it is shown in the Fig. 12.5. The window consists of four 

main parts:  

 Display – presents measurement signal level and 

percent of gathered samples; 

 Two plots – upper presents gathered distance, 

velocity, or acceleration data, lower the Fourier 

Transformation (FFT) of the upper plot; 

 Measurement options; 

 Panel with buttons. 

        

 

FIG.12.5. VIBRATION MEASUREMENT WINDOW 
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Before starting the measurements the options located in 

the right panel should be set according to the current 

requirements. Radio buttons enable to select the type of 

input data, i.e. whether amplitude of Distance, Velocity or 

Acceleration is important. Pull-down lists are used to 

configure measurement duration for single cycle and to 

select averaging strength respectively. Measurement is 

started by the Start button. If Continuous option is selected, 

the measurement has to be finished by pressing the Stop 

button. During Continuous measurements the graph on the 

screen is constantly updated every measurement cycle.  

Measurement result is presented on the time domain 

diagram and its FFT analysis on the frequency diagram 

(fig.12.8). The frequency diagram is configured (logarithmic 

scales for X and Y axes and DC offset elimination) by 

checkboxes located in the bottom right part of the window. 

The results can be saved, printed or exported (menu File).  

 

 

FIG.12.6. VIBRATION  PULL-DOWN MENU FILE  
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Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit-

>Machine data), like machine type, machine serial number, 

measured axis or machine operator (see figure 12.7). Those 

values allow describing performed measurement for later 

analysis and they are also present on the printed report. 

 

 

FIG.12.7. MACHINE DATA WINDOW  

 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window (fig. 12.8). The report can be 
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generated in the basic form where only the plots of the 

measured values and calculated frequency transformation 

are shown (fig. 12.9) or in the extended version, which 

contains also tables with measured data. 

 

FIG.12.8. VIBRATION MEASURED DATA ANALYSIS WINDOW  

 

FIG.12.9. VIBRATION REPORT PREVIEW WINDOW (PAGE 1)  
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It is also possible to copy the straightness graph to the 

clipboard and then paste it for example to a Word editor 

document. Copy to clipboard command is available from 

popup menu that appears after right-click on the area of the 

graph. 

 

d. Measurement procedure 

 

1. Set up the laser on the measured machine and 

align optical path. 

2. Start the HPI-3D software and select Vibration 

option. 

3. Configure Vibration measurement. 

4. Press Start button and run the machine. 

5. In the continuous mode press Stop button; in the 

single-shot mode wait for the end of 

measurements 

6. Save the results and/or print the measurement 

report. 

 

To obtain correct results, a point where the retro-

reflector is attached to the machine, has to be carefully 

chosen. If the point is chosen improperly, instead of a sought 

frequency f, a multiple frequencies n*f appear (where 

n=1,2,...) on the FFT chart. For that reason the retro-reflector 
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must not be used with the magnetic holder UM2. Magnetic 

Base, Stainless Rod (SR1), and Holding Block (HB1) should be 

used instead. It is worth to mention that the system measures 

the vibration only in the axis of the optical path. Any 

vibrations in perpendicular axes do not influence the 

measurement (see fig.12.11).  

 

Laser

Retroreflector

RL1

Interferometer

IL1

Retroreflector

RL1

Interferometer

IL1

Laser
Vibrations

important

Vibrations not

important

A)

B)

 

FIG.12.11. VIBRATION MEASUREMENT IN DIFFERENT AXES 
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13.  MEASUREMENTS - DYNAMIC 

 

 

 

 

 

a. General Description 

 

Dynamic measurements are usually used for 

characterization of subtle machine movement. The laser 

measurement system HPI-3D is capable of characterizing the 

tested machine with up to 1000 samples per second in the 

Bluetooth mode and up to 100000 samples per second in the 

USB mode. In both modes the measurement resolution is 

100pm. Dynamic measurements are performed with the use 

of linear optics, angular, or Wollaston optics. 

The System enables to perform dynamic measurement 

of distance, velocity, acceleration, angle or straightness in 

different units.. 
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b. Measurement Setup 

 

i. Dynamic  measurements of distance, velocity or 

acceleration  

 

For dynamic measurements of distance, velocity and 

acceleration the linear optics should be used. Necessary 

components are (see also figures 13.1 to 13.4): 

 Laser head 

 Power Supply 

 Linear interferometer IL1 

 Linear retro-reflector RL1 

 

Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Base temperature sensor  

 Air temperature sensor  

 

Dynamic measurements of distance, velocity and 

acceleration require optical elements IL1 and RL1 to be 

aligned along laser beam as shown in the figure 13.1. The 

laser measures the difference of distance between optical 

elements (i.e. IL1 and RL1). 
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During dynamic measurements the usage of the air 

temperature sensor is recommended. Base temperature 

sensors do not have to be used. 

 

LASER  HEAD

IL1 RL1

 FIG.13.1 OPTICAL PATH SET UP FOR DYNAMIC MEASUREMENTS OF 

DISTANCE, VELOCITY OR ACCELERATION – SCHEMATIC 

 

 

FIG.13.2 OPTICAL PATH  SET UP FOR LINEAR DYNAMIC MEASUREMENTS 

IN X AXIS 

 

Dynamic measurements can be performed not only 

along the laser beam (as shown in the figures 13.1 and 13.2) 
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but also in directions perpendicular to the laser beam. These 

configurations are shown in the figures 13.3 and 13.4. In 

those two configurations only the retro-reflector RL1 can be 

moved. 

 

 

FIG.13.3. OPTICAL PATH  SET UP FOR LINEAR DYNAMIC MEASUREMENTS 

IN Y AXIS 
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FIG.13.4. OPTICAL PATH  SET UP FOR LINEAR DYNAMIC MEASUREMENTS 

IN Z AXIS 

 

ii. Dynamic  measurements of angle  

 

For dynamic measurements of angle the angular optics 

should be used. Necessary components are: 

 Laser Head  

 Power Supply  

 Angular Interferometer IK1 

 Angular Retro-reflector RK1 

 

Optional elements are: 

 USB cable 

 Manual Strobe  
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 Magnetic holder UM2 

 Tripod stand 

 Air temperature sensor  

 Base temperature sensor  

 

Dynamic measurements of angle require optical 

elements IK1 and RK1 to be aligned along laser beam as 

shown in the figure 13.5. Each of the elements can be moved.  

During Angular straightness measurements the usage of 

the air temperature sensor is recommended. Base 

temperature sensors do not have to be used. 

LASER  HEAD

IK1 RK1

 FIG.13.5 OPTICAL PATH  SET UP FOR ANGULAR DYNAMIC 

MEASUREMENTS - SCHEMATIC 

 

Angular straightness measurements can be performed 

not only along the laser beam (as shown in the figures 13.5 

and 13.6) but also in directions perpendicular to the laser 

beam. These configurations are shown in the figures 13.7 and 

13.8. In those two configurations only the retro-reflector RK1 

can be moved. 
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FIG.13.6. OPTICAL PATH  SET UP FOR ANGULAR DYNAMIC 

MEASUREMENTS IN X AXIS 

 

FIG.13.7. OPTICAL PATH  SET UP FOR ANGULAR DYNAMIC 

MEASUREMENTS IN Y AXIS 
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FIG.13.8. OPTICAL PATH  SET UP FOR ANGULAR DYNAMIC 

MEASUREMENTS IN Z AXIS 

 

iii. Dynamic measurements of straightness (Wollaston)   

 

For dynamic measurements of straightness the 

Wollaston optics should be used. Necessary components are: 

 Laser Head  

 Power Supply  

 Wollaston prism WP2 

 Wollaston retro-reflector WRP2 

 

Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 



MEASUREMENTS - DYNAMIC 

13-9  www.lasertex.eu     

13  

 Air temperature sensor  

 Base temperature sensor  

 

Dynamic straightness measurements require optical 

elements WP2 and WRP2 to be aligned along laser beam as 

shown in the figure 13.9. Each of the elements can be moved.  

During dynamic straightness measurements the usage 

of the air temperature sensor is recommended. Base 

temperature sensors do not have to be used. 

LASER  HEAD

WP2

WRP2

 FIG.13.9. OPTICAL PATH  SET UP FOR DYNAMIC STRAIGHTNESS 

MEASUREMENTS- SCHEMATIC 
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FIG.13.10. OPTICAL PATH  SET UP FOR DYNAMIC STRAIGHTNESS 

MEASUREMENTS IN X AXIS 

 

Dynamic straightness measurements can be performed 

in two configurations – horizontal X (figure 13.10) or vertical 

Z (figure 13.11). In the configuration X only the straightness 

of path in the X axis is measured. The same situation is with 

the Z setup. 
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FIG.13.11. OPTICAL PATH  SET UP FOR DYNAMIC STRAIGHTNESS 

MEASUREMENTS IN Z AXIS 

 

 

c. Software description 

 

All types of dynamic measurements are performed in 

the Dynamic option, chosen from the Main Menu. The HPI-

3D program window looks like it is shown in the Fig. 13.12. 

The window consists of four main parts:  

 Display – presents measurement signal level and 

percent of gathered samples; 

 The main plots – presents gathered distance, 

velocity, acceleration, angle, or straightness 

(Wollaston) data; 

 Configuration panel (right panel); 
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 Panel with buttons (bottom panel). 

        

 

FIG.13.12. DYNAMIC MEASUREMENT WINDOW 

 

Before the measurement is started, the options in the 

right panel should be set according to current requirements. 

The Averaging has four available options that limit the 

maximum frequency of the measured movement to: 50 kHz 

in 0s, 50Hz in 0.1s, and 5Hz in 1s and 0.5Hz in 10s mode. The 

Sample Rate button is used to set the sampling frequency. 

The maximum value over USB connection is 100 kHz and 1 

kHz over Bluetooth connection. For both connection types 

the minimum sample rate value is 50 Hz. If, for some 

reasons, slower sample rate is necessary, then the 

measurements should be performed in the Velocity option. 
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The Measurement time is used for setting the total 

measurement time in seconds. The Delay time option 

defines the time that will elapse between pressing the Start 

button and the actual start of the measurements. The 

Threshold box allows setting the minimum value of 

movement in nm units that will trigger the measurements. 

Both Threshold and Delay time can be used simultaneously: 

if the registered movement value exceeds the value set as 

threshold, the delay time counter starts counting down to 0. 

Only when the counter finishes decrementing, the 

acquisition is started. 

Choosing the DC Block option causes switching on the 

high pass digital filter in the path. This option can be used 

for example to eliminate thermal expansion effects from the 

measurement. 

Measurement is started by the Start button. During 

measurements the data are registered to the buffer. They are 

displayed after the measurement is finished (i.e. after 

Measurement time elapses) or after the user breaks the 

measurements (by the Stop button). 

When both the measurement and the transmission are 

completed, the measurement results are presented on the 

time diagram (fig.13.15). The results can be saved, printed or 

exported (menu File). With the use of radio buttons the type 

of input data may be chosen: Distance, Velocity or 

Acceleration, Angle or Straightness (Wollaston).  
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FIG.13.13. DYNAMIC  PULL-DOWN MENU FILE  

 

Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit-

>Machine data), like machine type, machine serial number, 

measured axis or machine operator (see figure 13.14). Those 

values allow describing performed measurement for later 

analysis and they are also present on the printed report. 

Measurement report can also be generated from 

obtained data, either by pressing Print or Preview on the 

measurement analysis window (fig. 13.15). The report can be 

generated in the basic form where only the plot of the 

measured values is shown or in the extended version, which 

contains tables with measured data. 
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FIG.13.14. MACHINE DATA WINDOW  

 

It is also possible to copy the straightness graph to the 

clipboard and then paste it for example to a Word editor 

document. Copy to clipboard command is available from 

popup menu that appears after right-click on the area of the 

graph. 
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FIG.13.15. DYNAMIC DATA ANALYSIS WINDOW  

 

d. Measurement procedure 

 

1. Set up the laser on the measured machine and 

align optical path. 

2. Start the HPI-3D software and select Dynamic 

option. 

3. Configure Dynamic measurement. 

4. Press Start button and run the machine. 

5. Wait for the end of the measurements or press 

Stop button. 

6. Save the results and/or print the measurement 

report. 
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14.  MEASUREMENTS – ANGULAR 

POSITIONING 

 

 

 

 

 

a. General Description 

 

The angular positioning measurements are performed 

with the use of a Rotary Encoder (Wally). This measurement 

is used, for example, to characterize a movement quality of 

rotary axes or for very precise measurements of a rotation 

angle. The System measures angular positioning accuracy, 

repeatability and backlash by comparing the position to 

which the machine moves (i.e. the position displayed on the 

machine’s readout) with the true position measured by the 

laser interferometer. 

The laser measurement system HPI-3D together with 

the rotary encoder is capable of measuring any rotation angle 

with precision down to 1 arcsec. The System allows 

measuring angle in different units. The parameters of the 
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measurement can be set in the Configuration->Rotary Encoder 

option. 

The Rotary System Wally is connected to the PC 

wirelessly. The measurements can be performed either when 

the Encoder is mounted exactly in the in the center of 

rotation of the measured axis (in-axis configuration) or 

outside the center of rotation (off-axis configuration).  

 

 

b. Measurement Setup 

 

For angular positioning measurements an angular optics  

together with rotary encoder should be used. Necessary 

components are (see also figure 14.1): 

 Laser Head  

 Power Supply  

 Angular Interferometer IK1 

 Air Temperature Sensor (TH sensor) 

 Rotary System RE1 with integrated RK1  

 

Optional elements are: 

 USB cable 

 Manual Strobe  

 Magnetic holder UM2 

 Tripod stand 

 Base temperature sensor 



MEASUREMENTS – ANGULAR POSITIONING 

14-3  www.lasertex.eu     

14   

 

LASER  HEAD

IK1
WALLY

 

FIG.14.1. OPTICAL PATH  SET UP FOR ROTARY MEASUREMENTS IN-AXIS - 

SCHEMATIC 

 

 

 

FIG.14.2. OPTICAL PATH  SET UP FOR ANGULAR POSITIONING MEASUREMENTS- 

PHOTO 



MEASUREMENTS – ANGULAR POSITIONING 

14-4  www.lasertex.eu     

14   

 

Angular positioning measurements require usage of the 

rotary encoder RE1 together with optical elements IK1 and 

RK1. The Rotary Encoder is to be mounted precisely in the 

center of rotation of the measured axis.  With the Rotary 

Encoder there is integrated the Angular Retro-reflector RK1. 

Outside the Rotary Encoder there are placed the Laser Head 

and the Angular Interferometer IK1 as shown in the figures 

14.1 and 14.2.   

 

i. Characteristics of Wally – Rotary Measurement 

System 

 

The Rotary Measurement System Wally is a standalone 

device destined for accurate  measurement of rotation. Any 

angle rotation can be measured with precision reaching 

below 1 arcsecond. The device is battery operated and 

connects to a PC computer over wireless Bluetooth interface. 

High capacity Li-on battery allows 24 hour operation with 

fast charging lasting less than 2 hours. Battery is not 

replaceable. The power supply of the Wally is identical and 

exchangeable with the power supply of the HPI-3D laser 

head.  

Although it is possible to use the Wally in a standalone 

configuration, it is recommended to operate it together with 
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the HPI-3D. The main advantages of the combined 

laser/encoder operation are: 

 independence of the measurement accuracy on an 

imperfect mounting on the machine, 

 measurement of the angle against the laser beam, 

i.e. much greater flexibility of the setup, 

 fully automatic operation with machine 

compensation files and measurement reports 

generation. 

 

 The Rotary Measurement System is delivered in a 

separate case consisting of: 

o Rotary unit, 

o Mounting ring, 

o Mounting kit for milling machines, 

o Mounting kit for turning machines, 

o Power supply unit, 

o Necessary screws. 

 

In a separate set there is delivered a special mounting 

for off-axis measurement – as shown in the Figure 14.5, 

element 3. 

Before measurements it is necessary to mount the whole 

kit depending on the mechanical configuration. In the figures 

14.3 and 14.4 there are shown necessary elements for milling 

machines (turning tables) and for turning machines. 
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Assembled rings do not have to be disassembled if not 

necessary. 
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FIG.14.3. CONFIGURATION OF WALLY FOR MILLING MACHINES MEASUREMENTS. 

1 – CENTRAL UNIT, 2 – MOUNTING RING, 3 – RING FOR TURNING TABLES, 

4 – SCREWS M4X8, 5 – TEMPORARY TOOL FOR FINDING TABLE CENTER 
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FIG.14.4. CONFIGURATION OF WALLY FOR TURNING MACHINES 

MEASUREMENTS. 1 – CENTRAL UNIT, 2 – MOUNTING RING, 3 – RING FOR 

TURNING MACHINES, 4 – SCREWS M4X12. 

 

 

 

FIG.14.5. CONFIGURATION OF WALLY FOR OFF-AXIS MEASUREMENTS. 1 – 

CENTRAL UNIT, 2 – MOUNTING RING, 3 – MECHANICHAL SET FOR OFF-

AXIS MEASUREMENT, 4 – SCREWS M4X12. 

 

 

ii. Theory of operation  

 

The Angular Positioning measurements are performed 

with the use of two measurement instruments working 

together: the Rotary Measurement System – Wally and the 

Laser Head. 
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The coarse value of the angle is given by the rotary 

encoder RE1.  

The laser head has two functions during the 

measurements: it controls and drives the whole process and 

at the same time measures the fine value of the angle in the 

range of +/-10 degrees with the resolution of 0.01’’. The 

measurements are performed with the use of angular 

optics – IK1 and RK1 and mechanical mounts.  

 

The Laser Head and the Rotary Encoder communicate 

with the PC computer over Bluetooth interface. The laser can 

be also connected over USB port. The presence of the 

powered on the encoder is detected after connection and 

signalized by the yellow color on the Rotary link field in the 

Status bar.  

Proper rotary measurements are possible only if the 

laser sets up measurement link with the encoder. During the 

link set up procedure the wireless link quality and the 

optical signal strength are tested. The laser tries to drive the 

table to rotate -5 degrees, then +10 degrees and then -5 

degrees. If all the tests are succeed, then the link with the 

encoder is set (Rotary link field in the Status bar changes to 

green) and the measurements are possible.  
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During measurements the laser monitors the current 

rotation of the RK1 element. If the measured angle is outside 

internally set range then the HPI Software issues wireless 

command the encoder to counter rotate. 

 

Preferably the measurements should be performed with 

mount of the central unit in the center of axis rotation, i.e. in 

so called in-axis configuration. If such mechanical 

configuration is not possible, then the off-axis setup has to be 

used with or without the additional off-axis mounting 

(depending on the mechanical configuration of the measured 

axis).  

 

iii. Rotary measurements – hardware preparations 

 

Depending on the requirements the Wally has to be 

properly assembled and mounted on the machines. In the 

case of turning tables or milling machines, the configuration 

shown in figure 14.6 has to be mounted.  

The procedure of setting the Rotary link requires optical 

path to be aligned. 

The Rotary link can be set by pressing Rotary link field in 

the Status bar. 

The Rotary link is automatically broken when the optical 

path is broken.  
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First the assembled ring has to be installed in the center 

of the rotation of the machine’s measured axis. For this 

purpose special tool can be used – see element 5 in the figure 

14.3. Then the central unit has to be placed inside the ring, 

rotated clockwise and fastened with both wings. 

  

 

 

FIG.14.6. ROTARY SYSTEM ASSEMBLED FOR MILLING MACHINES MEASUREMENTS 

 

 

In the case of turning machine the assembled ring has to 

be installed in the machine’s spindle. Then the central unit 

has to be placed inside the ring, rotated clockwise and 

fastened with both wings – see figure 14.7. 

For highest accuracy red dots on the ring and the central 

unit have to be close to each other. 
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For measurements off the rotation axis there is necessary 

precision right angle set (delivered separately). The elements 

of the off-axis setup are shown in the Figure 14.5 and the 

assembled system in the Figure 14.8. 

 

 

 

FIG.14.7. ROTARY SYSTEM ASSEMBLED FOR TURING MACHINES MEASUREMENTS 
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FIG.14.8. ROTARY SYSTEM ASSEMBLED FOR OFF-AXIS MEASUREMENTS 

 

iv. Rotary measurements – battery charging 

 

The central unit of the Wally is operated from an 

internal, high quality, lithium-ion battery. The battery is 

rechargeable and non-replaceable. It can be charged either 

with the attached power supply unit or with the power 

supply unit of the HPI-3D laser head. The charging process 

takes around two hours to complete, yet 20 minutes charge is 

usually enough for 8 hours of measurements. 

 

 

v. Rotary measurements – elimination of error sources 
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One of the main advantages of the laser based angle 

measurement systems is their low sensitivity to imperfect 

mounting of the measurement components. Still an attention 

is required for proper mounting on the machine in order to 

reduce the errors to unmeasurable values.  

 

The two main possible error sources are:  

 mounting the rotary encoder outside the rotation 

axis, 

 mounting the rotary encoder at an angle to the 

rotation axis. 

 

Mounting the encoder precisely inside or outside the 

rotation center does not influence the measurement accuracy 

as long as the eccentricity is lower than 1mm.  

 

 

FIG.14.9. ROTARY SYSTEM TURNED INTO THE ALIGNMENT POSITION 
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A non-negligible influence on the accuracy has the 

mounting the laser and the central unit at an angle to the 

rotation axis. In order to minimize this problem certain 

precautions should be taken: 

1) When inserting the central unit into the ring, the red 

dots should be close to each other; 

2) In the beginning of the alignment procedure, before 

the IK1 element is used, the rotary unit should be 

rotated to the alignment position (see Fig. 14.9), i.e. 

with the mirror facing the laser. The laser head 

should be aligned (mostly with angular mountings) 

in such a way that the beam reflected from the mirror 

returns back to the front of the laser head. This 

operation forces the laser beam to be perpendicular 

to the rotation axis. 

3) In the next step the laser beam should be directed to 

the input of laser head and the software should be 

started with Display -> Adjustment shown. The 

position of the laser beam should be within the 

middle of the chart. Then the axis under 

measurement should be rotated by 90 degrees with 

Wally counter rotated by the same angle. The change 

of beam position on the chart should be marked. The 

operation should be repeated for 180 and 270 

degrees. The lower are variations of the beam 
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position, the better accuracy of the angle 

measurement. For radiuses of the measured tables of 

0.5-3m good accuracy is obtained if the beam position 

variations are within +/- 0.5mm. If the variations are 

higher, then the mounting of the Wally has to be 

checked. 

4) Only then the Wally can be rotated to the 

measurement position and IK1 can be inserted into 

the optical path. Laser head position should be 

changed only in horizontal or vertical plane (no 

angular adjustments).  

 

 

c. Software description 

 

The described device option can be used either for 

measurement of any rotation angle or for angular 

positioning measurement.  

 

i. Connecting with Wally 

 

The Wally is to be wirelessly connected to the PC 

computer over Bluetooth 4.0 or higher interface. The 

connection is carried on in the Configuration->Interface option 

(see figure 14.10). In the Communication interface pane the 

Wally button has to be pressed and then the Search… After a 
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while the compatible rotary units will be listed in the Devices 

list. Now the device with proper serial number (it can be 

read on the bottom steel ring of the central unit) has to be 

chosen and Reconnect button should be presses. After a short 

while the devices should be connected and a value in the 

Battery level should appear. 

 

 

 

FIG.14.10. CONNECTION TO THE ROTARY SYSTEM  

 

ii. Measurements of the rotation angle   
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In order to start Rotation measurements in the Main 

Menu the Display button should be pressed. On the screen 

there should appear a window Display as shown in the fig. 

14.11. The functionality of the window is very similar to the 

one described in the chapter 3 with the difference that 

options necessary for rotary measurements are visible (see 

figure 14.12). In the top left corner of the window there is 

give Wally battery level indicator. 

 

 

 

FIG.14.11. DISPLAY WINDOW WHEN ROTARY ENCODER IS PRESENT 

 

The additional options become visible in the bottom right 

corner of the window only after the Measurement type is set to 

Wally. 
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On the Status bar on the very bottom of the screen there 

is present a Wally link segment. As described in the chapter 3 

this segment has three states: 

 gray – rotary encoder RE1 not present or not 

detected; 

 yellow – rotary encoder RE1 detected but no link 

to the laser or the link was broken; 

 green – rotary encoder RE1 properly connected 

and linked. 

The measurements are possible only when the link with 

encoder is set – i.e. when the Wally link segment is green. 

Setting the link requires proper alignment of IK1 and RK1 

first. Only when the elements are aligned the Wally link 

segment should be double clicked. The procedure of setting 

the link, as described in Theory of operation section, should be 

started. When the procedure is finished successfully the 

Wally link segment turns green and the measurements are 

possible.  

 

 

FIG.14.12. DISPLAY WINDOW OPTIONS FOR ROTARY ENCODER 
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Setting link to the rotary unit is possible by left mouse 

button press on the Wally link segment of the status bar. 

Breaking the link with the rotary table is done automatically 

when the laser beam path is broken. 

 

 

Buttons in the Wally – parameters pane are used as 

additional tools during operation with Wally. The buttons 

are described below. The buttons are useful only when there 

is no Wally link! 

 - after pressing the button  Wally 

rotates by the value set in the  box. The value is in 

degrees, e.g. 20.2 means rotation by 20.2 degrees or 20 

degrees and 12 minutes.  

 - after pressing the button  Wally searches 

automatically for the best position of the RK1 element by 

rotating the element and monitoring input beam strength. 

- after pressing the button  the curent 

position of Wally is remebered. The, after for example 

Only when there is set link between Wally and HPI Software 

the laser automatically traces the position of the Wally.  

Breaking the beam path breaks the Wally link.  
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machine movement, the position can be retained by pressing 

the button . 

 

 

iii. Measurements of angular positioning   

 

In order to start Angular Positioning measurements in the 

Main Menu the Angular Positioning button should be 

pressed. On the screen there should appear a window 

Angular Positioning as shown in the fig. 14.13 

  

 

FIG.14.13. ANGULAR POSITIONING WINDOW 

 

iv. Pull down menu - File 

 

The menu bar of this window contains following 

options: File, Edit, Measurement, View, and Help. In the File 
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option (figure 14.14) there can be found commands for 

reading measured data from a file, saving the data to a file, 

printing measurements results or exporting them to a file. 

 

 

FIG.14.14. POSITIONING PULL-DOWN MENU FILE  

 

Other important options available in the File menu are 

options for generating CNC path and preparing 

compensation table. 

 

v. CNC path generation for in-axis measurements 

 

CNC path generation options allows automatic 

preparation, by the  HPI-3D software, the G-code program 

compatible with most CNC control systems. The options of 

the path generation are set in the separate window as shown 
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in the Figure 14.15 for in-axis measurement and in the Figure 

14.16 for off-axis measurements.  

In the upper part of the window the machine movement 

parameters are set. In the lower part the generated program 

can be viewed end edited. The results can be saved to a text 

file or previewed and printed. 

 

    

FIG.14.15. CNC PATH GENERATION WINDOW FOR IN-AXIS 

MEASUREMENTS 
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Following parameters in Software parameters panel 

should be configured in order to generate the proper code: 

 Measurement method - should be set accordingly 

with the chosen measurement method (see below). 

Choice must be made between linear, pendulum, 

pilgrim effective and pilgrim standard; 

 Axis – the measured machine movement axis 

should be chosen (X, Y, Z, U, V, W, A, B, C). 

 Feed Rate – the maximum machine feed rate in 

the chosen axis during measurements can be 

modified. The chosen value cannot be greater than 

machine limitations (see manual of the tested 

machine).  

 Stop Time – the time the machine stops at every 

measurement point. This time is necessary for the 

HPI Software to capture measurement point. The 

proper value of this parameter depends on the 

tested machine and on Point Capture parameters of 

the laser (described later in this chapter).  

 Step – the distance between measurement points.  

 Start point – the initial position of the machine in 

its own coordinate system. 

 Clearance – additional machine movement used 

to compensate backlash. The chosen value should 

be large enough for the proper backlash 

compensation of the machine. 
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 Cycles number – sets the number of generated 

movement cycles. For proper calculation of 

statistical parameters in Report the number of 

measurement cycles should be not lower than 

three. The more measurement cycles is chosen the 

better characterization of the machine is done but 

the longer the measurement process lasts. The 

number of cycles should be the same with the 

value in Configuration->Positioning->Cycles in series. 

 Points number – sets the number of measurement 

points. 

 g code/Heidenhain – it is possible either to 

generate the standard G-code program or a 

version compatible with Heidenhain machine 

controls.  

 Off axis measurement – opens elements used for 

machine path generation for off-axis 

measurements – see Figure 14.16. Option is active 

only after software unlocking – please contact 

local distributor for more details. Path generation 

for off-axis measurement is described in more 

details in the next chapter. 
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FIG.14.16. CNC PATH GENERATION WINDOW FOR OFF-AXIS 

MEASUREMENTS 

 

vi. CNC path generation for off-axis measurements 

 

Proper off-axis measurements are not possible without 

proper movement of the measured machine. During machine 

movement the distance between optical elements IK1 nad 

RK1 (mounted on the Wally) should be constant. This 

requires during table rotation instantaneous movement in 

two linear axes: main and auxiliary one. Manual generation 
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of such a path is very difficult thus in the HPI Software there 

is included step-by-step tutorial, explained below. 

 

0) Phase 0 – Wally and laser are to be mounted on the 

machine as described in previous paragraphs. 

 

 

FIG.14.17. PHASE 1 OF THE OFF-AXIS PATH GENERATION  

 

 

1) Phase 1 – Main axis of the machine (see Figure 14.17) 

is to be moved to make the laser beam alignment 

crosses  close to the center of the adjustment chart 

(fig. 14.17). With the movement of the auxiliary axis 

there is to be set a distance between IK1 element and 
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the central unit. The accuracy of this distance should 

be better than 10cm and does not have to kept very 

precisely. After the machine is set, the markings of 

the Main and Aux axes are to be put in the software 

window – in Linear axis – Main and Linear axis – Aux 

fields respectively. In the example in the figure 14.17 

Main is axis X, Aux is axis Y. The values from the 

machine absolute coordinate system are the written 

in the software as well in the P0 fields.  

2) Phase 2 - machine is to be rotated in the measured 

axis by +45 degrees (figure 14.18) 

 

 

 

FIG.14.18. PHASE 2 OF THE OFF-AXIS PATH GENERATION  
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3) Phase 3 – Wally is to be rotated in the same direction 

like the machine. As shown in the figure 14.19, in the 

Phase 3 there available two buttons with arrows. 

Pressing the buttons rotates Wally by predefined +45 

or -45 degrees. 

 

 

 

FIG.14.19. PHASE 3 OF THE OFF-AXIS PATH GENERATION  

 

4) Phase 4 – Machine is to be moved in the linear Main 

axis until the crosses return to the position they were 

during Phase 1 (see Figure 14.20).  
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FIG.14.20. PHASE 4 OF THE OFF-AXIS PATH GENERATION  

 

 

5) Phase 5 – Machine is to be moved in the linear Aux 

axis until the distance between IK1 and RK1 becomes 

similar to the value during Phase 1. The required 

accuracy is <10 cm. The absolute positions of the 

machine in the Main and Aux axes are to be written 

into the P0+45o fields in the software – see figure 

14.21.  

6) Phase 6 - machine is to be rotated in the measured 

axis by -90 degrees (figure 14.22) 
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FIG.14.21. PHASE 5 OF THE OFF-AXIS PATH GENERATION  

 

 

FIG.14.22. PHASE 6 OF THE OFF-AXIS PATH GENERATION  
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FIG.14.23. PHASE 7 OF THE OFF-AXIS PATH GENERATION  

 

7) Phase 7 – Wally is to be rotated in the same direction 

like the machine, i.e. by -90 degrees – see figure 14.23. 

8) Phase 8 - Machine is to be moved in the linear Main 

axis until the crosses return to the position they were 

during Phase 1. 

9) Phase 9 - Machine is to be moved in the linear Aux 

axis until the distance between IK1 and RK1 becomes 

similar to the value during Phase 1. The required 

accuracy is <10 cm. The absolute positions of the 

machine in the Main and Aux axes are to be written 

into the P0-45o fields in the software – see figure 

14.24. 
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FIG.14.24. PHASE 9 OF THE OFF-AXIS PATH GENERATION  

 

10) Phase 10 – Machine is to be rotated back to the start 

position. 

11) Phase 11 – Wally is to be rotated back to the start 

position. 

12) Phase 12 – Machine is to be moved back in the linear 

Main axis to the start position. 

13) Phase 13 – Machine is to be moved back in the linear 

Aux axis to the start position. 

14) Summary – after the movement phases the machine 

and the Wally should be in the start position and the 

software should show the summary screen as 
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presented in the Figure 14.25 with collected data. 

From the generated data the CNC path is generated. 

 

 

 

FIG.14.25. SUMMARY OF THE OFF-AXIS PATH GENERATION  

 

 

vii. Pull down menu - Edit 

 

In the pull-down menu Edit option (fig. 14.26) there are 

commands for setting measured machine data (Fig 14.27), 

defining machine error limits (fig. 14.28), previewing 

obtained positioning results, editing positioning points 

(when option Target Points from List from menu 
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Measurement is active) and changing overall positioning 

configuration.  

 

FIG.14.26. POSITIONING PULL-DOWN MENU EDIT  

 

 

FIG.14.27. MACHINE DATAWINDOW 
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viii. Machine error limits 

 

 

FIG.14.28. MACHINE ERROR LIMITS WINDOW 

 

In the Edit option allowable error limits of the machine 

for different norms (option Machine error limits - Fig. 14.28) 

are configured. The results of the angular positioning 

measurements are compared with these limits (see Fig. 

14.29). This option is especially useful when there are 

checked many machines of the same type and the same 

requirements on their accuracy are expected. 
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FIG.14.29. MACHINE ERROR LIMITS COMPARATION PANEL 

 

ix. Positioning points generation 

 

If option Target Points from List from Measurement 

menu is active, then the program expects the measured 

machine to stop in points defined in the Positioning points 

window as shown in the figure 14.30. Points can be entered 

manually or can be generated from the input parameters: 

start position, distance and interval or number of points. The 

points are calculated when Calculate button is pressed. 

Obtained points can be saved to a file. 
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FIG.14.30. POSITIONING POINTS GENERATION WINDOW 

 

x. Configuration of Positioning measurement  

 

In the Rotary encoder tab in the Configuration window 

the important parameters of the angular positioning 

measurements can be set (Fig. 14.31). There are four available 

methods for checking machine’s positioning: Linear, 

Pendulum, Pilgrim standard and Pilgrim effective (buttons 

in Measurement method panel).  
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FIG.14.31. LINEAR POSITIONING COFIG WINDOW 

 

In the Cycles in series field the number of complete 

measurements cycles is set. The greater number of cycles is 

used the better result is achieved. 

 

Max Acceptable Error is an option where the maximal 

acceptable error level is set. Above this limit, the software 

generates a warning. 

Options Point capture after and Vibrations are valid 

only when the automatic point capture is chosen. These 

options are used to configure a time delay required by the 

machine to settle the position successfully and the acceptable 
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level of vibration (level of vibration depends mainly on the 

measured machine). 

Min Points Interval configures minimal distance 

between positioning points. 

 

xi. Pull down menu – Measurement 

 

 

FIG.14.32. POSITIONING PULL-DOWN MENU MEASUREMENT  

 

Measurement menu includes the options related to the 

measurement process:  

Stop after each cycle – if this option is active program 

breaks the measurement when a measuring cycle is 

completed; if it is not active the configured number of cycles 

is executed.  

Correct target value – setting this option enables to 

change an earlier defined distance value of a measuring 

point during the measurement process. Before the point is 

captured, appears a window in which a new distance value 

can be written. In the edit field there are only marked places 
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after comma what causes that it is not necessary to write the 

whole distance.  

Automatic point capture – program captures 

measurement points automatically using settings from 

Configuration. In this mode the system itself recognizes the 

moment of stop, the value of target point, the direction of 

movement and the series number. Option exclusive with 

“Manual point capture”. 

Manual point capture – measured points are captured 

by the program when a Manual Capture button, Space key or 

a remote Strobe button is pressed. Option exclusive with 

“Automatic point capture”. 

Automatic points generate – positioning points are 

calculated automatically by the program. Points calculation 

is performed in first measuring cycle. Option exclusive with 

“Points from list”. 

Points from list – when this option is selected on the 

screen appears a window for positioning points edition. This 

window enables to write or calculate distance values for 

positioning points which are compared to measured points 

during positioning measurement. Option exclusive with 

“Automatic points generate”. 
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FIG.14.3. POSITIONING PULL-DOWN MENU VIEW  

 

View menu is used to switch on or off a Deviation table 

and to switch on schematic diagram of selected 

measurement method.  

 

d. Measurement procedure 

 

If the system is ready to work, then two digital displays 

and the gauge of measuring signal level appear on the 

screen. On the upper display the measured value is shown. 

On the bottom display the value of the target position (read 

from data points table or appointed automatically) is shown. 

Under the displays on the left side there is shown a graph on 

which the results of measurements are shown. On the right 

side an Error Table can be found. Under the graph three 

buttons can be found: Start - begins the measurement, Reset 

Position – resets the measured value and the button Main 

Menu - re-enters to the Main menu. 

In the bottom part of the window a status bar can be 

found which presents a configuration of the positioning 

measurements. In the first field the information about the 
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points capture method is placed (manual or automatic). The 

next field informs about number of cycles in series (number 

of cycles executed one after one, if not active is the option 

Stop After Cycle). In the third field there is shown the 

information about measurement method selected in the 

Configuration. 

The angular positioning measurement requires target 

positions which define the points where positioning errors 

are calculated. The target points can be automatically 

defined during the first cycle in the measurement, or 

manually written to the list or calculated (Target Points 

From List). Points are detected with 1 degree tolerance in 

automatic mode. In case of manual mode accuracy is also 

defined. 

During the measurement points can be captured 

automatically or manually as described earlier in this 

chapter. 

 

i. Rules of automatic positioning measurement  

 

For correct operation of the automatic positioning 

measurement option below rules should be followed:  

1) The time of machine stand still duration in the 

positioning point  must be no less than 1 second – default 

value (this can be changed in the Configuration->Positioning-

>Point detection->Point capture after), 
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2) Vibrations of the target  should be less than 10 arcsec - 

default value (this can be changed in the  Configuration-

>Positioning->Point detection->Vibrations less than),    

3) Backlash compensation move of the machine should 

exceed 1 arcmin.      

If vibrations are too large and system does not capture 

points, the option Manual Capture should be switched on in 

the Measurement menu. 

 

ii. Remarks on measurements and data analysis 

 

 

FIG.14.34. POSITIONING WINDOW AFTER FINISHING A FULL 

MEASUREMENT CYCLE  

 

Examination of angular positioning of machine consists 

of at least 2 measuring cycles. 
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In every cycle the measured machine rotates the retro-

reflector for programmed distance clockwise and 

counterclockwise. 

After each rotation the machine should stop for a short 

time (at least one second). 

The measured angle by the laser system is saved in the 

table of results. 

After one cycle, if Stop after each cycle is set or after the 

whole measurement process, the window with results 

appears (figure 14.34). 

Buttons Remove and Add can be used to remove or add 

the measurement cycle. It is possible to change the 

measuring cycle in which accidental error is possible. 

Browse button opens data browsing window (figure 14.33) 

where each data cycle can be viewed and analyzed.  
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FIG.14.35. DATA BROWSING WINDOW  

 

Both from main positioning window and from data 

browsing window the measurement report can be generated. 

If at least two series of measuring cycles are completed, 

statistical calculations can be performed and the report can 

be generated. In order to get the final report the Report 

button has to be pressed. The screen of the computer after 

pressing the Report button is presented in fig. 14.35. 
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FIG.14.36. ANGULAR POSITIONING REPORT WINDOW 

 

The positioning results are presented on the graph and 

in the Results panel. This panel is also used to set 

measurement data processing parameters. The norm defines 

a statistical method used in calculations and can be chosen 

from a pull-down list. Norm selection causes recalculation of 

the results. Limit values for measured machine parameters 

are presented in this panel. They are assigned to the machine 

that is chosen from Machine pull-down list. If the error 

value exceeds limits for the machine, this error is displayed 

in red.  

Under the graph there are: buttons used for report 

Preview, Print the report, change of the graph Parameters, 

and return to the previous window.  
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The axis scale can be changed using Axis Scale 

(automatic scaling or assignment, minimum and maximum 

values) option available by right mouse click on the graph. 

The report can be generated in a simplified or an 

extended form. The selection window is shown each time the 

Preview or Print buttons is pressed. The simplified version 

consists of three pages: the title page, the results page and 

the chart page. The logo on the title page can be changed in 

the Configuration. In the Extended Report additional pages 

with measurement results are added. The number of 

additional pages depends on the number of measurement 

points. 
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15. CONNECTING LASER HEAD TO 

MACHINE 

 

 

 

 

 

a. General Description 

 

The main functionality of the HPI-3D are measurements 

of machine geometry with the use of a PC computer 

connected over BT or USB interface. The functionality can be  

significantly enhanced by the Extension Connector available 

at back of the laser as shown in the figure 15.1.  

With the use of signals available on this connector it is 

possible to use the laser as a standalone device. The main 

applications are: 

 Monitoring the measured shift with an external 

counter; 

 Using the laser as a feedback part of a machine 

control loop; 

  Driving with the laser a motor through an 

external motor driver;  
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 Changing behavior of the laser by connecting 

different sensors (like end sensor or zero-crossing 

sensor).  

 

 

FIG.15.1. CONNECTIONS OF THE HPI-3D.  

 

b. Extension Connector 

i. Extension Connector pinout 

 

The Extension Connector available at the back of the 

laser head is a miniature Hirose Connector LX40-20P CL No. 

CL245-0017-0. The pinout of this connector is shown in the 

table 15.1. 

 

Power Button 

Power Connector 

Extension Connector 

USB Connector 
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Pin number Function 

1 24V / 100mA Supply 

2-7 Digital IO  Software configurable Input/Output 

8 Digital Output  

 

 Negative output of Differential B signal pair (Digital 

AquadB Output)  

 Negative output of Differential Sign signal pair 

(Shift/Sign Output) 

9 Digital Output   Negative output of Differential A signal pair (Digital 

AquadB Output) 

 Negative output of Differential Module signal pair 

(Shift/Sign Output) 

10 Digital Output   Positive output of Differential B signal pair (Digital 

AquadB Output) 

 Positive output of Differential Sign signal pair 

(Shift/Sign Output) 

11 Digital Output  Positive output of Differential A signal pair (Digital 

AquadB Output) 

 Positive output of Differential Module signal pair 

(Shift/Sign Output) 

12 5V /150 mA Power Supply  

13 Analog Output  Negative output of Differential Cosine signal pair 

(Sine/Cosine Output) 

14 Analog Output  Negative output of Differential Sine signal pair (Sine/Cosine 

Output) 

15 Analog Output  Positive output of Differential Cosine signal pair (Sine/Cosine 

Output) 

16 Analog Output  Positive output of Differential Sine signal pair (Sine/Cosine 

Output) 

17-20 Ground 

TAB.15.1. EXTENSION CONNECTOR PINOUT.  

 



CONNECTING LASER HEAD TO MACHINE  

15-4  www.lasertex.eu     

15  

There are four groups of signals available on the 

Extension Connector: 

 Power supply pins - +24VDC, +5VDC and GND 

pins are available for user application; 

 Digital IO pins – functionality configurable 

through HPI Software – see later in this Chapter; 

 Encoder type Digital Output pins – functionality 

partially configurable through HPI Software; Used 

for digital output of A-Quad-B or Shift/Sign 

output; 

 Encoder type Analog Output pins – analog output 

in SinA/CosB format (see later in this Chapter). 

 

ii. Extension Cable EX1  

 

 

FIG.15.2. EXTENSION CABLE EX1.  
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Because the Extension Connection is of high integration 

scale it is recommended to use the Extension Cable EX1 – 

figure 15.2.  

The Cable has on one end the appropriate miniature 

Hirose connector that should be inserted into the Extension 

Connector while on the other end there is a standard female 

three-row DSUB15 connector. The signals available on the 

DSUB connector are described and can be configured in the 

HPI Software in Configuration->Extension Connector panel. 

 

 

FIG. 15.3. CONFIGURATION WINDOW – EXTENSION CONNECTOR PANEL 
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Pin number Function 

1-6 Digital IO  Software configurable Input/Output 

7 Digital Output   Negative output of Differential B signal pair (Digital 

AquadB Output)  

 Negative output of Differential Sign signal pair 

(Shift/Sign Output) 

8 Digital Output   Negative output of Differential A signal pair (Digital 

AquadB Output) 

 Negative output of Differential Module signal pair 

(Shift/Sign Output) 

9 Digital Output   Positive output of Differential B signal pair (Digital 

AquadB Output) 

 Positive output of Differential Sign signal pair 

(Shift/Sign Output) 

10 Digital Output  Positive output of Differential A signal pair (Digital 

AquadB Output) 

 Positive output of Differential Module signal pair 

(Shift/Sign Output) 

11 Analog Output  Negative output of Differential Cosine signal pair 

(Sine/Cosine Output) 

12 Analog Output  Negative output of Differential Sine signal pair (Sine/Cosine 

Output) 

13 Analog Output  Positive output of Differential Cosine signal pair (Sine/Cosine 

Output) 

14 Analog Output  Positive output of Differential Sine signal pair (Sine/Cosine 

Output) 

15 Ground 

TAB.15.2. EXTENSION CABLE EX1 PINOUT.  

 

In the Table 15.2 there shown the default pinout of the 

Extension Cable EX1. Comparing this table with Table 15.1 it 
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can be seen that the only thing lacking on the EX1 are the 

power pins. All signal pins visible on the Extension 

Connector are as well accessible on the Extension Cable. 

 

iii. Encoder type outputs 

 

On the output of the HPI-3D there are available two 

types of encoder outputs: digital (A-Quad-B format, TTL) 

and analog (SinA/cosB format, 1Vpp). Both types are 

available at the same time on the Extension Connector and 

the EX1 cable – see figure 15.4.  

The edges of the digital signals and the sinusoidal wave 

of the analog output appear on the connector in real time 

after the movement of an optical element is detected by the 

laser head. The delay between measured movement and 

output signals is not greater than 10 s.  

 

LASER  HEAD

EX1

 FIG. 15.4. ENCODER SIGNAL GENERATION 
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The output signals are in real time compensated versus 

environmental parameters change. The process is shown 

schematically in the figure 15.5.  

T1 T3

Compensation 

unit with DSP 

and FPGA logic

Air

Press

USB

Bluetooth

A quad B

SinA/CosB

1.27589 mm
TH T2

Optical

Receiver

 

FIG. 15.5. REAL TIME COMPENSATION MECHANISM 

 

The detected optical signal is read by the main processor 

inside the laser head. The processor receives also data from 

environmental sensors (TH, T1, T2 and T3) and uses 

advanced algorithms to calculate the corrections of the input 
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signal. The calculations are performed each 10 s. The data 

from each sensor are received each one second. 

The corrected distance value is then sent over USB or 

Bluetooth interfaces to the PC computer.  At the same time 

the main processor communicates with a special coprocessor 

for generating encoder type signals. The coprocessor is 

responsible for adding corrections to the original optical 

signal and for generating the output signal in a desired 

standard. 

 

A

B

+90o -90 o

Positive 

movement

Negative 

movement

PERIOD
 FIG. 15.6. OUTPUT SIGNAL – A-QUAD-B FORMAT 

 

The digital A-Quad-B signal consists of two digital 

signals A and B shifted in phase by +90° or -90° depending 

on the direction of movement (figure 15.6). The signals are in 

The standard of the output encoder type signals can be 

changed by the user in Configuration->Extension Connector-

>Output Standard box. 
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5V CMOS standard and on the connector there are also 

available negated A and negated B signals – so a differential 

cable can be used. The PERIOD of the signal as shown in the 

figure 15.6 is four times greater than the Output Standard set 

in the Configuration.  

For example if the Output Standard is set to 100 nm then 

the full cycle on A and B outputs will be generated after the 

measured object shift of 400 nm is detected. 

 

Max 

+/- 1V

Resolution

SinA

CosB

 

FIG. 15.7. OUTPUT SIGNAL – SINA/COSB FORMAT 

 

The analog sinA/cosB signal consists of two analog  

signals sinA and cosB shifted in phase by +90° or -90° 

depending on the direction of movement (figure 15.7). The 

amplitude of the signals is 1Vpp single ended and 2Vpp 

differentially. The differential signals are available as a 

combination of sinA - /sinA and cosB - /cosB signals. The 

RESOLUTION of the signal as shown in the figure 15.7 is 
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forty times greater than the Output Standard set in the 

Configuration. 

For example if the Output Standard is set to 100 nm then 

the full cycle on sinA and cosB outputs will be generated 

after the measured object shift of 4 m is detected. 

 

sinA

/sinA

t [s]

U
 [
V

]

Mid

Voltage 

[V]

 

FIG. 15.8. OUTPUT ANALOG SIGNAL 

 

The output drivers deliver only positive voltages thus 

the Mid Voltage value of both output signals is important. 

This voltage can be set in Configuration->Extension Connector-

>Mid  Voltage as shown in the fig. 15.3 and should exceed 1V. 

 

The maximum frequency of analog output signals (sinA, 

cosB) is limited to 2.4 MHz. 

The maximum frequency of digital output signals (A, B) is 

limited to 24 MHz. 
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c. HPI-3D in a machine control loop 

 

Because of the encoder type signals available at the 

Extension Connector it is possible to use the HPI-3D in a 

machine control loop. The laser configured with the linear 

optics can be used as a very high-precision position encoder. 

 

Pin 11

Pin 14

Pin 12

Pin 13

EX1

sinA+

Machine with 

analog inputs

sinA-

sinB+

sinB-

sinA+

sinA-

sinB-

sinB+

Pin 7

Pin 10

Pin 8

Pin 9

EX1

Aout

Machine with 

digital inputs

/Aout

Bout

/Bout

/A

A

B

/B

 

FIG. 15.9. CONNECTING LASER HEAD TO A MACHINE 

 

Method of connection depends on the type of inputs of 

the machine as it is shown in the figure 15.9. 
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16. CONFIGURATION 

 

 

 

 

General Description 

 

All configuration options of the interferometer are 

available in the Configuration located in the Main Menu or 

in each measurement option in pull down menu Edit-

>Configuration. 

In the Configuration (Fig. 15.1) the user can configure 

the behavior of the HPI-3D during measurements and the 

appearance of the HPI Software. For example the language of 

the program can be changed - after installation the program 

opens in the language of the installed Windows system. 

Other panels are used to configure parameters of all types of 

measurements available with the system.  

 

 

Panel Interface 

 



CONFIGURATION 

16-2  www.lasertex.eu     

16  

In the Interface panel (fig. 16.1) the user can force the 

software to connect or reconnect with the laser over chosen 

interface. In order to do this the user should choose the right 

communication interface (USB, Bluetooth or Simulator) and 

press Reconnect. After a while an appropriate message will 

be displayed (with communication success or failure). 

 

 

FIG. 16.1. CONFIGURATION WINDOW – INTERFACE PANEL 

 

Panel WiMeteo 

 

The options available in the WiMeteo panel (fig. 16.2) are 

used to control the operation of the wireless module. It is 
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responsible for communication with environmental sensors 

and rotary encoder.  

 

 

FIG. 16.2. CONFIGURATION WINDOW – WIMETEO PANEL 

 

 

It is possible to switch the whole module on (if it went 

accidentally off) by pressing the WiMeteoOn button or to 

force the sensors to search for the new connection channel 

with WiMeteo Reconnect button.  

 

The reconnection takes usually between 2 and 3 minutes. 
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In the Sensors part of the WiMeteo panel the user can 

register a new sensor. The address of the registered sensor 

should be placed in the Address field, the sensor number 

should be chosen and then the Register button should be 

pressed. Sensor number 0 is TH sensor, while sensors 

numbered 1-3 are respectively sensors T1-T3. 

 

 

 

Panel Parameters 

 

In Parameters Panel (fig. 16.3) it is possible to set 

parameters of used optical components. Base length is the 

size of the carriage of the Angular Retroreflector RK1 

element. The standard size is 10cm.  

Wollaston Coefficient is a parameter of the Wollaston 

Prism WP2 element. The coefficient is delivered with every 

WP2 element. This field is password protected to avoid 

inadvertent modification of the parameter. The password is: 

“54321”. 

This operation should be done carefully. Putting wrong 

address in the Address field results in loosing proper reading of 

the changed sensor.  
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Right angle prism Error is the parameter of the Right 

Angle Etalon REW element. The coefficient is delivered with 

every REW element. This field is password protected to 

avoid inadvertent modification of the parameter. The 

password is: “54321”. 

 

 

FIG. 16.3. CONFIGURATION WINDOW – PARAMETERS PANEL 

 

On the front page of every report generated by the HPI 

Software there is placed the logo. Its path is set in the Logo 

path field. The file should have bmp file format. 
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Panel General 

 

The HPI Software can be easily tailored to different 

languages. This can be done by changing the language in the 

Language box in the General Panel (fig. 16.4). All language 

files are stored in the HPI_Software/Languages catalog on 

the hard drive and can be modified with the use of 

lngeditor.exe application which is present in the same 

catalog. 

The resolution of the measurements can be modified in 

the Precision box. For laboratory use the Extended precision 

should be chosen. In this case all results are displayed with 

the highest possible precision. For normal use the Normal 

option should be chosen. 

 

Parameters: Base length, Wollaston Coefficient and Right 

angle prism Error should be set to proper values after EVERY 

installation of the HPI Software on the new computer or in the new 

folder. 
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FIG. 16.4. CONFIGURATION WINDOW – GENERAL PANEL  

 

The double-pass option in the Interferometer type box 

should be chosen when the flat mirror type (so called double 

pass) interferometer is used in the optical path. In all other 

cases, i.e. for all other types of optical components the single-

pass option has to be selected. 

 

Other options present in the General Panel are used to 

change units for different measurements types. 

Improper choice of the Interferometer type option results in 

large measurement error! 
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Panel Meteo 

 

The options available in the Meteo panel (fig. 16.5) are 

used for further configuration of environmental parameters. 

It is possible to change units of temperature and pressure 

(Temperature unit and  Pressure unit boxes).  

 

 

FIG. 16.5. CONFIGURATION WINDOW – METEO PANEL 

 

Automatic measurements of selected parameters can be 

switched on or off in the Measurement parameters box.  
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It is also possible to change the Reference temperature 

which is the temperature the measured machine is corrected 

to. Usually 20.00°C is set. 

 

Panel Extension Connector 

 

 

FIG. 16.5. CONFIGURATION WINDOW – EXTENSION CONNECTOR PANEL 

 

The options grouped in the Extension Connector panel 

(fig. 16.6) are used to control the operation of the extension 

connector available on the back panel of the laser.  
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On the left side of the panel there is visible the schematic 

drawing of the connector with the description of the 

functionality of the pins. The functionality can be modified 

with the list buttons in the right part of the panel. Each 

modification has to be approved by pressing Set button.  

In the bottom part of the panel there are two parameters 

modifying the output analog and digital signals (i.e. A, B, 

sinA and sinB). The Output standard option defines the 

resolution of digital signals (A, B) – each edge of the digital 

signal means the measured movement of Output standard 

value.  

 

The resolution of the analog outputs is 40 x Output standard, 

i.e. one full period of the sinA or sinB signal means the measured 

movement of 40 x Output standard. 

The signals described in the Extension Connector panel are 

available on the DB15 connector of the extension cable (not present 

in the standard delivery). The extension connector pinout is 

described in the Technical Data chapter.  
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FIG. 16.6. OUTPUT ANALOG SIGNAL 

 

The Mid voltage option defines the medium value of 

the analog outputs as shown in the figure 16.6.  

 

 

Panel Statistics 

 

The data visible in the Statistics panel (fig. 16.7) are for 

information only. Laser work time shows how long the laser 

tube was switched on during its lifetime. After 20000 hours 

the laser should be shipped to factory for testing and 

calibration unless recommended calibration times are used.   

 

The value set as Mid voltage should be higher then 1V and 

lower than 4V. 
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FIG. 16.7. CONFIGURATION WINDOW – STATISTICS PANEL 

 

 

Panel Firmware update 

 

The HPI-3D device is fully software defined, which 

means that the digital processing of the signals is a very 

important part of the device. All internal digital modules are 

available through the USB interface and their firmware can 

be easily modified in the Firmware update panel.  
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FIG. 16.8. CONFIGURATION WINDOW – FIRMWARE UPDATE PANEL 

 

If firmware becomes available then below procedure 

should be followed: 

1. Connect laser head by USB interface 

2. Start HPI Software 

3. Enter Configuration->Firmware update 

4. Press Open button and choose the firmware file 

(with .x00, .mcs, .zig, or .hex extension) 

5. Press Program button 

6. Wait for the device to be programmed – up to 10 

minutes 
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Other panels 

 

Other panels available in the Configuration are 

described in the respective chapters: 

 panel Positioning in Chapter 5; 

 panel Velocity in Chapter 6; 

 panel Straightness in Chapter 7; 

 panel Flatness in Chapter 8; 

 panel Vibrations in Chapter 12; 

 panel Rotary Encoder in Chapter 14. 
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17. PRINCIPLES OF OPERATION 

 

 

a. The rules of laser displacement 

measurements 

 

Displacement measurements with the use of a laser 

interferometer allow obtaining the accuracy of a 

displacement measurement of 0.4 ppm in air and 0.02 ppm in 

vacuum. The interferometer was first built by A.A. 

Michelson in 1881. The simplified schematic of the 

interferometer is shown in the fig. 17.1. 

Coherent light beam falls on a semi-transparent mirror. 

This mirror splits the light into two beams. The first goes to 

the reference arm and reflects from the reflector Z1; the 

second goes to the measurement arm and reflects form the 

reflector Z2.  The reflected beams meet again on the detector. 

Because these beams come from the same, coherent, source, 

they will interfere. When the moving reflector is being 

displaced, the frequency of the reflected beam in the 

measurement arm changes. The detector counts the 
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frequency difference between reflected beams - fD (see fig. 

17.1). The measured value of the displacement is calculated 

according to  

 

22
*

ll
 NfL D  (1) 

                   Where:  N – number of pulses, 

l - light wavelength. 

 

FIG.17.1. THE MICHELSON INTERFEROMETER.  

 

Detector

Z

Coherent

light

source

Reference

reflector

Moving

reflector

 fDf1

f1

f1f1

x fD

Z1

Z2

f1

- frequency resulting from

the Doppler effect

fD

v
c2 f1fD =



PRINCIPLES OF OPERATION 

17-3  www.lasertex.eu     

17  

b. The construction of real interferometers 

The main disadvantage of Michelson interferometer 

results from the fact that the detector cannot determine, 

whether fD is negative or positive thus, from the 

measurements the displacement of the moving reflector 

without the sign is obtained. Currently there are widely used 

two methods that allow getting also the direction of the 

movement. Depending on the number of light frequencies 

(wavelengths) used in the interferometer, the first is called 

homodyne (one frequency) and the second heterodyne (two 

frequencies) method.  

In the homodyne method, shown on figure 17.2, as a 

coherent source of light a linearly polarized laser is used. If it 

is two-mode laser (i.e. it generates two wavelengths) than 

one mode must be cut off with the use of a properly set 

polarizer. The polarizing splitter splits the light beam from 

the laser into two beams polarized vertically (90°) and 

horizontally (0°). The former is directed to the measurement 

arm and the latter to the reference one. The frequency of the 

beam in the measurement arm changes with the movement 

of the moving reflector. The polarization of the reflected 

beams is changed to circular with the use of a l/4 waveplate. 

After 0° and 45° polarizers, two signals shifted in phase are 

obtained. The phase shift is +90° when the measurement arm 

moves to and -90° when it moves from the laser.  
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FIG.17.2. THE BLOCK DIAGRAM OF AN INTERFEROMETER WORKING 

ACCORDING TO THE HOMODYNE METHOD 

 

In the heterodyne method, shown on figure 17.3, two 

laser frequencies are used. Therefore a two-frequency laser is 

needed, e.g. a Zeeman laser. A two-mode laser is not suitable 

for the heterodyne method interferometer, because the 

difference between f1 and f2 is usually too high for an 

electronic counter. The output beam of a Zeeman laser 

consists of two circularly polarized beams, one polarized 
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leftward and the second rightward. A l/4 waveplate 

changes circular polarization to linear. The main difference 

between two described methods is that in the heterodyne 

one the beam frequency in reference arm differs from the 

beam frequency in the measuring arm. A detection path is 

also different – subtracting differential frequencies of 

reference and measuring arms does the measurement. 

 

The heterodyne method gives correct results only when 

fD does not exceed the difference between the laser 

frequencies, i.e.: f2 – f1. In reality, that difference, resulting 

from the Zeeman effect, is about 1MHz. This limits the 

maximum available velocity of measuring arm, in one 

direction, to 0.3 m/s. The next disadvantage of the 

heterodyne method is, that two frequencies must be used for 

measurements, while in the homodyne method the second 

may be used for measuring e.g. a second axis.   
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FIG.17.3. THE BLOCK DIAGRAM OF AN INTERFEROMETER, WORKING 

ACCORDING TO THE HETERODYNE METHOD 

 

c. The influence of the outside conditions on the 

measurement accuracy 

 

According to equation (1) an interferometer’s unit of 

measure in length measurement is laser’s wavelength. From 

definition 
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f

v
l   (2) 

 

a wavelength depends on laser’s frequency f and the 

speed of light v in the measuring path. If the measurement is 

done in vacuum, than = c = 3*108 m/s. The speed of light in 

a medium other than vacuum (e.g. air, water) is lower and is 

described as  

 

n

c
v     (3) 

                 Where: n – a refraction coefficient. 

 

Normally the refraction coefficient n is a complex 

variable or even a tensor, but for less accurate calculations it 

is simplified to a constant. The air coefficient depends mostly 

on the pressure P, temperature T and humidity H. The 

dependence nT,P,H, for the air was empirically determined by 

Edlen and is described as 

 

n
T

TP
Pn HPT 









*003661,01

)*00997,0613,0(**101
*10*8775,21

6
7

,,  (4) 

TeHn *057627,09 **10*033,3   (5) 
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From the above equations one may obtain the refraction 

coefficient dependences on T, P and H in usual conditions 

(T=293K, P=1000hPa, H=50%): 













 

KT

n 1
10*93,0 6  













 

hPaP

n 1
10*27,0 6  













 

%

1
10*96,0 8

H

n
 

It is worth to notice that the most critical parameter is 

the temperature, because its change influences the coefficient 

n more than changes in the pressure and much more than 

changes in the humidity. 

 

  

d. The accuracy of laser interferometers 

 

i. Errors caused by the environment  

 

The most impotent source of errors in machine 

geometry measurements is the temperature (or more exactly, 

the change of the temperature) of the measured machine. For 

example, if the machine’s base is made of steel, than the 

base’s length increases 11.7m when its temperature changes 

1K. It shows how important it is for very precise 

measurements to measure the temperature of the controlled 

part of the machine and to use it in readout corrections. This 
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is not a simple task for a few reasons, but the most important 

one is that, than when the machine operates, there are 

temperature gradients on it. That means that more than one 

temperature sensor is needed and that the more sensors are 

used the better accuracy can be achieved.  Moreover the 

shape of the measured part of the machine may “absorb” a 

part of the expansion of the material or the part may be built 

of materials of different expandability. 

As was mentioned in the previous chapter, the 

temperature influences the accuracy also as it changes the 

refraction coefficient of the medium the measurements are 

made in (usually it is air, but may be e.g. water). An Edlen 

equation was presented, showing how the refraction 

coefficient of the air changes with the change of the air 

temperature, pressure and humidity. The errors caused by 

the change of the wavelength are less important than the 

mentioned above, but they cannot be abandoned. Roughly, a 

1ppm error (i.e. 1m/m) is caused by: the air temperature 

change of o 1K, the air pressure change of 4hPa and the air 

humidity change of 30%. 

 

ii. Dead path error 

 

A dead path error is an error associated with the change 

in environmental parameters during a measurement. This 

error occurs when some part of the light path (a dead path) is 
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not included in the temperature (both air and base), pressure 

and humidity compensation.  

The dead path of the light path is a distance between the 

optical interferometer and the base (or the null point) of the 

measuring position (L1 on figure 17.4). Let the position of the 

interferometer and the retro-reflector does not change. When 

there is a change in the air temperature, pressure or 

humidity, than the wavelength changes on the whole path 

length (L1 + L2). The path length changes also when the 

temperature of the base changes. But the correction system 

will use the correct wavelength only on the length L2 and 

will correct only this length. The correction will not be made 

on a dead path L1. In this way, the laser system will “move” 

the base point.  

A dead path error is the more severe the greater is the 

distance between the interferometer and the base point. This 

error is especially important in laser interferometers where 

the interferometer is build-up in a common casing with a 

laser head, because it is than very difficult to reduce a dead 

path. 
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FIG.17.4. AN ILLUSTRATION OF A DEAD PATH ERROR 

 

 

iii. Cosine error 

 

If the laser beam is not parallel to a measured axis of a 

machine (i.e. the optical path is not properly adjusted) than a 

difference between the real distance and the measured 

distance occurs. This error of misalignment is known as a 

cosine error, because its magnitude depends on the angle 

between the laser beam and the axis of the machine (fig. 

17.5). 

Laser head
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Base point

(Null point)

Laser head

Interferometer

Reflector

L1 L2

Base point

(Null point)

The correct deployment of the optical

components for reducing a dead path error
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If, as a reflector a flat mirror is used, than the beam must 

be perpendicular to it. If the machine changes its position 

form point A to point B, than the beam stays perpendicular 

to the mirror, but moves on its surface. The distance 

measured by the laser interferometer LLMS, will be smaller, 

than the real distance LM, according to  

 

LLMS = LM * cos (6) 

 

The above equation is valid also when as a reflector a 

corn cube is used. 

 

FIG.17.5. THE BEAM UNALIGNMENT AS A CAUSE OF A COSINE ERROR 

 

The only method of eliminating the cosine error is a 

proper laser beam alignment done before a measurement. 

 

Laser head

LLMS

LM



Reflectors

Laser beam

Machine's movement

axis
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iv. Abbe error 

 

An Abbe error occurs when, during measurements, the 

measured part does not move perfectly straight and there 

appear angular movements, which cause sloping of the 

retro-reflector. The sloping of the reflector is the greater the 

longer is the distance between the axis of the measurement 

and the axis of movement. This distance is called An Abbe 

offset. Only the movements in the axis of the measurement 

are important (see fig. 17.6). An Abbe error may be avoided 

only when there are no angular movements of the retro-

reflector in the axis of the measurements. 

 

FIG.17.6.  AN ILLUSTRATION OF AN ABBE ERROR 
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v. Laser stability error 

 

As was already mentioned, in laser measurements the 

laser wavelength instability changes directly the readout 

from the interferometer, e.g. a relative instability of the laser 

in the range of 1ppm (10-6), causes an error of 1m on every 

1m of a measured distance. Therefore the laser instability 

error is important mainly in measurements in vacuum 

(where a refraction coefficient is constant) and when a low 

stability laser is used (e.g. a semiconductor laser). The 

stability of usually used in laser measurement systems, 

HeNe gas lasers is 0.02 ppm, so the stability error may be 

neglected. 

 

 

vi. Other errors 

 

In some conditions, a noticeable error may be caused by 

the electronic part of the interferometer. As the electronics is 

used mainly for counting, the errors may be associated either 

with miscounting (some pulses are not counted) or with 

miscalculating (the calculations are made with finite 

precision).  
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vii. A summary of laser measurement system errors 

 

In order to show which of the errors influence the 

accuracy of a laser measurement system the most, an 

exemplary calculation of errors on a 1m long steel machine is 

shown on figures 17.7 and 17.8. Different scales of the charts 

should be taken into account.  

 

FIG.17.7.  A CALCULATION OF ERRORS FOR A LASER MEASUREMENT 

SYSTEM WITHOUT THE COMPENSATION OF THE ENVIRONMENT 
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FIG.17.8.  A CALCULATION OF ERRORS FOR A LASER MEASUREMENT 

SYSTEM WITH THE COMPENSATION OF THE ENVIRONMENT
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18. TROUBLESHOOTING 

 

 

 

General Description 

 

The troubleshooting of the possible problems with the 

HPI-3D is shown in this chapter on the basis of block 

diagrams. In each diagram the first block on the top names 

the problem that is dealt by the diagram. 

 

Problems with connection over USB or Bluetooth 

 

The diagram charts for solving problems with 

connection are shown in the figure 18.1 – connection failed 

problem and in the figure 18.2 – connection broken problem.  
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Connection 

failed

Is the laser head 

powered? 

Power on the head

Is the USB 

connection desired?

N

Is the USB cable 

connected to laser 

and PC?

Is the USB cable 

connected to laser 

and PC?

Y N

Connect USB cable

Restart HPI 

Software

Restart HPI 

Software

Disconnect USB cable

Restart HPI 

Software

N Y

Is the right device 

number chosen on 

the splash screen?

Is the right device 

number chosen on 

the splash screen?

Y N

Restart HPI 

Software and 

choose the right 

device number

N N

Restart HPI 

Software and 

choose the right 

device number

Y

Power off laser head

Wait 10 second

Power on laser head

Restart HPI 

Software

Y

 

FIG.18.1. CONNECTION FAILED CHART 
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Connection 

broken

Is the laser head 

powered? 

Power on the head

Is the laser connected 

over USB?

N

Is the USB cable 

connected to laser 

and PC?

Is the wireless 

module in the PC on?

Y N

Connect USB cable

Restart HPI 

Software

Restart HPI 

Software

Switch on wireless module 

in the PC 

Restart HPI 

Software

N N

Y

Power off laser head

Wait 10 second

Power on laser head

Restart HPI 

Software

Power off laser head

Wait 10 second

Power on laser head

Restart HPI 

Software

Unplug USB cable

Plug in USB cable

 

FIG.18.2. CONNECTION BROKEN CHART 

 

Problems with connection with wireless sensors 

 

The diagram charts for solving problems with 

connection with one or more sensors are shown in the figure 

18.3.  
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Sensor(s) not 

visible

Was the power plug 

of the laser inserted 

for more than 4 

minutes?

Are some sensors 

visible?

N

Y N

Wait 4 minutes

Y

Press WiMeteo Reconnect 

button

Enter 

Configuration->WiMeteo 

option in HPI_Software

Y

Unscrew the top cap of the 

non-working sensors and 

check/replace the battery

Did the sensor diode 

blinked on during 

closing the top cap?

Wait 4 minutes

Check the battery

N

Power off laser head

Wait 10 second

Power on laser head

Restart HPI 

Software

Unplug USB cable 

(if applicable)

Plug in USB cable 

(if applicable)

 

FIG.18.3. SENSOR(S) CONNECTION PROBLEM CHART 

 

 

Problems with linear measurements 

 

The diagram charts for solving problems with 

measurements and laser stabilization are presented in the 

figures 18.4 and 18.5.  
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Laser does not 

measure

Does the laser 

stabilise?

Is the diode on the 

top of the laser 

green?

N

Y Y

Wait until laser 

stabilises
Y

Y

Is the diode on the 

top of the laser 

yellow?

Align properly 

optical path

N

In the HPI Software enter 

Main Menu and return to 

Display menu

Does the laser 

measure?

OK

Y Restart HPI Software

N

Does the laser 

measure?

OK

Y

Close HPI Software

Power off laser head

Wait 10 second

Power on laser head

Start HPI Software

N

Is the diode on the 

top of the laser 

blinking?

Wait until laser 

stabilises

Switch the laser 

on

N

Y

 

FIG.18.4. NOT MEASURING LASER PROBLEM CHART 
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Laser does not 

stabilise

Is the diode on the 

laser blinking for more 

than 10 minutes?

Is the laser stable in 

less then 2 minutes?

N

N Y

Wait 10 minutes

Close the diaphragm on 

the laser head or obstruct 

the beam before the laser

Y

Problems with back 

reflection of the laser 

beam

Realign the optical path so 

that no reflection returns 

back to the laser

Power off laser head

Wait 10 second

Power on laser head

Restart HPI 

Software

Unplug USB cable 

(if applicable)

Plug in USB cable 

(if applicable)

 

FIG.18.5. NOT STABILISING LASER PROBLEM CHART 
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19. TECHNICAL DATA 

 

 

 

 

a. System specifications 

 

 

 

Measurement Range Resolution Accuracy 

Distance 0 – 30 m 100 pm 0,4 m/m 

Velocity 0 – 7 m/s 0.25 m/s 0,1 % 

Angular 0 – 3600 arcsec 0,001 arcsec  0,1 ppm 

Straightness 

measurement 

(with angular optics) 

0 – 15 m 
0,01 m (for 100 

mm base) 
 0,2 % 

Straightness 

measurement 

(with 3D optics) 

0 – 6 m 0.1 m (10+10*L)m 

Flatness 

0 – 15 m 

Vertical range 2 

mm 

0,01 rad (for 

100 mm base) 
 0,2 % x L 

Straightness 

measurement (with 

Wollaston prism) 

0.3 – 9 m 

Vertical range up 

to 30mm 

0.01 m 
0.5% x L m 
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Squareness   1000 arcsec 0.01 m  0,5 arcsec 

Rotary measurements  720  0,04 arcsec  0,2 % 

L = axis length in meters 

 

b. Laser head 

Laser type 
HeNe laser with frequency 

stabilization 

Heating time Approx. 5 min 

Wavelength (vacuum)  
632,990566 nm 

632,992031 nm 

Wavelength accuracy  0,005 ppm 

Short time stability  0,001 ppm (1 hour) 

Output power  900 – 1000 μW 

Beam diameter 8 mm 

Distance between outgoing and 

ingoing beam 

12,7 mm 

Laser Head dimensions 45x70x245 mm 

Net weight 1500 g 

Safety class 
Class 2 Laser product according to 

PN-91/T-06700 

 

c. Laser Head outputs - analog 

Signal type SinA / CosB 

Voltage level 1 Vpp 

Signal resolution User defined: 

from 40nm/period to 200m/period  

in 40nm/period step 

Maximal signal frequency 2.5 MHz 
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d. Laser Head outputs – digital, type 1 

Signal type A quad B 

Voltage level 5 V differential CMOS 

Signal resolution User defined: 

from 1nm/transition to 

5m/transition  

in 1nm/transition step 

Maximal signal frequency 25 MHz 

 

e. Laser Head outputs – digital, type 2 

Signal type Shift / Sign 

Voltage level 5 V differential CMOS 

Signal resolution User defined: 

from 0.1nm/pulse to 5um/pulse  

in 0.1nm/pulse step 

Pulse width 5 ns 

Maximal signal frequency 100 MHz 

 

f. Laser Head outputs – Extension connector 

pinout 

Connector type Hirose Connector LX40-20P 

CL No. CL245-0017-0 

 

Pin number Function 

1. 24V Supply 
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2. Digital IO  Reserved for future use 

3. Digital IO  Reserved for future use 

4. Digital IO  Reserved for future use 

5. Digital IO  Reserved for future use 

6. Digital IO  Reserved for future use 

7. Digital IO  Reserved for future use 

8. Digital IO   Negative output of Differential B signal pair (Digital 

AquadB Output)  

 Negative output of Differential Sign signal pair 

(Shift/Sign Output) 

9. Digital IO   Negative output of Differential A signal pair 

(Digital AquadB Output) 

 Negative output of Differential Module signal pair 

(Shift/Sign Output) 

10. Digital IO   Positive output of Differential B signal pair (Digital 

AquadB Output) 

 Positive output of Differential Sign signal pair 

(Shift/Sign Output) 

11. Digital IO   Positive output of Differential A signal pair (Digital 

AquadB Output) 

 Positive output of Differential Module signal pair 

(Shift/Sign Output) 

12. 5V Supply 

13. Analog Output  Negative output of Differential Cosine signal pair 

(Sine/Cosine Output) 

14. Analog Output  Negative output of Differential Sine signal pair 

(Sine/Cosine Output) 

15. Analog Output  Positive output of Differential Cosine signal pair 

(Sine/Cosine Output) 

16. Analog Output  Positive output of Differential Sine signal pair (Sine/Cosine 

Output) 

17. Ground 
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18. Ground 

19. Ground 

20. Ground 

 

g. System work conditions 

Temperature range 0 – 35 C 

Humidity range 10 – 90 % (non-condensing) 

 

 

h. Power Supply 

 

 

i. PC interface 

Type 1 USB 2.0 

Data rate 3125000 bps (VCOM) 

 

Type 2 Bluetooth 2.0 + EDR 

Connection  Point-to-Point (pico net) 

Frequency 2.400 to 2.4835 GHz 

Tx Power Max 18 dBm (Class 1) 

Rx Sensitivity -86 dBm typical 

Coverage Up to 25m 

 

Voltage 90-230 VAC, 50-60 Hz 

Power 
100 W (during heating) 

15 W (work) 
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j. Environment compensation 

   Wavelength compensation 

Manual Environments parameters entered 

from keyboard 

Automatic With the use of the Environmental 

Compensation Unit - (ECU) . 

 

Parameters of the wireless Environmental Compensation Unit - (ECU) compensation 

Air temperature Range 0 – 50 C, accuracy 0,15 C 

Base temperature Range 0 – 50 C, accuracy 0,1 C 

Pressure Range 940 – 1060 hPa, accuracy 1 hPa 

Humidity Range 10 – 90 %, accuracy 10 % 

Time constants Temperature 8 s, pressure 2s, humidity 

20 s 

Dimension 50x55 mm 

Net weight 150 g 

 

 Wireless material temperature compensation 

Manual Temperature of material entered from 

keyboard 

Automatic With the use of 1 to 3 wireless 

temperature sensors . 

Temperature sensor Pt-1000 

Time constant 10 s 

Net weight 150 g 

 

 

Our products are subject to continuous further development and 

improvement. Subject to technical changes without prior notice. 
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20. INDEX 

 

 

 

 

A 

Abbe error, 17-13 

Acceleration, 12-6, 13-13 

Accuracy, 5-1, 5-25, 5-40, 14-1, 14-12, 17-1, 

17-6, 17-8, 17-9, 17-15, 19-2, 19-6 

Air temperature, 3-11, 5-7, 6-2, 7-7, 7-16, 7-21, 

8-2, 9-2, 10-3, 11-3, 12-2, 13-2, 13-6, 13-9, 

19-6 

analog outputs, 16-11 

Angular Interferometer, 3-12, 7-7, 8-2, 9-2, 

10-2, 11-2, 13-5, 14-2, 14-4 

Angular positioning, 14-1, 14-4 

Angular Retro-reflector, 3-13, 7-7, 7-42, 8-2, 

9-2, 10-2, 11-2, 13-5, 14-2, 14-4 

autocollimator, 7-1 

Automatic point capture, 5-35, 14-17 

Automatic points generate, 5-36, 14-17 

B 

Base length, 7-38 

Base temperature, 3-11, 6-2, 7-7, 7-8, 7-16, 7-

21, 7-22, 8-2, 8-4, 9-2, 10-3, 10-6, 11-3, 11-5, 

12-2, 13-3, 13-6, 13-9, 14-2 

Base temperature sensor, 6-2 

battery, 3-15, 3-22 

Beam alignment, 4-1 

Beam Benders, 8-2 

Bluetooth connection, 3-14 

C 

CNC path generation, 5-19, 5-20 

Compensation table, 5-23 

Configuration, 3-20, 3-25, 3-27, 3-28, 3-30, 5-

28, 5-35, 5-41, 5-46, 6-1, 6-10, 6-11, 7-38, 8-

9, 9-9, 9-10, 10-10, 10-11, 11-9, 11-10, 12-1, 

14-2, 14-14, 14-17, 14-19, 14-23, 15-1, 15-6, 

16-1, 16-2, 16-3, 16-5, 16-7, 16-8, 16-9, 16-

12, 16-13, 16-14 

connection, 3-18, 3-20, 3-25, 13-12, 16-4, 18-1, 

18-3, 18-4 

Correct target value, 5-35, 14-16 

Cosine error, 17-11 

D 

Dead path error, 17-9 

diaphragm, 4-6 

digital, 3-22, 5-37, 13-13, 14-18, 16-10, 16-12, 

19-3 

Digits, 3-22 

displacement measurements, 17-1 

Display, 3-20, 3-21, 3-22, 3-29, 4-2, 5-12, 6-5, 

7-25, 8-5, 9-5, 10-7, 11-6, 12-5, 13-11 

Distance, 12-6, 13-13, 19-1, 19-2 

Dynamic measurements, 13-1 

E 

ENVIRONMENT, 3-7, 3-22, 19-6 
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Error Table, 5-37, 14-18 

Excel, 3-23 

Extension Connector, 3-14 

F 

FFT analysis, 12-6 

firmware, 16-12, 16-13 

Firmware, 16-12, 16-13 

G 

G-code, 5-19 

H 

heating up, 3-21 

heterodyne, 17-3, 17-4, 17-5, 17-6 

homodyne, 17-3, 17-4, 17-5 

I 

IK1, 3-12, 7-7, 8-2, 8-3, 9-2, 10-2, 11-2, 13-5, 

13-6, 14-2, 14-4 

IL1, 3-10, 3-26, 4-10, 5-7, 5-8, 6-2, 12-2, 13-2 

Interferometer type, 16-7 

L 

Language, 16-6 

Laser head, 3-10, 12-2, 13-2, 19-2 

Laser Head, 1-2, 3-13, 3-14, 3-15, 3-21, 3-25, 

3-26, 4-2, 4-5, 4-6, 4-8, 5-7, 6-1, 7-7, 7-15, 

8-1, 9-2, 10-2, 11-2, 13-5, 13-8, 14-2, 14-4, 

19-2, 19-3 

laser interferometer, 17-8, 17-10 

Laser stability error, 17-14 

Laser work time, 16-11 

Linear interferometer, 3-10, 5-7, 6-2, 12-2, 13-

2 

Linear positioning, 5-11 

Linear retro-reflector, 3-10, 5-7, 6-2, 12-2, 13-

2 

Logo path, 16-6 

M 

Machine data, 6-7, 6-8, 7-37, 8-7, 8-8, 9-7, 9-8, 

10-9, 10-10, 11-8, 11-9, 12-7, 13-14, 13-15 

Machine error limits, 5-25, 14-12 

Magnetic holder, 3-11, 5-8, 6-2, 7-7, 7-16, 8-2, 

9-2, 10-3, 11-3, 12-2, 13-2, 13-6, 13-8, 14-2 

MAIN MENU, 3-20, 3-21, 5-11, 5-38, 6-5, 7-24, 

8-5, 9-5, 10-7, 11-5, 12-5, 13-11, 14-6, 14-9, 

14-18 

Manual Capture, 5-35, 5-40, 5-41, 14-17, 14-

20 

Manual point capture, 5-35, 5-36, 9-6, 14-17 

Max Acceptable Error, 14-15 

Measurement, 3, 1-1, 3-23, 3-24, 3-27, 4-6, 5-4, 

5-18, 5-24, 5-27, 5-29, 5-34, 5-35, 5-37, 5-40, 

6-1, 6-11, 7-2, 7-10, 7-19, 7-37, 8-1, 8-14, 8-

16, 9-2, 9-6, 9-10, 10-1, 10-14, 10-15, 11-1, 

11-12, 11-13, 11-14, 12-2, 12-9, 13-2, 13-16, 

14-2, 14-9, 14-10, 14-13, 14-14, 14-16, 14-18, 

14-20, 19-1 

measurement cycle, 5-42, 14-20, 14-21 

Mid voltage, 16-11 

mirror, 3-13, 3-30, 8-11, 8-13, 17-1, 17-12 

O 

Output standard, 16-10 

P 

parallelism measurement, 11-1 

parallelism measurements, 11-1, 11-3, 11-4, 

11-5, 11-10 

Pendulum, 5-29 

Pilgrim Effective, 5-29 

Pilgrim Standard, 5-29 

Pitch, 7-32, 7-44, 7-46, 7-47, 8-14, 9-1, 9-2, 9-3, 

9-4, 9-5, 9-6, 9-7, 9-9, 9-10, 10-14, 11-13 
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Point capture after, 14-15 

points capture, 5-18, 14-18 

Points from list, 5-36, 14-17 

Points from List, 5-24, 5-27, 14-10, 14-13 

Points Interval, 14-16 

Positioning, 5-1, 5-8, 5-9, 5-11, 5-19, 5-24, 5-

27, 5-28, 5-34, 5-36, 5-42, 14-9, 14-10, 14-11, 

14-13, 14-14, 14-16, 14-17, 14-20 

Power Button, 3-17 

power down mode, 3-15 

Power Supply, 3-10, 3-13, 3-15, 5-7, 6-1, 7-7, 

7-15, 8-1, 9-2, 10-2, 11-2, 12-2, 13-2, 13-5, 

13-8, 14-2, 19-5 

Precision, 16-6 

Pressure unit, 16-8 

Print, 5-44, 6-6, 6-8, 7-36, 8-7, 10-9, 10-14, 11-

7, 11-12, 14-23 

problems, 3-20, 18-1, 18-3, 18-4 

R 

Reconnect, 16-2 

Recording mode, 3-29 

Reference temperature, 3-27, 16-9 

Report, 5-43, 14-22 

Reset, 5-38, 14-18 

Resolution, 3-24, 19-1 

retro-reflector, 3-24, 4-12, 5-10, 5-41, 6-3, 7-9, 

7-15, 7-43, 9-3, 10-2, 11-2, 12-3, 12-9, 12-10, 

13-4, 13-6, 13-8, 13-16, 14-20, 17-10, 17-13 

RK1, 3-13, 7-7, 7-9, 7-38, 8-2, 8-3, 9-2, 9-3, 10-

2, 11-2, 13-5, 13-6, 14-2, 14-4 

RL1, 3-10, 3-21, 3-26, 4-10, 5-7, 5-8, 5-10, 6-2, 

6-3, 12-2, 12-3, 13-2, 13-4 

rotary encoder, 3-26, 14-1, 14-2, 14-4, 14-6, 

14-7, 14-8, 16-3 

S 

Sign, 3-24, 15-3, 15-6, 15-7, 19-3, 19-4 

Simulator, 3-18, 16-2 

SO1, 3-13 

Software installation, 3-1 

splash screen, 3-17, 3-18 

Squareness, 19-2 

squareness measurement, 10-1 

squareness measurements, 10-1, 10-3, 10-4, 

10-5, 10-6, 10-11, 10-14, 11-10, 11-12 

status bar, 3-22, 5-17, 14-18 

Status Bar, 3-25, 3-27 

Stop After Cycle, 5-18, 14-18 

Stop after each cycle, 5-35, 5-42, 14-16, 14-21 

Straightness, 7-1, 7-24, 7-25, 7-36, 7-42, 7-45, 

7-46, 8-11, 9-1, 9-9, 10-12, 11-11, 19-1, 19-2 

straightness measurements, 7-1, 7-7, 7-8, 7-9, 

7-10, 7-15, 7-16, 7-17, 7-18, 7-42, 8-1, 8-12, 

8-14, 10-1, 10-3, 10-4, 10-14, 11-1, 11-3, 11-

5, 11-13, 13-5, 13-6, 13-7, 13-8, 13-9, 13-10, 

13-11 

Straightness measurements, 7-1 

Strobe, 3-11, 3-15, 5-8, 5-36, 6-2, 7-7, 7-16, 8-2, 

8-16, 9-2, 9-6, 10-3, 10-15, 11-3, 11-14, 13-2, 

13-5, 13-8, 14-2, 14-17 

T 

Technical Data, 3-15 

temperature compensation, 19-6 

Temperature unit, 16-8 

Tripod, 3-10, 3-13, 5-8, 6-2, 7-7, 7-16, 8-2, 9-2, 

10-3, 11-3, 12-2, 13-2, 13-6, 13-8, 14-2 

troubleshooting, 3-20, 18-1 

U 

Uninstall, 3-9 

USB, 3-8 

USB cable, 3-14, 5-8, 6-2, 7-7, 7-15, 8-2, 9-2, 

10-3, 11-3, 12-2, 13-2, 13-5, 13-8, 14-2 

USB connection, 3-13, 3-14 
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Velocity, 3-25, 3-26, 6-1, 6-2, 6-3, 6-5, 6-11, 

12-6, 13-13, 19-1 

Velocity measurements, 6-1, 6-2, 6-3 

Velocity plot, 6-5 

Velocity value table, 6-5 

Vibration measurements, 12-1, 12-2, 12-3, 13-

2, 13-3 

Vibrations, 5-41, 12-5, 14-15, 14-19 

W 

WiMeteo, 16-3, 16-4 

Wollaston, 7-1, 7-15, 7-16, 7-17, 7-25, 7-32, 

10-1, 10-2, 10-4, 10-11, 10-14, 11-1, 11-2, 

11-5, 11-10, 11-12, 13-8, 13-13, 16-5 

Y 
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